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iv

Explanation of Symbols

CAUTION: Risk of Danger! Wherever this symbol appears, always consult note
iji in this manual for further information before proceeding. This symbol identifies com-

ponents that pose a risk of personal injury or damage to rhe instrument if improperly

handled.

A CAUTION: Risk of Electrical Shock! This symbol identifies components that pose

a risk of electrical shock if improperly handled.

CAUTION: Hot Surface! This symbol identifies components that pose a risk of per-
sonal injury due to excessive heat if improperly handled.

Safefy Warnings

personal injury hazard. Only qudlified laboratory persénnel trained in the
safe use of electrical equipment should operate this instrument.

2 Warning: Operating the Chromo4 detector befare reading this manual can consfitute a

Warning: Do not open or attempt to repair the Chromo4 unit. Doing so will void your
warranties and can put you at risk for electrical shock. Return the Chromo4
detector to the factory {North American customers) or an authorized distribu-
tor {all other customers) if repairs are needed.

tion to cause burns or cause liquids to boil explosively. Wear safety goggles
or other eye protection af all times during operation.

Caution: Never remove the Chromo4 unit from the DNA Engine base when the power
is turned on or a program is running. Doing so can cause electrical arcing
that can melt the contacts in the connector joining the Chromo4 unit to the
cycler.

2 Warning: The sample block can become hot enough during the course of normal opera-
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Safe Use Guidelines

The Chromo4 system is designed fo operate safely under the following conditions:

. Indoor use

. Altitude up to 3000m

. Ambient temperature 15-31°C

. Humidity 10-80%, noncondensing

. Transient overvoltage per Installation Category I, IEC 664
. Pollution degree 2, in accordance with IEC 664

Electromagnetic Interference

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful inferference, and {2) this device

_ must accept any interference received, including interference that may cause undesired
operation. '

This device has been tested and found to comply with the EMC standards for emissions
and susceptibility established by the European Union at time of manufacture.

This digital apparatus does not exceed the Class A limits for radio noise emissions from

digital apparatus set out in the Radio Interference Regulations of the Canadian Depart-
ment of Communicafions.

LE PRESENT APPAREIL NUMERIQUE N'EMET PAS DE BRUITS RADIOELECTRIQUES
DEPASSANT LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A
PRESCRITES DANS LE REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR
LE MINISTERE DES COMMUNICATIONS DU CANADA. '
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FCC Warning

Warning: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio-frequency
energy and, if not installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be re-
quired o correct the inferference at his own expense.

Note Regarding FCC Compliance: Although this design of instrument has been tested
and found to comply with Part 15, Subpart B of the FCC Rules for a Class A digital de-
vice, please note that this compliance is voluntary, for the instfrument qualifies as an "Ex-
empted device" under 47 CFR § 15.103(c), in regard to the cited FCC regulafions in
effect at the fime of manufacture.

This instrument system is labeled, "For Research Use Only".
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Meet the Chromo4™ Continuous Fluoresence Detector, 1-2
Using This Manual, 1-2 ‘
Important Safely Information, 1-3
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Meet the Chromo 4™ Continuous Fluorescence Detector

Thank you for buying @ Chromo4 Continuous Fluorescence Detector from MJ Research,
Incorporated. Designed by a team of molecular biclogisis and engineers, the Chromo4
defector will meet your needs for a sensitive, easy-to-use, and compact continuous fluo-
rescence detection system. Some of the Chromo4 system’s many features include:

Designed to function like an Alpha™ unit compatible with our DNA Engine® thermal
cyclers.

Swappable with any Alpha unit, thus maintaining the flexibility of the cycler.

DNA Engine Peltier thermal cyclers deliver superior thermal accuracy and welkHo-
well thermal uniformity.

A 96-well sample block accepts siandard consumables (96-well microplates and
0.2ml strip tubes).

An infegrated heated lid permits oil-free cycling.
Long-lived LEDs excite fluorescent dyes.
Sensitive photodiodes detect fluorescence.

Opticon Monitor™ software facilitates experimental setup, run initiation, run-status
monitoring, and data analysis. '

Two modes of temperature control: calculated control for maximum speed and accu-
racy; block control for adapting protocols optimized in other cyclers.

Using This Manual

This manual contains instructions for operating your Chromo4 system safely and produc-
tively: '

Chapter 2 acquaints you with the physical characteristics of the Chromo4 detec-
tor.

Chapter 3 presents the basics of installing and operating the Chromo4 detector.

Chapter 4 discusses the chemistry and sample vessel compatibilities of the
Chromo4 detector.

Chapters 5-8 step you through the use of the Opticon Monitor software includ-
ing how to enter and run protocols and how to analyze collected data.

Chapter 9 explains the proper maintenance of the Chromo4 detector.

Chapter 10 offers troubleshooting information for the Chromo4 detector.
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Infroduction &

Important Safety Information

Safe operation of the Chromo4 fluorescence detection system begins with a complete
undersh::nd[ng of how the instrument works. Please read this entire manual before attempt-
ing to operate the Chromo4 detector.

The Chromo4 unit is designed to operate like an Alpha unit on a DNA Engine ther-
mal cycler. In addition to reading this manual, please read DNA Engine® & DNA
Engine Tetrad® Peltier Thermal Cyclers, Operations Manual to understand how
that instrument works, before attempting to operate the Chromo4 detector in con-
junction with the DNA Engine cycler. (The Engine manual was shipped with the
thermal cycler.) Do not allow anyone who has not read these manuals to operate
the instrument.

Warning: The Chromo4 system can generate enough heat to inflict serious burns
and could deliver sirong electrical shocks if not used according to the instructions in

this manual. Please read the safety warnings and guidelines at the beginning of
this manual on pages iv and v, as well as the warnings throughout the manual, and
exercise all precautions outlined in them.
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2. Layout and Specifications

Front View, 2-2

Back View, 2-2
Specifications, 2-3

Gradient Specifications, 2-4
Computer Specifications, 2-4

2-1



B Chromo4 Real-Time Detector Operations Manual

Front View
(Figure 2-1)
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Layout and Specifications ®

Specifications
Thermal range: 0° to 105°C, but not more than 30°C
' below ambient temperature

Thermal accuracy: +0.3°C of programmed target @ 20°C,
NI[ST-raceable

Thermal homogeneity: +0.4°C wellto-well within 30 seconds of
arrival at 20°C

Ramping speed: Up to 3.0°C/sec

Sample capacity: ?6-well microplate or 96 x 0.2ml tubes

Line voltage: 100-240VAC !

Frequency: 50-60Hz

Power:

thermal section: A0Vdc, 10A 2
fluorescence section: 24Vdc, 2.5A3
Weight: - 6.8kg {excluding thermal cycler, com-
‘ "puter, and monitor)

Size: 23cm deep x 20cm wide x 18cm high
{excluding thermal cycler, computer, and
monitor)

Fluorescence Excitation Range: Channel 1: 450-490nm
Channel 2: 500-535nm
Channel 3: 555-585nm
Channel 4: 620-650nm

Fluorescence Detection Ranges: Channel 1: 515-530nm

Channel 2: 560-580nm
Channel 3: 610-650nm
Channel 4: 675-730nm

' No adjustment by the user is necessary to use elecirical power within these ranges. However, all users
should employ the proper IEC-320 cordset to connect the instrument to a power outlet, see page 3-4.

2 The Chromo4 defection system is a component dedicated for thermal cyclers of the DNA Engine
tamily, which supply power for the thermal section.

3 Supplied by included power supply, Input: T00-240V ~1.5A 40-60Hz.

Tech Support: {888) 652-9253 » Sales: (888) 735-8437 « tech@mir.com » www.mjr.com 2-3
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Gradient Specifications

Accuracy: +0.3°C of target at end columns within
30 seconds [NISTiraceable)

Column uniformity: +0.4°C, in column, well-to—well, within
30 seconds of target attainment

Calculator accuracy: +0.4°C of actual column temperature
-{NISTtraceable}
Lowest programmable 30°C

gradient temperature:

Highest programmable 105°C
gradient temperature:

Gradient range: from 1.0°C up to 24.0°C
(temperature differential)

Computer Specifications

{minimum specifications required for running Chromo4 system and Opticon Monitor™ software

version 2.03)
Operating System: Windows 2000 or XP Pro
Processor Speed: 1GHz
‘Display: ' . 1024 x 768 screen resolution
Memory: 256 MB RAM
Storage: 10GB hard drive

Specificalions subject to change without notice.
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Unpacking the Chromo 4™ System

Note: Retain dll packaging materials, undamaged, for use in the event
of a service return.
1. Open the outer box {the "over-packing"), faking care not to damage it. Lift out the three
inner boxes; these contain the Chromo4 unit, photonics shuttle {which contains the LEDs,
photedicdes, filiers, and electronics for excitation and detection), and accessory kit.

2. The smaller box at the fop contains one or more white corrugated-cardboard photonics-
shutile boxes. Each photonics-shuttle box contains a dyecalibration CD-ROM matched to
a specific photonics shuttie and a foam-filled plastic case containing the photonics shuttle
itself. Note that the serial numbers on the CD-ROM, the photonics shuttle, and the plastic
box should all match.

Note: Leave the photonics shuttle in the plastic box until you are ready to install it. Inside
the box, the photonics shuttle is in o staficprotective bag. Open this bag only when in-
stalling the photonics shutile.

A Caution: Never touch the circuit board on the back of the photonics

shuttle: doing so could damage the electronics.

3. Remove the accessory kit from the inner box. Make sure all of the items listed under
Packing Checklist {next page) are included.

4. Remove the Chromo4 unit together with the foam-plastic packaging end caps. Note
that the Chromo4 unit is also in a static-protective bag. Remove the end caps.

5. Observing static-profective procedures, remove the Chromo4 unit from its plastic bag
and proceed with installation.
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Instaflation and Operation W

Packing Checklist

The following items should have been shipped. If any item is missing or c]omc:ged, con-
tact MJ Research immediately.

Chromo4 vnit

Photonics shuttle box

photonics shuttle
dye calibration CD-ROM
Accessory kit *
1 base-stabilizer bar
2 USB cables, A-B Male, 2 meters
1 serial interface cable, PC
1 power cord, black
1 box low-profile strip tubes (M catalog #TLS-0851)
1 box ultra<lear strip caps (MJ catalog #TCS-08¢3)
1 strip-cap seating tool (MJ catalog #ECT-2000)
1 power supply, 24V, 3.0A
1 Chromo4 alignment plate
1 USB+to-serial adapter
1 Opticon Monitor CD-ROM, version 2.03

1 Chromo4 Operations Manual {this document]

Tech Support: (888) 652-9253 « Scles: (888) 735-8437 @ tech@mjr.com ® www.mjr.com 3-3
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Conditions Required for Installing a Chromo 4 System
DNA Engine Requirements

To use a Chromo4 detection system, the DNA Engine® base {PTC-200) must be run-
ning version 3.3C or greater firmware. A previously purchased PTC-200 may need to
be upgraded to version 3.3C or greater by following the instructions on page 3-14 of
this document. To check the firmware version on a PTC-200 thermal cycler, perform
the following steps:

1. Power on the PTC-200 (with an aftached Alpha™ unit).
2. On the Main Menu programming screen, choose Setup using the select arrow keys.
3. Hit the Proceed key fo advance to the next window.
4. Click Version on the programming screen using the select arrow keys.
5. Hit the Proceed key fo advance to the next window.
6. Note the firmware version.
Note: A DNA Engine base that is running firmware versions 1.0A-1.1R cannot be upgraded

(or become gradient enabled) without a hardware modification.

Computer Requirements

The minimum computer specifications required for Chromo4 system installation are as
follows:

1. Operating system: Windows XP Pro or 2000
2. Memory: 256MB RAM

3. Processor speed: 1GHz

4. Storage: 10GB hard drive

5. Screen resolution: 1024 x 768pixels

Environmental Requirements

The Chromo4 system requires a location with four power outlets to accommodate the
Chromo4 unit, the DNA Engine base, the computer, and the monitor. A location with net-
work access {Ethernet 10/100BaseT) is recommended if you wish to transfer setup and
analysis files between the computer running the Chromo4 system and other computers.
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Installation and Operation W

For reasons of safety and performance, ensure that the area where the Chromo4 system
is installed meets the following conditions:

* Indoor use

* Nonexplosive environment

* Normal air pressure (alfitude below 3000m)

* Ambient temperature 15°-31°C

* Relative humidity above 10% and up to 80%, non-condensing

* Installation Category Il {portable equipment)

* Pollution Degree 2 Environment (normally only nonconductive pollution)

* Unobstructed access fo air that is 31°C or cooler [see the following pages)

* Protection from excessive heat and accidental spills. {Do not place the Chromo4
system near such heat sources as radiators, and profect it from danger of having
water or other fluids splashed on it, which can cause electrical short circuits.)

Power Supply Requirements

The Chromo4 system requires 100-240VAC, 50-60Hz and a grounded outlet. Supply
voltage fluctuations should not exceed =10%. The Chromo4 system can use voltage in
the specified range without adjustment, so there is no voltage-sefting switch.

The Chromo4 unit is equipped to accept power from an AC “brick type” adapter, which
in furn can accept 100-240VAC, 50-60Hz. This adapter accepts cord sets with an
IEC 60320-2-2 class Il 2.5A 250V connector. Additionally, the cord set must meet all
other applicable national standards—thus at @ minimum, the cord set should carry the
mark of a nationally recognized testing agency appropriate to your nation.

Note: Do not cut the supplied 120V power cord and attach a different connector, Use a one-
piece molded connector of the type specified above.

Air Supply Requirements

A DNA Engine thermal cycler equipped with a Chromo4 unit requires a constant supply
of air that is 31°C or cooler in order to remove heat from the detecior’s heat sink. Air is
taken in from the vents at the front, back, and bottom of the cycler base and exhausted
from the vents on both sides. I the air supply is inadequate or too hot, the instrument
can overheat, causing performance problems and even automatic shutdowns.

Tech Support: (888) 652-9253 » Sciles: {888) 735-8437 « tech@mir.com ® www.mjr.com  3-5
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Ensuring an Adequate Air Supply

¢ Do not block air intake vents.

* Position the cycler equipped with the Chromo4 unit at least 10cm from vertical sur-
faces and other thermal cyclers or heatgenerating equipment {greater distances may
be required; see the following section). Da not put loose papers under the base—
they can be sucked into the air infake vents on the bottom of the instrument

¢ Do not allow dust or debris to collect in the air intake vents.

Ensuring That Air Is Cool Enough

* Do not position two or more cyclers (or other instruments) so that hot exhaust air
blows directly into the air intake vents.

* Confirm that the cycler receives air that is 31°C or cooler by measuring the tempera-
fure of air entering the machine through its air intake vents.

Place the cycler equipped with the Chromo4 unit where you plan to use it, and turn it on.

_ Try to reproduce what will be typical operating conditions for the machine in that loca-
tion, particularly any heatproducing factors (e.g., nearby equipment running, window
blinds open, ||ghfs on). Run a typical protoco[ for 30 minutes fo warm up the system, then
measure the air temperature at the air intake vents. If more than one instrument is in-
volved, measure the air temperature for each.

I the qir intake temperature of any instrument is warmer than 31°C, consult Table 3-1 for
possible remedies. After implementing possible remedies, verify that the temperature of the
air entering the air intake vents has been lowered, using the procedure outlined above.

Table 3-1 Troubleshooting Air Supply Problems

Cause Possible Remedies

Air circulation is poor. Provide more space around instrument or adjust room
ventilation.

Ambient air temperature Adjust air conditioning fo lower ambient air

is high. temperature.

Instrument is in warm part  Move instrument away from, or protect instrument from,
of room. such heat sources as radiators, heaters, other equip-
ment, or bright sunlight.

Instruments are crowded. Arrange machines so that warm exhaust air does not
enter intake vents.
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Installation and Operation W

Setting Up the Chromo 4 System

The Chromo4 unit is designed to be used like an Alpha unit on @ DNA Engine thermal
cycler. Please see the DNA Engine® & DNA Engine Tetrad® Peltier Thermal Cyclers, Op-
erations Manual, which was shipped with your Engine, for complete instructions and re-
quirements for setting up the thermal cycler. '

Installing the Base-Stabilizer Bar on the DNA Engine Base

Important: Before installing the Chromo4 unit on the DNA Engine base,
install the base-stabilizer bar on the rear, bottom of the base.

1. Tilt the cycler on its side so that the bottom air vents are accessible (Figure 3. 1 ).

2. Orient the base-stabilizer bar so that the magnet faces the bottom of the cycler and
the channel and bent tabs are toward the front of the cycler.

3. Insert the two bent tabs into the rearmost air vents.

4. Rotate the base-stabilizer bar toward the cycler until the magnet atiaches fo the
cycler. The oval recess in the fop of the stabilizer bar should fit over the plastic
screw in the base of the cycler, and the back of the bar should extend approxi-
mately 7cm beyond the back of the cycler.

Figure 3.1. Installing the base-stabilizer bar on the DNA Engine base.

Tech Support: (888) 652-9253 » Sales: (888) 735-8437 » tech@mir.com www.mjr.com  3-7
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Installing the Chromo 4 Unit on the DNA Engine Base

1. Make sure the Engine base (the thermal cycler) is off.

on-—electrical arcing can result. Read the safefy warning at the beginning of
this manual regarding electrical safety when inserting or removing the Chromo4 unit.

f Caution: Do not insert or remove the Chromo4 unit with the cycler turned

2. Hold the Chromo4 unit at its front and back edges.

3. Lower the Chromo4 unit into the DNA Engine base, leaving at least 3cm between the
front edge of the Chromo4 unit and the front of the base.

4. Raise the black metal handle at the back of the Chromo4 unit and slide the unit for
ward as far as it will go (Figure 3-2a]

5. Push the back handle down until it is completely vertical and snug against the unit
[Figure 3-2b)—firm pressure may be required. A definite click signals that the Chromo4
unit's connectors have mated with the cycler’s connectors.

When the back handle is in the down position, the Chromo4 unit is locked into place.

Figure 3-2. Installing the Chromo4 unit on the DNA Engine cycler.
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Opening and Closing the Chromo 4 Detector

Be sure the base-siabilizer ber is attached to the cycler base before opening the lid of the
Chromo4 unit.

Always use the blue handle to open and close the lid of the Chromo4
system. Improper opening and closing can damage the latch springs.

To gain access to the Chromo4 unit’s sample holder, grip the bottom edge of the blue
handle on the front of the lid and rotate the handle all the way upward {Figure 3-3). Now
lift upward on the handle fo open the lid of the Chromo4 unit, exposing the sample holder.

Note: Do not open the Chromo4 lid while the blue protocol-indicator light is on. Opening
the lid, particularly during a scan of the plate, may interrupt the software's control of
the protocol.

Figure 3-3. Opening the Chromo4 Detector.

To return the Chromo4 lid to the closed position, use the raised blue handle to lower the
lid. When the lid is down, rofate the handle down and inward until it lies flush with the
front panel that holds the blue indicator light.

Warning: Never attempt to force the Chromo4 housing closed with the blue handle in the
down position. This puts unnecessary strain on the latch-spring mechanism, which
may eventually cause the springs fo fail.

Tech Support: {888) 652-9253 = Sales: (888) 735-8437  tech@mir.com www.mjr.com  3-9
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Installing the Chromo 4 Photonics shuttle

The Chromo4 photonics shuttle contains the LEDs and photodiodes for illumination and
detection, as well as appropriate filters and communication electronics. During plate reads,
the photonics shutile scans across the sample plate fo interrogate each well.

Important: Before touching the photonics shuttle, discharge any static
electricity that you may be carrying. One method of discharging static elec-
tricity, for example, would be to touch a grounded metal plumbing fixture shortly before
touching the photonics shutile.

A Caution: Do not touch the circuit board on the back of the photonics

shuttle: this could damage the electronics.

1. On the inner face of the Chromo4 lid is @ metal heater plate with an 8 x 12 array of
holes. The heater plate is held in place by two D-shaped latches along the anterior edge.
Turn these lafches to access the photonics -shuttle stage axes.

o osooRf ]

Figure 3-4. Accessing the photonics shuttle’s stage.

2. When you first open the Chromo4 unit to install the photonics shutile, you will see one
red and one yellow plastic tube wrapped around the unit's stage axes. These protect the
lead screws and prevent the photonics shuttle stage from moving during fransit. Remove
these tubes and save them along with the other packaging. Returning a unit
without replacing these fubes may allow damage not covered by the warranty.

3. Center the shutile stage by hand.
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4. Remove the photonics shutile from its plastic sforage box and staticprotective bag.

5. Orient the photonics shuttle so that when you insert it into the shutile stage the circuit
P y g

board will face the stage, the flattened pivot pins are at the bottom, and the metal side

plates with holes to accommodate the ball detents are at the top. In this position, the 18-

pin connector should insert inte the connector on the shuttle stage.

shuttle
stage

e

]

ball deten
Ilﬁ?

guide slots

pivot pin &m\\ ¢

Figure 3-5. Installing the Chromo4 photonics shuttle.

6. Grasping the photonics shuttle between your thumb and forefinger, hold it at approxi-

mately a 60 degree angle fo the stage’s circuit board, so that the flattened pivot pins on
the shuttle can slide into the guides on the stage.

7. Slide the pivot pins completely into the guides, then rofate the phofonics shuftle up-
ward, pressing it against the stage plate until it snaps info the ball detents on the stage.

8. Close the heater plate and rotate the latches to hold the plate in place.

Attaching the Power Cords and Communication Cables
Power Connection

1. Insert the cycler power cord plug into ifs jack af the back of the base, and then plug the
cord info an electrical outlet {see DNA Engine® & DNA Engine Tetrad?® Peltier Thermal
Cyclers, Operations Manual for more details).

2. Insert the switching power supply plug into its jack at the left bottom side of the Chromod
unit, and plug the other end into a standard 110V or 220V electrical outlet.
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Turning the Chromo 4 Detection System On and Off

The Chromo4 unit does not have its own power switch; it will receive power when it is
plugged in, and will be controlled by the Opticon Monitor software.

The power switch for the DNA Engine thermal cycler is located on the back of the unit,
just above the power cord. To turn the cycler on, press the switch so that the side marked
“I" is depressed. The red power-indicator light on the base will turn on. The blue indica-
tor light on the Chromo4 unit will not be illuminated until @ profocol is running.

The thermal cycler requires several minutes to warm up after it is powered up.

To turn the cycler off, depress the “0” side of the power switch.

Serial Connection

Note: When the serial cable is affached to the DNA Engine thermal cycler, the front panel of
the cycler is nonfunctional. Instead, the cycler is conirolled by the computer, using
Opticon Monitor software.

1. Turn on the power to both the computer (with no peripherals plugged in} and the DNA
Engine base with the Chromo4 detector installed.

2A. If the computer has a serial port, first connect the serial cable to the PTC-200, and then
connect the serial cable to the computer. Note the COM port number info which the
serial cable hds been inserted, as it will be used in the machopts file when installing

Opticon Monitor software.

2B. If the computer does not have a serial port, use the serialo-USB adapter. Instructions are
as follows:

a. Plug the provided USB-to-serial addpier info a USB connection on the computer {do
not plug in the serial cable from the PTC-200 yet]. The blue light on the adapter
should illuminate.

b. The Windows OS will open the Found New Hardware Wizard.

c. Insert the CD provided with the adapter and follow the driver installation instructions. You
will receive a warning that the software has not passed Windows Logo testing to verify its
compatibility with Windows XP. Click the Continue Anyway button fo proceed.

d. The Found New Hardware Wizard will indicate when the software installation is
complete. Click Finish to close the Wizard.

e. Plug the serial cable from the PTC-200 info the adapter. The blue LED on the adapter
should get brighter.
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f. Document the COM port number into which the USB-o-serial adapter has been in-
serted by right clicking on "My Computer” and selecting “Properties”. Then, click the
“Hardware” tab and the following window will appear:

| Syztem Rsstore li Automatic Updates | Remots I
| Geneml || Computer Mame Hardware | Advanced |

« 2Ad Hardware Wizard e o U
;@? The Add Hardware Wizaed halps you install hardware.

| Add Hardware Wizard |

'DE‘J‘iCE Manager S S g L e

The Device Manager lists gl the hardwars devices installed
on your compuier. Use the Device Maragerio change the
propeties of any device. _—

{ Driver Signing Davice Manager

s~ Hardware pruﬁ%és provide a way for you to set up and store
: é‘?ﬁi different hardware configurstions. )

‘ L Hardware Profiles —] |

oK |] L .Cancel 1 5 Apely E

g. Click on “Device Manager” and then select “Ports (COM & LPT) as shown below, left.
The device along with a COM port designation should be present {Note, the Cables
To Go adaptor will be listed as “Prolific USB+o-Serial Comm Port” as shown below,
right]. You will need to record the COM port number shown in parenthesis (4" in the
figure below) in the machopts file during Opticon Monitor installation.

PCMCL adapters
¥ Ports (COM & LEL LD .
M8 Processors Elﬁ Ports (COM & LFT)

(]

=0 . o7 ) _
-to-Serial Comm Fort (COb

&7 Frolific USB
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USB Connection

1. Copy the folder entitled Ml USB Driver from the Chromo4 Dye File Disk onto the computer
desktop. This folder contains the files MIR.inf, MIRdetec,sys, MIRQuad.sys, and quadldr.sys.

2. Plug the USB cord into the Chromo 4 detector and then into the computer.

3. The Windows OS will pop up a device message alerting the user it detects an MJ Real-
Time Detector. The New Found Hardware Wizard will then open.

4., Select “Install from a list or specific location (Advanced)”. Browse for the MJ USB Driver
folder on the desktop.

5. Follow the Wizard instructions. A warning will appear indicating the Mi Real-ime Detec-
tor USB Device has not passed Windows Logo testing. Click the Continue Anyway
button o proceed.

Upgrading DNA Engine Firmware (if necessary)

Once the serial connection between the thermal cycler and the computer has been estab-
lished, the DNA Engine firmware can be upgraded to version 3.3C, if necessary, by fol-
lowing the instructions below.

1. Download the DNA Engine Update Utility and the latest firmware version from
www.mjr.com. The two current versions are MJ Instrument Updater {Ml Thermal Cycler
Update Utility 1_3.EXE) and 3.3C files (33CEngine.EXE). lcons for these programs are
shown below:

= 33CEngine . EXE
¢ | PRKSERE: for Windows
Mg PK'@-‘%.REV Ine.

M1 Thermal Cycler Update Utility
|1 3.ExE
. PKSFAE: for Windowss
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2. First install the M) Updater, by double clicking on the MJ Thermal Cycler Update Utility
1_3.EXE icon. In the next window, check the box for “run after extraction: setup.exe” as
shown below. Click the Extract button to run the installer. '

Extract ta: IC:\F‘rbgram Files'hiJ -Fiesearch'\h-.UH 7 Ernwsé..:_

0%

v Run after extraction: setup.exe

Created with the Regisiered Version of PKSFX® for Windows
WOT FDH DISTRIBUTION WITHOUT PERMISSION

: E:-:tracti © Cancel l

3. When exiraction is complefed, the program prompts to run the sefup.exe program. Click
the Yes button. '

4. Follow the instructions for the InstallShield Wizard for MJ Thermal Cycler Update utility.
This procedure will drop the following shortcut icon on the deskiop:

MJ Thermal Cycler Update Utility.exe

5. After installing the updater utility, open and extract the 3.3C file. Double click on the
33CEngine.EXE icon. In the next window, check the box for “run after extraction:
setup.exe” and click the Extract button. '

&. Run the MJ Instrument Updater by clicking on the shortcut icon on the desktop. A “failure
to initialize serial port” warning will be registered. Click Ok.

7. Instructions will indicate that a serial port has not been selected. Click Ok.
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8. The software update window shown below will open.

| Communications Options  Help  About

Thermal Cyder |5 0FTW ARE

MV ATE THEIT :;( '~.,~_f e
somevnr A0

=

DOWNLOAD

Technical Support:
LRBE-MICYCIE
{1-8B8.632.9253)

9. Under “Communications”, select the correct serial cable COM port number (see section
on Serial Connecticn, on page 3-12, for instructions).

10. Select Update DNA Engine cycler and verify that the program fists firmware version 3.3C.

11. Click the Continue button to updc:lre the PTC-200 firmware.

12. Follow the instructions given from the updater {read instructions carefully).

13. After the update, a message will prompt you to turn the thermal cycler power off and
then restart it. Do so, and then press Exit.

Installing Opticon Monitor™ Software

1. Install the Opticon Monitor 2.03 installer from the disk provided by inserting the disk

and double<licking on the installer icon. Follow the installation instructions. Reboot
the computer.
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2. Go to C:\Program Files\Opticon Monitor 2\instrument\chromo4 and open the machopis
file with Notepad. The file should look like this:

File Edit Format View Help

ftachType: Chremod
callidtemp: 0
calrpt: 1

caltemps: 25
inst.ncolors: 4
inst.ncolumns: 12
inst.nrows- 8
inst.path: chromaod
patience: 30

ush: 1
cycler.conn: com?
tremont: @

3. IF necessary, change the COM port number in the machops file, listed above as
“cycler.conn: com1”, fo the COM port number in which the serial cable has been
inserted {from section on Serial Connection, page 3-12).

Warning: Do not change any other parameters in the machopts file.
Doing so could damage the instrument and void the warranty.

4. Save the machopts file.

Copying the Dye Files

Insert the Chromo4 dye files CD-ROM and copy the Chromo4 dye calibration files fo
C:\Program Files\Opticon Monitor 2\Instrument\Chromo4\Dyes

Aligning the Chromo 4 Photonics shuttle
1. Open Opticon Monitor v.2.03 software.

2. Make sure ‘Chromo4’ is the selected instrument in the Instrument panel. Note, ‘Chromod’
should be the only instrument [isted.

3. Under the Tools menu select Change Chromo4 Photonics shutile.

4. A window will appear. Select Yes and follow instructions to align the photonics shuttle
using the provided alignment plate.
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Changing the Chromo 4 Photonics shuttle

Important: Before touching the photonics shuttle, discharge any static
electricity that you may be carrying. One method of discharging static elec-
tricity, for example, would be to touch a grounded metal plumbing fixture shortly before
touching the photonics shutile.

Caution: Do not touch the circuit board on the back of the photonics
shuttle: this could damage the electronics.

> >

1. Unplug the power from both the Chromo4 unit and the DNA Engine thermal cycler.

2. Open the lid of the Chromo4 detector. Be careful—it may be warm.

3. Open the Chromo4 housing by turning the D-shaped laiches along the anterior edge that
hold the heater plate in place (Figure 3-4). This will remove power from the instrumeni—
you may receive a USB-detach warning from the Windows OS.

4. When the Chromo4 housing is open, the photonics shuttle’s filters will be visible (Figure 3-

5b). To remove the photonics shuttle, grasp it firmly between your thumb and forefinger

. along its upper edges, where there are two hexhead screws. Pull on the photonics

shuttle, rotating it outward on the flat pivot pins unfil the pins can be lifted free of their
guide slots on the photonics shuttle stage {Figure 3-5a.

Note: Every fime you remove and replace the photenics shutile, you must realign the
detector (see page 3-17) using the alignment plate that came with the instrument.
The last screen of the Change the Photonics shuttle protocol instructs you fo insert
the alignment plate.

Loading Sample Vessels into the Detector

To ensure uniform heating and cooling of samples, sample vessels must be in complete
contact with the sample holder. Adequate contact is ensured by doing the following:

¢ Ensure that the sample holder is clean before loading samples (see Chapter 9 for
cleaning instructions). '

o Firmly press strips of 0.2ml tubes, or a 9é-well microplate info the sample-holder
wells (see the “Selecting the Correct Sample Vessel” section in Chapter 4).

» M Research strongly recommends that oil not be used to thermally couple sample
vessels to the holder.

Tip:  Air bubbles in samples, or liquid on the plate deck, can adversely affect results in real-
fime experiments. You may wish to spin down reactions in tubes or microplates fo
remove any air bubbles before loading the vessels into the thermal-cycler sample holder,
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Optical System

The Chromo4™ system uses a scanning photonics shuttle containing four LEDs and four
photodiodes to sequentially illuminate and detect emitted fluorescence from each of the
96 wells in the cycler block.

The Chromo4 detector is calibrated at the factory and requires no further calibration before
use. See Chapter 10, “Troubleshooting” for instructions on how to test the detector's eali-
bration and how to recalibrate, if required.

Compatible Chemistries

The Chromo4 system is compatible with popular dye chemistries including SYBR Green |,
molecular beacons, hydrolysis probes (TagMan probes), Scorpiens probes, the Amplifluor
system, and LUX Fluorogenic Primers. In addition fo performing realtime quantification*
and DNA melting profiles, the DNA Engine cycler configured with a Chromo4 detector
is useful as a temperaturecontrolled fluorimefer for @ number of applications including
ligand binding and protein structure studies. If you have questions regarding the compat-
ibility of a particular chemistry with the Chromo4 detector, contact MJ Research technical
support at 888-652-9253.

SYBR Green | (SGI)

SYBR Green | [available from Molecular Probes, Inc. of Eugene, Oregon) is a double-
stranded-DNA binding dye. Because the fluorescence of SGI is greatly enhanced upon
binding dsDNA, it is an ideal dye for the detection of amplification products. The maxi-
mum absorbance of SGI is ~497nm and the emission maximum is ~520nm’.

SGI offers several advantages for detection of nucleic acids in real time. Because SGI
binds to all dsDNA, it does not have to be customized for individual templates. There-
fore, protocols can be adapted quickly and at relatively low cost. Furthermore, because
multiple SGI molecules bind to a single amplification product, SGI is very sensitive. On
the other hand, because SGI binds to all dsDNA, false positive signals from primer-dimers,
secondary structure, or spurious priming can interfere with accurate quantification. Mea-
suring fluorescence at elevated temperatures may help reduce the detection of nonspe-
cific products?. Performing a melfing curve analysis can help to identify optimal anneal-
ing and plate-read temperatures, fo avoid generating false positives. Melting curve analysis
can also be used to analyze product homogeneity after a run.

M]J Research recommends using buffers containing 5% dimethyl sulfoxide [DMSO) with a
concentration of 1X or less SYBR Green | with the Chromo4 detector. For additional infor-
mation on oplimizing protocols using SYBR Green | with thermostable enzymes available
from MJ Research, contact MJ Research technical support at 888-652-9253.

'Malecular Probes, Inc.

Morrison, T.B., 1J. Weis and C.T. Witiwer. 1998. Biotechniques 24:954-962.

*The polymerase chain reaction {PCR} process is covered by patents owned by Hoffmann-la Roche, exclu-
sively licensed to Applied Biosystems. Use of the PCR process requires a license.
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Molecular Beacons

Molecular beacons are duaHabeled oligonucleotide probes designed to form stemloop
structures in the absence of target. In the hairpin configuration, the fluorophore at one
end of the molecule is brought into close proximity with a quenching moiety at the other
end of the molecule. When the fluorophore is excited in this configuration, it fransfers
energy to the quencher rather than emitting that energy as light, in a process known as
fluorescence resonance energy transfer (FRET). A “dark” quencher is often used, so the
energy transferred from the fluorophore is emitted in the infrared, rather than the visible
range. If a second fluorophore is used as a quencher, the transferred energy is emitted as
light at the quenching fluorophore’s characteristic wavelength.

Molecular beacons are designed such that the loop, which is usually 15-30 nucleotides
long, is complementary to the target sequence. The arms flanking the loop, which are
usually 5-7 nucleotides long, are designed such that they are complementary to each
other, and thus favor formation of a stem structure. A fluorophore is attached to the
end of one arm, and a quencher is attached to the other. Molecular beacons must be
carefully designed so that, at the annealing temperature of the reaction, hairpins form
in the absence of template but annealing of the loop sequence fo the target is energeti-
cally favorable in the presence of template. When the loop of a molecular beacon
hybridizes to the target sequence, the conformational change of the probe separates
the fluorophore and the quencher. When the fluorophore is excited, it now emits light
at its characteristic wavelength.

One advantage of molecular beacons is that, unlike SYBR Green, molecular beacons spe-
cifically detect the target of interest. Great sensitivity, including detection of single nucle-
ofide polymorphisms {SNPs), is possible with carefully designed molecular beacons under
optimized reaction conditions {femperature, buffer). The major disadvantage is that each
probe must be carefully and uniquely designed for the detection of a specific target.

Molecular beacons are a technology patented by the Public Health Research Institute of
New York, N, and are available from a number of licensed suppliers. When designing
molecular beacons for use with the Chromo4 detector, fluorophores with excitation and
emission spectra falling within ane of the Chromod detector’s excitation and detection
range pairs, such as FAM, should be used. Either dark quenchers or a quenching
fluorophore may be used with the Chromo4 detecior.

Hydrolysis Probes (TagMan Probes)

TagMan probes are a patented technology available from a number of licensed suppli-
ers. They are oligonucleotide probes whose flucrescence is dependent on the amplifica-
fion of a farget sequence. TagMan probes are designed fo anneal fo the farget sequence,
between the forward and reverse primer-binding sequences. A reporter fluorophore is
attached to the 5' end of the probe and a quencher to the 3’ end.
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When the intact probe anneals to the target sequence (and when it is not bound), excita-
tion of the reporter is quenched because of its proximity to the 3 quencher. However, as
extension proceeds, the 5’ exonuclease activity of the polymerase cleaves the probe, sepa-
rating the reporter from the quencher. TagMan probes work well with enzymes derived
from Thermus species, such as DyNAzyme™ Il DNA polymerase from Thermus brockianus,
available from MI Research, Inc. Liberated reporter molecules accumulate as the number
of cycles increases, so the increase in fluorescence is proportional to the amount of am-
plified product. '

One advantage of TagMan probes, particularly for quantification, is that fluorescence is
dependent not only on the presence of a specific target, but also on amplification of that
target. Like molecular beacons, however, TagMan probes must be individually designed
for specific targets. See the "Molecular Beacons” section above for recommendations on
the use of specific fluorophores and quenchers with the Chromo4 detection system.

Scorpions Probes

Scorpions probes (available from licensed suppliers) confain an amplification primer linked,
through an intermediary portion containing an amplification stopper, fo a targei-specific
probe. The sequences flanking the probe sequence are complementary fo each other,
and can form a hairpin structure. This hairpin structure brings a flucrophore and a quencher
into close proximity.

During amplification, extension of the target sequence proceeds from the primer portion of
the Scorpions probe. During denaturation, the hairpin loop opens. As the reaction cools
following denaturation, the targetspecific Scorpions probe sequence binds to the ampli-
fied, complementary target sequence, so the original hairpin structure does not reform.
Thus the fluorophore and quencher are separated, and fluorescence emission can be de-
tected. The amplification siopper prevents read-through during amplification, which could
" lead to opening of the hairpin, and thus flucrescence defection, in the absence of target.

Because the Scorpions probe is infegrated into the product, there is a direct relationship
between the number of fargets generated and the amount of fluorescence.

See the “Molecular Beacons” section above for recommendations on the use of specific
flucrophores and quenchers with the Chrome4 detection system.

Amplifluor Universal Detection System

The Ampliflucr system (available from Intergen Company of Purchase, NY) makes use of
o universal primer that emits a fluorescence signal only following incorporation of the
primer into an amplification product. The universal primer consists of an 18-base primer
tail {"Z sequence") coupled to a hairpin sequence labeled with a fluorophore and a
quencher. First, the target is amplified using target-specific primers, one of which has the
7 sequence added fo its 5' end. In the following round of amplification, the complement
to the Z sequence is incorporated into the product. The universal primer then anneals to
the complement of the Z sequence and extension proceeds. In the next cycle, extension
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proceeds through the universal primer, incorporating it into the amplification product. In
the process, the hairpin is unfolded, separating the fluorophore and quencher and emit-
ting a fluorescence signal that is proportional fo the amount of amplified product.

See the "Molecular Beacons” section above for recommendations on the use of specific
fluorophores and quenchers with the Chromo4 detection system.

LUX Fluorogenic Primers

LUX {Light Upon eXtension) Flucrogenic Primers {available from Invitrogen Corporation,
Carlsbad, CA) come as a primer set. One primer is labeled with a single fluorophore,
while the other primer is unlabeled. The labeled primer is designed to form a hairpin
loop that causes an infrinsic quenching of the fluorophore. When the primer binds to the
target and extension begins, the primer is incorporated into the double stranded PCR
product and the flucrescence emitted by the fluorophore increases. These primers are
sensitive and target specific, and allow melting curve analyses to be performed. Although
the primers have to be designed specifically for the target of inferest, there is no require-
ment for additional probes, as there is with the TagMan system.

See the “Molecular Beacons” section above for recommendations on the use of specific
fluorophores and quenchers with the Chromo4 detection system.

Selecting the Correct Sample Vessel

For best results, use thin-wall microplates or 0.2ml tubes with white or clear wells with the
Chromo4 system. Some users choose vessels with opaque, white wells to achieve higher
signal strength in fluorescence-detection assays. Other users prefer vessels with clear wells,
for easier sample viewing. MJ Research offers both microplates and tubes with either
opaque, white wells or clear wells. Qur vessels are designed for fluorescence detection
assays and are optimized to precisely fit in the cycler block (see the "Sample Vessel and
Sealing Selection Chart for Optical Assays" starting on page 4-7).

Microplates with black wells may be useful in applications requiring very low levels of
background, but signal strength is significantly reduced when plates and tubes with black
wells are used. :

Note: Infactory calibration of the Chromo4 detector is performed with both clear and
opaque white microplates.
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Sealing Sample Vessels

To achieve accurate, uniform, and repeatable results in thermalcycling reactions, proper
sealing of vessels is at least as important as high light transmission. Tight sealing is neces-
sary to prevent evaporative losses and resulting increases in the concentration of reac-
fion components. Only a layer of mineral oil or wax, such as Chill-out liquid wax, will
completely prevent evaporation from sample vessels. Nonetheless, an adequate degree
of protection can be achieved by sealing with optical caps or sealing film {in conjunction
with an optical compression pad—see below}, and cycling the samples using the Chromo4
unit's heated lid to prevent condensation.

Sealing with Optical Caps or Sealing Film and the Heated Lid

Excellent sealing of sample vessels can be achieved with optical caps or sealing film when
used with the Chromo4 unit's heated lid. The heated inner lid maintains the upper part of
sample vessels at a higher temperature than the reaction mixture, thus inhibiting conden-
sation of evaporated water vapor onto the vessel walls, and leaving solution concentra-
tions unchanged during thermal cycling. The heated lid also exerts pressure on the tops
of vessels loaded into the block, which is necessary fo maintain a vaportight seal.

Ultra-clear, optical strip caps available from MJ Research provide high light fransmission
for flucrescence detection and reliable, vaportight sealing.”

The Optical Film Sealing Kit from MJ Research includes optically clear, adhesive seals
and a compression pad that improves sealing. The excellent sealing capabilities and
high light transmission of this kit have produced more uniform resuls and earlier C{t) val-
ues than other optical films that appear more transparent.

Notes for use:

* When tubes are cooled fo below ambient temperatures, a ring of condensation may
form in tubes above the liquid level but below the top of the sample block. This is not
a cause for concern since it occurs only at the final cool-down step, when thermal
cycling is finished.

Sealing with Chill-out™ Liquid Wax

Clear Chill-out liquid wax {available from MJ Research) provides 100% prevention of
condensation and vapor loss and provides excellent light transmission for optimal perfor-
mance in optical assays. At room femperature and above, this overlay is a fransparent
liquid and can be applied by pipette. The wax solidifies below 10°C, thus proteciing
samples during cold storuage. The solidified wax is easily pierced with a pipette fip, so
the aqueous sample is easily retrieved, if needed.

4-6  Tech Support: (888) 652-9253 » Scles: {888) 735-8437 * tech@mir.com * www.mjr.com



|

Notes for use:

Compatible Chemisiries, Sample Vessels, and Sealing Options ®

* Use 154l of Chill-out liquid wax for a 20yl reaction, 20l for a 50ul reaction.
* Include the volume of wax in the fotal volume when sefting up o calculated-control

protocol.

* Be sure to use the same amount of wax in all reaction wells, to ensure a uniform
thermal profile.

Sample Vessel and Sealing Selection Chart for Optical Assays

The following reaction vessels and sealing options are recommended for use with the
Chromo4 system and are available from MJ Research. To place an order, call 888-729-
2165 or fax 888-729-2166.

MJ Research Catalog

TBS-0201 full height, clear

Product Number Product highlights
Veésel's B ' _ _
® |deal for small numbers of
samples
0.2m! tubes TLS-0851 low profile, white » Use white wells for maximum
st;ipn; of 8 - TLS-0801 low profile, clear signal, clear wells for easier

sample viewing.
* Use low profile vessels for
reaction volumes <25ul.

Hard-Shell® 96-well
skirted microplates

HSP-9655 white shell, white wells
HSP-2601 white shell, clear wells

* Ideal for 26 samples

* Plate remains absolutely flat
during thermal cycling, for
uniform light collection

* Use white wells for maximum
signal, clear wells for easier -
sample viewing.

* Colored shells are available for
color-coding.

Multiplate™ 96-well
unskirted microplates

MLL2651 low profile, white
MLL2601 low profile, clear
MLP2451 full height, white
MLP-9601 full height, clear

* Good for fewer than 96 samples
—microplates can be cut to size

* Precut, 48- and 24-well micro-
plates are also available.

* Use white wells for maximum
signal, clear wells for easier
sample viewing.

* Use low profile vessels for
reaction volumes <25yl
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4-8

MJ Research Catalog

Product Number

Product highlights

Sealing Options

¢ Ultra-clear caps yield high light
TCS0803 transmission and robust sealing
: ' * For thermal-cycling volumes 25l

Optical flat caps,
strips of 8

e Clear, adhesive seals yield
optimal light fransmission and
strong sealing for consistent

results.
. . * Includes optional compression
(K3i|i:)hcu| Film Sealing | 31551001 pad; additional pads can be

ordered separately {ADR-3296).
* For thermalcycling volumes
=10
* Can be used for plate storage,
ambient fo ~40" C

ChillOut™ Liquid * Replaces mineral oil overlay

CHO-1411 s Provides high light transmission

Wax, ophcgl-grude ' ¢ For thermalcycling volumes 22yl

Reaction Volume Recommendations

Reaction volumes of 20l are recommended for most applications. Volumes as low as 10l
can be used, although.sensitivity may be slightly reduced and variability slightly increased.
The maximum recommended sample volume is 100p. Volumes exceeding 100ul do not
maintain adequate contact with the wells of the sample block, and can result in nonuni-
form heating and cooling within the sample. It is beneficial to empirically optimize reagent
concentrations and sample volumes with the Chromo4 system, because the sensitivity of
the optical system often allows a costsaving reduction in reagent concentrations.

Thermal accuracy is optimum when all samples contain identical volumes and this vol-
ume is used to calculate the tfemperature of the samples during a calculated-control run
(see the “Temperafure Control Method” section in Chapter 6).
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Introduction

Opticon Monitor software controls the Chromo4 Continuous Fluorescence Detection Sys-
tem and performs data analysis. This chapter will introduce you to Opticon Monitor soft-
ware and discuss the basics of Jaunching and navigating the software. Chapter 6 de-
scribes experimental setup and programming, Chapter 7 discusses run initiation and sta-
tus, and Chapter 8 focuses on data analysis. This manual documents version 2.03
of the Opticon Monitor software.

Installing Opticon Monitor Software

Opticon Menitor sofiware is compatible with Windows 2000 and Windows XP Pro op-
erating systems. Users may install the software on multiple computers, and data analy-
sis may be performed on computers not attached fo the Chromo4 system.

To install Optican Monitor software, insert the program disk info the computer’s CD drive.
The Install Wizard should automatically open when the computer reads the disk. If the
Install Wizard does not open, view the disk’s contents and double<lick on the Opficon
Monitor icon.

To complete installation, follow the instructions on the Install Wizard screens.

Note fo users of previous versions of Opficon Monitor software: If Opticon Monitor is already
installed on the computer, the Install Wizard will first uninstall the existing version. You then must
run the Install Wizard a second time fo instoll Opticon Monitor version 2.03.

Using the Install Wizard on the Opticon Monitar program disk to uninstall Opticon Moni-
tor will not affect previously stored data, master, plate, or protocol files. To avoid delet-
ing important files, use the Install Wizard on the Opticon Monitor disk, as described above,
to uninstall the Opticon Monitor program.

Caution: Using Windows software to uninstall Opticon Monitor will
erase all Opticon Monitor files, including data files. :
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How Opticon Monitor Software Works

Opticon Monitor software is structured such that different types of operations are accessed
from different screens. Operations can be categorized into three stages: experimental
setup, data acquisifion and monitoring, and data analysis.

1. Experimental setup and programming. Setup and programming operations
are accessed from the Master File window. The master file consists of a plate file, which
specifies the parameters {e.g. well contents) of the plate, and a protocol file, which speci-
fies the experimental conditions {e.g. incubation temperatures and timing of flucrescence
measurements). Users can create new files or use exisfing files, in their current form or
after editing.

2. Run initiation and status. After a plafe and o profocol setup have been created
or selected, a run can be initiated. The user may stop the run at any fime and may skip
protocal steps, if desired. The Status window appears automatically upon run initiation
and can be used fo monitor the progress of the run and the ongoing thermal profile of the
sample, block, and/or lid. Data collection can be monitored during the run by plotting
fluorescence infensity vs. cycle number.

3. Data analysis. Depending on the type of data being collected {as specified in the
master file] data can be analyzed using the Quantitation, Melting Curve, and/or Analy-
sis windows. Starting copy number can be quantified either during or after the run by
.using the functions in the Quantitation window to set the threshold line for determining
C{t) values, view and adjust an'automatically generated standard curve, and interpolate
samples with unknown template concentrations against the curve. If melting analysis
was performed, the melting profile, including fluorescence intensity vs. temperature and/
or the negative first derivative {~dI/dl of fluorescence intensify vs. temperature, can be
viewed in the Melting Curve window.
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Launching and Navigating Opticon Monitor Software

To launch the Opticon Monitor software, choose Programs from the Windows Start menu,
and then Opticon Monitor. If you are planning fo perform an experimental run, make
sure the Chromo4 system is turned on, closed, and attached to the computer.

Upon first launching the Opticon Menitor software, you must accept the terms of the Ii-
censing agreement. After you click Accept, the Opticon Monitor window will appear dis-
playing a new master file template. On subsequent launches, the window will display the
master file template that was last used in an experimental run. Users can also launch
Opticon Menitor software by double clicking on an existing Opticon Monitor master

(.mast), plate {.plate), protocol (.prot), or data {.tad2) file, in which case the chosen file
will be displayed. '

Nofe: If the Chromo4 system is not attached to the computer, a message stating that the com-
puter is unable fo communicate with the Chromo4 system will appeor upon launching Opticon
Monitor software. The user will be instructed fo make sure that the Chromo4 unit is turned on,
closed, and properly connected to the computer. If Opticon Monitor software is being used for
analysis only, the user may confinue simply by clicking OK.

4. Setup/Status/Analysis display

3. Pulldown menus window (showing master file)

¥ Opticop Monltor: Mastar Flla

1. Toolbar

{ e R

2. Status box
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Opticon Monitor window features include:

1. Toolbar: The toolbar confains menu buttons that serve as the primary means of
navigation between the setup/programming, run/status, and data analysis windows:

Experimental setup & programming

Data acquisition and monitoring

m‘.‘-!‘_‘""i{"&.ﬁ fg\fﬁ ing Data 0nc1|y5is
|

et L GGt AL ST e T

R ST

AR RIRTEE |
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2. The Run-Status Box indicates whether or not a protocol or infinite incubation
step is running. If o protocol is running, it lists the estimated time remaining in the run,
the current step and cycle counts, and the current temperatures.

| Protozol info
1|: Running -
: ND |
qL oo Step NO

Time Rermaining
Total 0::00:00:

Program Counter |
- |:Step # 0|
i BE:O2:80 |
| Cycle #t 0y
oy of 0
i1 Tempsratue
Sample 288C
‘| Bleck 288C
‘| 'Lid 28.2C

3. Pull-down menus: The pull-down menus provide access to many functions includ-
ing the ability to export data, create calibration files for specific dyes, and view
message and error logs.

4. Setup/status/analysis display window: This window displays the selected
setup, status, or analysis screen.

Exiting Opticon Monitor Software

Exit Opticon Monitor software by selecting Exit from the File menu, or by clicking the
close button in the upperright corner of the title bar. If o protocol is running, you should
stop the protocol before exiting Opticon Monitor software.
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Opticon Monitor File Extensions

When saving files, the Opticon Monitor software automatically adds one of the following file
extensions: :

.mast  Master file: Controls a run by specifying which plate and protocol
files to apply during the run.

-.plate  Plate file: Specifies the contents of the 96 wells, any descriptive well labels that
were assigned, the calibration files for the plate type and dyes used, and the
amounts of any quantitation standards for use in generating a standard curve.

.prot Protocol file: Specifies the order and parameters of protacol steps including
temperature incubations, plate reads, temperature gradients, goto steps, and
melting curves.

tad2  Data file: Contains the fluorescence and femperature data collected during the
run, and any selected options and analysis parameters.

Which Version of Opticon Monitor Software Are You
Running?

To determine which version of Opticon Monitor software is currently installed on your
computer, choose About Opticon Monitor from the Help menu. The About window will
display the Opticon Monitor version number. This manual doecuments Opticon Monitor
software, version 2.03.

Viewing Logs

To view a record of operations performed by the Opticon Monitor software, select Mes-
sage log from the View pull-down menu.

To view a list of error messages, select Error log from the View pull-down menu.
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Creating a Master File

Upon launching the Opticon Monitor software {see Chapter 5], the Opticon Monitor win-
dow will appear displaying either a new master file template (first launch], or the last
master file used {subsequent launches). All setup and programming operations can be
accessed from the Master File window.

Before running a protocol on the Chromo4 system, the user must tell the system how the
microplate is set up, and what thermalcycling parameters to use in the run. This is done
with plate and profocol files, respectively. The master file specifies which specific plate
and protocol files are to be used in a run. The first section of this chapfer will describe
how to create new plate and protocol files and how to assign them to a master file. The
second section will describe how to assign existing plafe and protocol files, with or with-
out modifications, to a master file. Finally, instructions for reusing and editing existing
master files will be discussed.

$ Opticon Manitor ¢ Mastar Fle

New master file

A master file consists of two component files:

1. The plate file specifies the contents of the wells, any descriptive well labels that the
user assigns, the calibration files for the plate type and dyes used, and the quantities
of any standards fo be used in generating a standard curve.

2. The protocol file specifies the order and parameters of temperature incubations,
plate reads, temperature gradients, goto steps, and melting curves to be used for the
experimental run. It also specifies the reaction volume, temperature control method,
and heated lid seftings.
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The New, Edit, Open, and Save buttons located in the Plate Setup and Protocol Setup
panels of the Master File window can be used fo assign new or existing files to the master
file as described below. Alternatively, the Quick Load menus can be used fo quickly as-

sign existing plate and profocol files to the master file (see the "Using the Quick Load
Menus" section at the end of this chapier).

Instrument Selection/Re-initialization Panel

If more than one instrument is connected to the computer, use the pull-down menu in the
Instrument selection/re-initialization panel fo select the instrument you wish to ruri. This
panel may also be used to re-nitialize the Chromo4 detector, for example if it were not
properly connected fo the computer upon launching Opticon Monitor software, by select-
ing Chromo4 from the pull-down menu.

Specifying a User

The User feature allows users to organize master, plate, protocol and data files by plac-
ing them in the Shared folder or into personal folders.

To select a user, click the icon in the Master File window.

In the Manage Users window that appears, highlight the name of the user you want fo
choose..This user’s folder will become the default save location for newly saved files.

Add

Lisa - Remave

i

..... _ Close I

Adding New Users

To create a new user, select Add. Enter the new user's name in the New User window
that appears and select OK. The new user's name will appear in the Users list

Removing Users

To remove a user from the Opticon Monitor software, select the user's name in the Man-
age Users window and then select Remove. You will be asked to confirm delefion of the
user, as all data associated with the user will alse be deleted.
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Assigning New Plate and Protocol Files to a Master File
Creating a Plate File

A plate file describes the contents of the experimenial microplate. The Optlicon Menitor
software uses the information in this file to interpret the raw data collected by the fluores-
cence detectors. The plate file specifies the type of microplate and dyes used in the experi-
ment, so that the software can apply the appropriate calibration files to the data. The plate
file also defines the contents (see below) of individual wells, the quantities and units of any
standards, and may contain well descriptions fo identify the specific reaction components.

Note to users of previous versions of Opticon Monitor software: The reaction volume is now
specified in the protocol file.

One of four possible "content" types is assigned for each of the four dye channels for
each well. The four content types are: "Empty" (software will ignore collected data), "Blank"
{collected data may be used for background subtraction or controls), "Quantitation Stan-
dard" (software will use data for standard-curve generation}, and "Sample" {the unknown
and control reactions). Because contents are defined for each channel, one well may be
classified as blank with regard to one dye and sample with regards to another dye.

To create a new plate file, click the New button in the Plate Setup panel of the Master File
window. The following screen will appear. Refer back to this figure as you read the fol-
lowing pages of this manual; which describe the panels in more detail.

Wells with all but Wells with dyes
one dye assigned assigned Selected
as "Empty” different "*Contents" wells

Wells with all dyes

assigned same "Contents"

Plate
Plate information

dicgrcm\ / table

Dyes panel

Highlighted 1% e
wel et e o R

Confents
panel

—
Plate and Dye
selection panel

Wells

panel

Plate file window
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Parts of the Plate Setup Window

The Plate Setup window is made up of the following panels:

The Plate diagram is o representation of the 96 wells that may be used in the experiment.
Each well in an experiment cani be defined as containing up to four different dyes, and
each dye can be used in one of three different reaction types. The wells in the Plate dia-
gram are color-coded according to the reaction type, or "Contents", specified for each
dye: white for empty (dye not used), blue for blank, green for standards, and red for sample.

The Plate diagram can display the confents for a paricular dye or for all dyes. When
displaying contents for all dyes, the wells in the diagram are partitioned into four quad-
rants. Contents for dye 1 are displayed in the upper left quadrant, for dye 2 in the upper
right, for dye 3 in the lower left, and for dye 4 in the lower right.

The Dyes panel, to the left of the Plate diagram, is used to select which dye to display in
the Plate diagram, or to select All dyes. :

The Contents panel is used to indicate what type of reactions, Empty, Blank, Standard, or
Sample, are present for each color dye in each well.

The Plate and Dye selection panel is used to indicate what vessel type and dyes will be
used in the experiment.

- The Plate information table is a list of the contents of each well, including any descrip-
tions the user adds as a reminder of the specific contents.

The Wells panel is used fo enter the descriptions that appear in the plate information fable.
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Selecting and Deselecting Wells

To select wells, either for assigning content for an experiment or, later, to view the data
for a specific well, you can use either the Plate diagram or the plate information table to
the right of the Plate diagram.

Selecting Wells Using the Plate Diagram

Move the cursor over an individual well, row letter, or column number io highlight the
well or wells with a thin outline and darken the corresponding well coordinates (see well
H1 in the diagram on page é-4). Clicking on a highlighted well will select it. Selected
cells appear heavily outlined, and the fields of the corresponding wells are highlighted
in the plate information table (see wells in column 10 in the diagram on page 6-4).

Select an individual well by clicking on the well.

Select multiple wells by holding down the left mouse button and dragging the
cursor over the wells fo be selected, or hold down the control key and click on the
individual wells you wish to select.

Select all wells in o column by clicking on the numbered box at the top of the
column. To select multiple columns, hold down the control key and click on the
numbered box at the top of each column to be selected.

Select all wells in a row by clicking on the lettered box at the start of the row. To
select mulfiple rows, hold down the control key and click on the leitered box at
the start of each row to be selected.

Select all wells in the plate by clicking on the * in the upperleft corner of the
Plate diagram.

To deselect a well(s), either click on the well(s) again or select another well or set
of wells.

Selecting Wells Using the Plate Information Table

Select an individual well by clicking on the well's coordinates (e.g., A1) in the table.

Select multiple wells by holding down the control key and left clicking on each
well’s coordinates fo select it.
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Specifying the Plate Type and Dyes

, The Chromo4 detector must be calibrated for both the plate type and the dyes that will be
5 used in an experiment. The system comes pre-calibrated with settings for plates
and many commonly used dye chemistries. Plate calibration files exist for white
or clear wells. Dye calibration files exist for Cy3, Cy5, FAM, HEX, JOE, ROX, SYBR Green
i l, TAMRA, TET, Texas Red, and VIC. Please note that not all dyes can be read in each
' channel. Dyes are only listed under the channelfs) that have the appropriafe excitation
| and detection wavelengths for the dye.

Select the desired Plate type from the drop-down list.

| Next, select the Dye that should be detected in each charinel. This panel tells the soft-
ware which dye-calibration files fo use. All channels must have a dye option applied to
begin the run.

| IF the desired calibration file is not present for the dye/plate combination being used, it
may be possible to use the setfing for one of the pre-calibrated dyes, if one has excitation
1 and emission spectra similar to those of the dye you want fo use. Please contact MJ Re-
search if you would like calibration recommendations when using non-precalibrated dyes.

IF it is not possible to use one of the pre-calibrated seftings, it will be necessary fo perform a
calibration by selecting Dye Calibration fram the Tools pulldown menu. Follow the direc-
tions in the Dye Calibration Wizard to create a calibrafion file(s) for the dye(s) being used.

Dye: Calibeatin Wizard:

_degludpecﬁﬁelbzi SRR : ) ; W&hﬂéladye’:c;!ﬁa!i;’n 0 B ;
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Specifying Dye(s) Displayed in the Plate Diagram

Use the drop down list in the Dyes panel fo select which dye to display in the Plate dia-
gram, or select All to display the contents for all wells at once. When Allis selected, the
wells in the Plate diagram are seciioned into quadrants. Contents for dye 1 are displayed
in the upper left quadrant, for dye 2 in the upper right, for dye 3 in the lower left, and for
dye 4 in the lower right.

Assigning Well Contents

If you will be performing an experiment in which all dyes will be assigned the same con-
tents in every well, select All in the Dyes panel. This facilitates Plate setup by allowing
you fo assign the contents for all dyes at the same time.

If you will be performing an experiment in which some wells will contain different con-
tents for the individual dyes (e.g. standard for dye 1 and sample for dye 2, or sample for
dye 1 and blank for dye 2}, you must assign the contents o the wells for each dye indi-
vidually. First, select dye 1 in the Dyes panel. Wells in the Plate diagram will not be par-
fitioned because only the well assignments for dye 1 will be illusirated. Follow the in-
struciions below to assign contents to all wells containing dye 1. Then, choose dye 2 in
the Dyes panel. The Plate diagram will appear empty because no contents have yet been
assigned to dye 2. Follow the insiructions below to assign contents to all wells containing

. dye 2. Repeat these steps-for dye 3 and dye 4. Affer assigning content to wells for all
dyes, fo view the confents assigned to each dye simultaneously, select All. Lines partition-
ing the wells will appear, and those wells that were assigned different contents for the
four dyes will display different colors in the four quadrants, accordingly.

After specifying which dyes are displayed in the Plate diagram as described above, follow
the steps below fo identify well contents as Emplty, Blank, quantifation Standard, or Sample:

1. Select the well or group of wells fo which a specific content is to be assigned, using
one of the methods described in the section "Selecting and Deselecting Wells".

2. Assign the appropriate contents fo selected wells by clicking on one of the four
butions in the Confents panel:

o Empfy (white): The well does not contain reactions for the selected dyefs]. Col-
lected data will be ignored.

o Blank [blue): The well contains a blank reaction {e.g., buffer only} for the se-
lected dye(s). Fluorescence intensity measurements from blank wells can later be
used in background subtraction calculations.
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* Quantitation Standard (green): The well contains a user-specified standard of
known quantity for the selected dyels] (see the “Specifying Quantitation Stan-
dards” section below). Fluorescence intensity readings from quantitation stan-
dards are used to plot a standard curve.

* Sample (red): The well contains an experimental sample {unknown or control) for
the selected dye(s).

The Contents column of the plate information table lists the content assignment
(empty, blank, quantitation standard, or sample} and content color {white, blue,
green, or red) for all dyes for each well. The listing of wells in the plate information
table can be sorted according to well or dye by selecting Sort Primarily by Well {or
Sort Primarily by Dye). The wells can be further sorted by column or row. Select
Across Rows o list the wells in order of row {e.g., Al, A2, A3); select Down
Columns to list the wells in order of column (e.g., A1, B, C1).

3. To change the content assignment of a well, select the well as described in step 1 and
click on the desired bution in the Contents panel. Make sure the correct dye is se-
lected in the Dyes panel before changing the contents. The well's color and corre-
sponding content information in the plate information table will reflect the confent
change. The confent assignment for the well can be changed after the run.

Assigning Well Descriptions

To aid in sample idenfification, you can enter well descriptions for individual wells or
groups of wells. Begin by selecting the wellfs) using the Plate diagram or plate informa-
fion table as described in the “Selecting and Deselecting Wells” section above. Then,
type a description in the Well Label (Dye 1), Well Label {Dye 2}, Well Label {Dye 3),
and/or Well Label (Dye 4} field(s). The well label will be applied to the selected well or
wells and appear in the Description column in the plate information table. Note that by
enfering the label in the Well Label panel you can label multiple wells ot once. Alterna-
tively, click on an individual row in the plate information fable and type a well label di-
rectly into the well’s Description field. You can also copy and paste a well label from one
Description field in the table to a second Description field by first clicking on the Descrip-
tion field and then using control+c to copy and control+v to paste. To simultaneously paste
a well label into the Description fields of multiple wells, select the wells as described above
and use confrol+v to paste into the desired Well Label field.
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Specifying Quantitation Standards

IF you are using quantitation standards, click the Specify Quant Standards button after you
have designated standardscontaining wells. A pop-up window will appear, with a table
listing all of the wells that have been designated as standards. If some wells contain stan-
dards for some, but not all dyes, then "[not a standard]" will appear in the cells correspond-
ing fo those wells/dyes {e.g. cell G1, dye #4 and cell H1, dye #4 in the figure below].

iDye 4 Amotng

! 111 AmuountDye #2 Amount i
Fn 5 1 i
a1 [ T | 10 " P
100 100 100
1000 qoon 1008
Tooon ‘1n0o0 " oo .
7 100000 100000 100000 S E
&1 | 1e+006 Tet0D6  1e+D06  |Rolpsiandera) -
0o Testd7 " Tes007 CHesn0?

To specify quantifation standards, first enter the amount of each standard in the Dye #1
Amount, Dye #2 Amount, Dye #3 Amount, and Dye #4 Amount fields as applicable.
Small numbers may be entered as integers or using scientific notation (e.g., 1E4]; but
numbers greater than or equal to 1E7 must be written as scientific notation. Next, specify
the Units of the standard by choosing ng, pg, moles, molecules, ge {genome equivalents),
or copies from the pull-down menu. You can define additional units by selecfing the Man-
age buiton (see below).

Select OK to apply the standard specifications fo the plate file, or click Cancel to undo
any changes fo the standard specifications.

A standard curve will auiomatically be generated during analysis of the data using the
values supplied. You will be able to adjust the standard curve by deselecting points
(see Chapter 8).
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To define additional units, first click on the Manage buton in the Specify Quantitation
Standards pop-up window. Next, select Add in the Manage Standards window that ap-
pears, and then typs the desired unit name in the Add Quantitation Standard Name win-
dow. To remove unit designations, highlight the designafion in the Standards list in the
Manage Standards window and click the Remove button.

;:pie: . Stardard Name ) ﬁ'e:tﬁuve. I
¢ |moleculez .
¢ [moler iI
ng
e} )
[T | ooneal |
T ok i

Pasting Plate Data from Excel

If on @ previous run you exported a plate file to an Excel spreadsheet (see Exporting Data
in Chapter 8), you may paste the plate information from the Excel file into the Opticon Monitor
plate file. First, open the Excel file and select the type of plate information you want to
paste {Well Name, Dye, Contents, and/or Description). Include the column headings to
have these automatically applied in the Opticon Monitor software. Copy the selected
cells o the clipboard. Next, return o the Opticen Monitor screen and, in the Plate Sefup
window, select Paste from Excel from the Edit menu. The following window will appear:

Saoited By_;" -

) Columns
I Foice Set By € Fis € Colimer

[Weltame =]  AlAz.

Do ] FAM.HEX..

Descriplion - B-Aclin, HPRT...
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TS Cancel
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If you copied the column headings specifying the type of plate information, these head-
ings will automatically appear in the drop-down menus in the Plafe Setup - Excel Import
dialag box. If the headings were not selected, or if you want to reclassify the data, select
the type of plate information from the drop-down menu. Note that the data in each col-
umn must match the format for the different plate information types (Well Name, Dye,
Confents, or Description). Click OK to enter the plate information info the plate informa-
tion table. Note that other plate parameters, such as plate and dye type, and values of
quantitation standards, are not specified by the Paste from Excel command.

Exiting the Plate Setup

Once you have finished entering plate file parameters, click the OK button in the upper-
left corner of the Plate Setup window to return to the Master File window. A picture and
summary of the assigned plate contents will appear in the Plate Setup panel of the Mas-
ter File window. '

Alternatively, if you wish to discard the plate file infermation and return to the Master
File window, click Cancel.

Saving a Plate File

To save the newly created plate file, select the Save button from the Plate Setup panel in
the Master File window. Enter an appropriate name in the File name field of the Save
window. Click the Save button fo save the .plate file.
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Creating a Protocol File

The protocol file contains a program that controls the thermalcycling parameters of an
experimental run and specifies when during the run the Chromo 4 detector will measure the
fluorescence in the wells. Protocol steps are entered and edited in the Profocol Setup win-
dow. A listing and graphical representation of the protocol are displayed for easy review.

Click the New button in the Protocol Setup panel of the Master File window fo create a
new protocol file.
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protocol and Lid Mode Reaction
creation panel Volume
panel T —— w%_\ e SN field
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Protocol file window
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Choosing a Temperature and a Lid Control Mode

Click the Editbution in the Temperature and Lid Mode panel to display the Protocol Options
window, and to specify the methods of temperature and lid conirol to be used in the run.

on Menitor - Protocol Dptions

Temperature Control Modes

The Chromo4 system can conirol block temperature in two different ways. Each method
has implications for the speed and accuracy of sample heating.

1. Caleulated contral is the default method of temperature control. Calculated confrol is
the method of choice for most profocols, yielding consistent, reliable, and fast results.
When using calculated conrol, the Chromo4 system maintains a running estimate of
sample temperature based on the block’s thermal profile, the rate of heat transfer
through the sample fube, and the sample volume. Since this esfimate is based on
known quantities and the laws of thermodynamics, sample temperatures are con-
trolled much more accurately than with block temperature control,

Hold fimes can be shortened significantly when protocols are run under calcu-
lated control. Typically, for cycling denaturations running under the calcu-
lated control method, optimal hold times range from 5 to 30 seconds. Anneal-
ing/extension steps can also be shortened—but the periods for these will be
reaction specific. In addition to offering the simple convenience of spending
less time running reactions, shorter protocols minimize false priming and help
fo preserve enzyme acfivity.

6-14  Tech Support: {888) 652-9253 # Scles: (888) 735-8437 » tech@mijr.com ® www.mjr.com



Experimental Setup and Programming m

Calculated control permits shorter protocols for three reasons:

* Brief and precise block-femperature overshoots are used to bring samples
to femperature rapidly.

* Incubation periods are timed according to how long the samples, not the
block, reside af the target temperature.

* The instrument automatically compensates for vessel type and reaction
volume.

2. When Block control is selected, the Chromo4 system adjusts the block’s tempera-
ture fo maintain the block at programmed temperatures without calculating sample
temperature. Block control provides less precision in control of actual sample
temperature than calculated control provides. Under block control, the tfempera-
ture of samples always lags behind the temperature of the block. The length of
the time lag depends on the vessel type and sample volume but is typically be-
tween 10 and 30 seconds. Block control is used chiefly to run protocols devel-
oped for other thermal cyclers that use block confrol, including the PTC-100®
cycler and the MiniCycler® personal cycler from MJ Research.

Reaction Volume

For the Opticon Monitor software to accurately caleulate and control the sample tem-
perature, you must enter the volume of your reactions (in ul, including the volume of
any oil or wax overlay) in the Reaction Volume field in the upper righthand corner of
the protocol file window. For volumes less than 10pl enter 10y, See the "Reaction
Volume Recommendations" section in Chapter 4 for addifional information.

Lid Control Modes

When a sample is heated, condensation under the tube cap or the plate cover can
occur. This changes the volume of the sample, the concentration of components, and
thus the kinetics of the enzymatic reaction. Use of a heated lid minimizes condensa-
tion by keeping the upper surface of the reaction vessel ot a temperature slightly greater
than that of the sample itself.

The Chromod system provides three options for controlling lid temperature: Constant,
Tracking, or Of.

* The Constant method keeps the inner lid ot o specified temperature ["C). This is the
default method of control. To use constant lidtemperature control, select Constant
and enter a Lid Temperature between 30°C and 110°C or use the arrows to scroll
o the desired temperature. A temperature of 5°C fo 15°C above the highest tem-
perature in a protocol is recommended. You can also specify a sample-block tem-
perature below which the heated lid will turn off. Enter a Lid Shutoff Temperature
between 1°C and 50°C or use the arrows to scroll fo the desired temperature.
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* The Tracking method offsets the temperature of the heated inner lid a minimum
specified number of degrees relative fo the temperature of the sample block.
Tracking is useful for protocols that have long incubations in the range of 30-
70°C, in which it may be undesirable to keep the lid at a very high femperature.
An offset of 5°C above block temperature is adequate for most protocals. To use
tracking lid-temperature control, select Tracking and enter the number of de-
grees, from 1°C to 45°C, that you wish the lid temperature fo be maintained
above the block temperature, in the line Lid Temperature = Block Temperature +
__°C.You can also use the arrows to scroll fo the desired temperature. To specify
a sample-block temperature below which the heated lid will turn off, enter a Lid
Shutoff Temperature between 1°C and 50°C or use the arrows to scroll to the
desired femperature.

Note: Because there is no active cooling of the lid, a decrease in the lid temperature
may not be observed during rapid cycling. Nofe also that the lid heats more
slowly than the sample block due fo its additional thermal mass.

e When Offis selected in the lid conirol panel, no power is applied to the heated
lid. In this mode, condensation will occur at a rate consistent with the incubation
temperature and the type of fube or plate sealant being used. This option is
recommended only when using an oil or wax overlay.

Click the OK bution to apply the temperature and lid control seftings to the protocol,
or choose. Cancel to close the window without changing the seftings applied fo the
protocol. The Temperature Control and Lid Seftings will appear in the appropriate
fields of the Temperature and Lid Mode panel in the Protocol Setup window.

Designing and Entering a Protocol

Programming the Chromo4 system consists of entering a series of steps comprising a pro-
tocol. This section will present a sample protocol and describe how to enter the protocol
steps. Additional protocol options will also be described.

Consider the following example pré’roco]:

1.
2.

o o oA W

Incubate at 94°C for 1 minute

Optimize annealing temperature by incubating at a range of 55°C to 65°C across
the 12 columns of the sample block, for 30 seconds

Read the fluorescence intensity of the Blank, Quantifation Standard, and Sample wells
Incubate at 72°C for 1 minute
Sequentially repeat steps 1-4, 29 more times, then proceed to step 6

Characterize reaction products by melting profile: Raise the temperature from 55°C to
90°C, and read the fluorescence 10 seconds after every 1°C increase in temperature
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Entering a New Protocol

As you insert steps into a protocol, descriptions of the steps will appear in the Protocol List
panel of the Protocol Setup window, and a graphical representation of each step’s tem-
perature and time period (in minutes) will appear in the Protocal Graph panel. To view the
graphical display more clearly, Use the sliders to the left of the graph panel fo zoom in and
out on the X and Y axes. Use the scroll bars on the axes o position the graph appropri-
ately. An example of a zoomed protocol, showing only the first five steps, is shown on
page 6-13.

Before beginning to enter a new protacol, note that the END step is highlighted in the
Protocol List panel. Opticon Menitor software adds new steps immediately before the step
that is highlighted.

Temperature Step

A temperature step specifies incubation temperature and duration. The Chromod4 sys-
tem ramps the sample fo this temperature at its maximum rate unless ramp modifying
instructions are added to the program (see the “Manual Ramp Rate” description near
the end of this section).

Click the Temperature button fo enter a temperature incubation step (e.g., step 1 or
step 4 from our example} into a protocol.

Enter the desired temperature, from 0°C to 105°C, into the Sef temperature fo field
or use the arrows o scroll to the desired temperature — which is 94°C in step 1 of
our example.
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Enter the desired incubation time, to a maximum of 18 hours, in the Maintain for field.
Click in the hour: minute: or second field and either enter a fime period or use the
arrows fo scroll to the desired time—00:01:00 in step 1 of our example. Alternc-
tively, you can select Forever to maintain the desired temperature for an infinite pe-
riod of time. A forever incubation step at the end of a protocol can be useful for hold-
ing reaction products at a sub-ambient temperature (we recommend 10°C] until they
can be processed. A forever incubation can alse be useful as the first step in o pro-
gram, for example, to bring the block and lid to the denaturation temperature before
the reaction vessel is put info the block. In both cases, the SKIP button is then used to
proceed to the next step of the protocal {See Chapter 7).

In the graphical representation of the protocol, a forever incubation is indicated with

the ¢y symbol.

Click the Insert bution to add the temperature step o the profocol without further modi-
fications. The femperature step should appear as step 1 in the upper protocol display
window, and a graphical representation of the temperafure and duration should ap-
pear in the lower window. Note that the END step is again highlighted indicating that
the next step will be added immediately above the END step and therefore after step 1.

You can also choose fo modify a temperature step before inserting it into the protocol
by adding options. Available options include:

1. Manual ramp rate: Set a slowerthan-maximum rafe of heating or cooling. A
slower-than-maximum ramp rate ranging from 0.1°C to 2.5°C per second can be
specified. Fast thermal ramping between incubation steps can often help reduce
overall reaction times by 10% to 30% and may help reduce production of non-
specific products.

2. Change temperature: Modifies a temperature step fo allow a “per cycle” in-
crease or decrease of temperature (0.1°C to 10.0°C per cycle) each time ihe
step is executed. This feature is useful when annealing stringency is a consider-
ation, such as in a fouchdown program.

In a touchdown program, the temperature selected for the annealing step begins
higher than the calculated annealing temperature and incrementally decreases
with each cycle, first reaching, and eventually falling below, the calculated an-
nealing temperature. Thus the reaction begins ot a temperature favoring high
stringency in hybridization and increments to a lower stringency. The higher
initial stringency favors the desired product by creating a high signalto-noise
ratio in the early amplification cycles.

3. Change time: Modifies a temperature step to allow a “per cycle” lengthening
or shortening of the hold time of the step {by 1-60 sec/cycle] each time the step
is executed. .

The change-ime capability is useful for slowly increasing (typically by 2 to 5 sec-
onds per cycle) the hold time during an extension step. The number of bases that
polymerase must incorporafe during the extension step increases in later cycles
because there are more template molecules and/or fewer active polymerase mol-
ecules. Allotting extra time for extension can allow synthesis fo be complefed.
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4. Beep when complefed: Modifies o temperature step so the insirument will beep
when the target femperature is reached.

Gradient Step

The temperature gradient feature allows you to opfimize denaturing or annealing
conditions by incubating at several different temperatures simultaneously. The range
of temperatures that can be achieved from left o right across the 96-well sample block
can be as small as 1.0°C or as great as 24.0°C. The maximum programmable tem-
perature is 105.0°C; the minimum programmable temperature is 30.0°C.

Click the Gradient button fo insert a gradient step into a profocal.
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The minimum gradient temperature is assigned to the far left column {column #1) of
the sample block and can range from 30°C to 104°C. In our example, the Left Tempera-
ture (Lower} field is set to 55. The maximum gradient temperature is assigned fo the far
right column (column #12) and can range from 31°C to 105°C. In our example, the
Right Temperature {Higher) field is set to 65. The minimum temperature differential
between the far left and far right columns is 1.0°C and the maximum differential is
24.0°C. Awarning will appear if you attempt to enter a differential that exceeds 24.0°C.

After entering the range of temperatures for the gradient, enter the desired incuba-
tion time in the Maintain Temperature for field by clicking in the hour: minute: or sec-
ond field and either entering a time period or using the arrows to scroll fo the desired
time — 00:00:30 in step 2 of our example. Alternatively, you can select Forever to
maintain the desired temperature gradient for an infinite period of fime.

Tech Support: (888) 652-9253 » Sales: (888) 735-8437 » tech@mir.com ® www.mjr.com  6-19



B Chromo4 Real-Time Detector Operations Manual

Click Inserfto add the gradient siep fo the protocol without further modifications. The
gradient step should appear as step 2 in the protocel display window. Note that the
END step is again highlighted indicating that the next step will be added above the
END step and therefore after step 2.

You can dlso choose to modify the gradient step before inserting it into the profocol
by choosing the Change Time option (see the “Temperature Step” section for an ex-
planation of this option).

Gradient Calculator

To accurately predict the temperature of each of the twelve columns across the
block during a gradient incubation, select Gradient Caleulator from the Tools menu.
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Note that the gradient temperature distribution is not linear but, rather, has a
broader spread in temperature between the center columns of wells. This is a natural
consequence of the geometry of the PeltierJoule heaters that underlie the block.
Although not evenly distributed, the temperatures displayed are quite accurate
for each well in a given column {£0.4°C of actual column femperature). The indi-
cated femperature of the column that yields the best reaction results can be accu-
rately transferred to a temperature step in a non-gradient protocol.

Plate Read Step

Insertion of a plaie read step directs the Chromo4 detector to measure the fluores-
cence of the wells. The plate read begins immediately after the programmed end of

" the previous incubation step, step 2 in our example. The Chromo4 detector performs
the plate read at the current incubation temperature, and then initiates the next step,
step 4 in our example.

To insert a plate read step, click the Plate Read bution. A plate read step will be
inserted into the protocol. In our example, the plate read step should appear as step
3 in the Protocol List panel. A plate read appears as an eye icon in the graphical
profocol display.
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Adding Multiple Temperature Steps, Gradient Steps, or Plate
Reads

To add additienal temperature steps, gradient steps, or plate reads to your protocal, click
the appropriate bution and follow the directions for the specific step as outlined above.

Following our example, step 4 is a temperature incubation step of 72°C for a dura-
fion of 00:01:00 with no additional options.

Goto Step

The goto step abbreviates a protocol that has many repeating steps. When a goto
step is executed, the profocol program returns to the step specified by the goto step,
and repeats that step and all subsequent steps back to the gofo step. After it has looped
back fo the goto step a specified number of times, the protocol program maves on to
the step that follows the goto step. Neote: You cannot nest goto steps. In other words,
a protacol loop cannot contain another goto step within this loop. You cannot include
melting curve steps {see next section) within a goto loop.

Step 5 of our example protocal indicates that the protocol should refurn to step 1,
repeat steps 1-4 an additional 29 times for a fotal of 30 cycles, and then proceed to
step 6. To add the goto step, click the Goto bution in the protocol creation panel.

Ersa‘éd'ﬁlepln_!ﬁgg,g'gé,é{a::l;.: T

i [ Gotaine 7

Enter the line number of the step to which the profocol program should return. You
may also select the number of the step using the drop-down menu, which is accessed
by clicking the arrow fo the right of the Go to fine field. In our example, enter 1 in the
Go to line field, and 29 in the How many more times? field. Step 5 of our protocol
will then direct the Chromo4 detector to repeat steps 1,2,3, and 4 of the protocol 29
fimes before continuing on to step 6. {Steps 1-4 will be performed a total of 30 fimes.)

Click the Insert button to add the goto step to the profocol.
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Melting Curve Step

A melting curve can be performed to identify specific products and/of assess the ho-
mogeneity of a sample. Melting curve profiles are influenced by several factors, in-
cluding the number and conceniration of discreet fragments produced, the length and
G+C content of each fragment, and buffer conditions.

Melfing curves are often useful in verifying the identity of amplification products, as
well as distinguishing positive internal controls from amplified products. In these cases,
simply specify a melting curve after a cycling run, and the instrument will perform
both procedures automatically.

The Chromo4 system can also be programmed fo run a melting curve independent of a
cycling protocol. This analysis can be useful in a variety of applications including
homothermic assays, sizing fragments relative to ladders, and ufilizing the 9é-well
capacity of the Chromo4 detector to perform endpoint assays fo increase throughput.

To add a melting curve step, click the Melting Curve button in the protocol creation
panel.

- Galect Step to Insert Béfu:r.e Lins
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Enter a Start temperature (0.0°C to 99.0°C), and an End femperature (1.0°C fo
100.0°C). In our example, the melting curve starts af 55°C and ends at 90°C.

Next, specify when during the melting curve step the Chromo4 defector will measure
fluorescence. Designate a temperature Increment between reads of 0.1°C fo 10°C
and a Hold Time between reads (1 second fo 1 hour] corresponding to the duration
for which the temperature increment should be maintained before the fluorescence is
read. A femperature increment of 0.2°C and a hold time of Ssec is recommended
for many profocols.
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Click the Insert button to add a melting curve step fo the protocol. Data can be ana-
lyzed from only one melting curve step per profocal.
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Editing a Protocol Step

To edit a protocal step, first click on the step in the protocol display window to highlight it.
Then, click the Edit Step button in the protocol editing panel. The parameters for the step as
itis currently entered will appear. After making the desired changes, click the Replace but-
fon to enter the edited siep into the protacol, or click Cancel to leave the step unmodified.

Deleting a Protocol Step

To delete a protocol step, click on the step in the protocol display window to highlight if .
Then, click the Delefe Step button in the protocal editing panel fo remove the step from
the protocol. The remaining protocel steps will automatically renumber.

Inserting a Protocol Step Between Existing Steps

To insert a protocol step between existing steps, highlight the step in the protocol display
window that will follow immediately afier the newly inserted step. All protocol steps are
added immediately before the step that is highlighted in the protocol display window.
Next, click the button corresponding to the type of step you would like to add. After you
click Insert, the.new step will be added and the protocol will be renumbered.

Exiting the Protocol Setup

Once you have finished entering protocolfile parameters, click the OK button in the
upper-left corner of the Protocol Setup window fo return to the Master File window. A
graphical representation of the protocol and a summary of the toial number of plate
reads, melting curves, and the estimated run duration will appear in the Protocol Setup
panel of the master file window.

If you wish to discard the protocel file information and refurn fo the master file, click Cancel.
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Saving a Protocol File

To save the newly created protocol file, select the Save butten from the Profocol Setup
panel in the Master File window. Enter an appropriate name in the File name field of the
Save window. Click the Save button to save the .prot file.

Saving a Master File

To save a master file, which will contain the plate and protocol files displayed in the Master
File window, click the Save button in the Master File panel. Enter an appropriate name in
the File name field of the Save window. Click the Save bution to save the .mast file.

You can also choose to not save this collection of component files and proceed directly to
the run {see Chapter 7 for infoermation on initiating @ run).

Assigning Existing Plate and Protocol Files
to a Master File

To assign existing plate and protocal files fo a new or existing master file, either click the

~ Open button in the panel of the master file window corresponding o the type of file you
wish to assign, or use the Quick Load menus to assign existing plate/protocol files to a
master file {see the "Using the Quick Load Menus" section below).

Selecting Open will display all the plate/protacol files in either the Shared folder or, if
user has been assigned to the master file, in that user's folder. Select the desired file or, if
the desired file has been saved o an alternate location, use the Windows browse screen
to locate the file, and then click Open. The plate/profocol file will be applied to the mas-
ter file, and a corresponding summary will appear in the Master File window.

To view the newly assigned plate or profocol file and/or make any necessary modifica-
tions, click the Edit button in the appropriate panel of the Master File window. The Plate
Setup or Protocol Setup window will open allowing you to modify the file parameters.
Select OK to retain any modifications and return to the Master File window, or select
Cancel to return to the Master File window without modifying the plate/protocal file.
Select Save to save any changes fo the plate/protocol file under the same or a newly
assigned file name. See the "Saving a Plate/Protocol File" sections in this chapter for
additional information on saving plate/protocol files.

Click the Save bution in the Master File panel fo save any changes to the master file.
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Reusing Master Files

A new master file need not be created for every run. Existing master files may be reused
without modifying the plate or protocol files, or the master file may be edited to accom-
modate changes such as a different arrangement of samples in the plate.

If @ run has just completed, or if a data file for a previously completed run has just been
displayed, and you wish to use the same master file, click on the Repeat This Run button
in the Master File window. To access a new master file templafe, click on the Prepare
New Run button. To display an existing master file, click the Open button in the Master
File panel, or use the Quick Load menu to assign an existing master file to the master file
template {see the "Using the Quick Load Menus" section below). To access a recently
used master file, select the desired master file from the list of Recent Master Files acces.
sible from the File menu.

Selecting Open will display all the master files in the Shared folder or, if a user has been
assigned to the master file template, in that user's folder. Select the desired file or use the
Windows browse screen to locate the file if it has been saved to a different location, and
then click Open. The master file will be applied to the master file template and the corre-
sponding plate and protocol file summaries will appear in the Master File window.

To use the master file without any changes, proceed to Chapter 7, Run Initiation and Status.

You can also modify the master file before initiating a run, by editing the assigned plate
or profocol files (Edit button), by substituting files {Open button or Quick load}, or by
creating new component files (New button).

Important Note: If a component plate or protocol file is edited and saved under the
same name, fhe edited file will replace the original file in all master files to which that file
has been assigned.

Click the Save button to save any changes to the master file.
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Using the Quick Load Menus

The Quick Load menus provide rapid access to any existing plate, protocol, master, or
data files. If the Plates/Protocols/Masters option is selected, all of the available plate,
protocol, or maser files that have been saved to the Shared folder or individual user fold-
ers are displayed in the drop-down menu. The files are listed along with their associated
user as shown below.

| hour hald

o ONURE—.

“|bob

Scroll to locate the desired file in the drop-down menu, and select the file. If the Data Files
option is selected, all of the data files are listed in the drop-down menu. Selecting a data
file will apply the plate, protocol, or master file that was used fo generate that data file to
the current master file template. '
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Running a Protocol

Before initiating @ run, check that the appropriate master file is displayed. Click the Mas-
ter bution on the toolbar to access the Master File window if it is not currently displayed.
If a run has just completed or a data file for a previously completed run has just been
displayed, select the Prepare New Run button to access a new master file template, or
select the Repeat This Run bution to use the same maser file (see Chapter 6 for instruc-
tions on how to create and edit master files).

Initiate the run by clicking the Run buiton on the toolbar. A Windows browse screen will
appear asking you to name the file to which the data will be saved. Click Save to accept
the default filename, or enter an appropriate file name and then click the Save button.
The data file will be saved as a .fad2 {acquired data) file. The file will be saved in the
data folder of the selected user [see Specifying a User, in Chapter 6].

The default data filename can be changed using the Filename Preferences command un-
der the User menu. The fields that can be included in the default filename are: username,
year {two format choices), month (two format choices), day {iwo format choices), time (six
format choices), and count, which adds an incremental count fo the filename. In addition
to these variable fields, the default filename can include constant characters, for example
an underscore between fields. The fields and constant characters must be typed into the
Data Filename Format field in the Filename Format window, as in the following example:

<year]>_<month2><day1>_<time4>

This sefting will result in a default filename as follows: |

2003_March15_102013PM

Interrupting a Run

Click the Stop button on the toolbar to halt the run’at any time. The Skip bution can be
used to skip to the next step in the protocol file. Note that if you press Skip while
a Goto loop is being executed, the program will skip out of the loop and
implement the next protocol step. Pressing Skip does not skip to the next
step within the loop. For example, if step 8 of a protocol says fo goto step 2 for 39
times, and you press Skip during the 20th execution of step 5, the program will skip to
step 9 of the protocol, nof step 6.
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Monitoring Run Status

| Protocol Information in the Run-Status Box

| A summary of run information is displayed in the status box located below the toolbar.
The run summary includes:

* Profocol information: indicates whether a protocol or a forever incubation is currently
| running.

| * Time Remaining: displays an estimate of the time remaining for the run.

* Program Counter: displays the current ste number, current cycle number, and the
g play. P Y
total number of cycles in the protocol.

* Temperature: displays the current sample, block, and lid temperatures.

| Pratecol Info

| Running - - .}
| T © OYES &
| [0 Step, 0 MO |
| Time Remairing - |

| Total 01:44:53 |

: F'lcgram Cﬁ%uﬁtef_'- :
| Step# o)
000049

| Coclo

| Temperat
B 'Sémijle.-
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The Status Window
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Toggle tabs

The Status windows allow you either o monitor run progress, by viewing the Thermal Cy-
cler Status screen, or fo monitor real-time data collection, by viewing the Optical Read Sta-
tus screen. The Thermal Cycler Staius screen is automatically displayed in the Status win-
dow when the run is initiated. To access the Status window after the run has completed,
click the Status bution on the toolbar. The fabs in the lowerleft corner of the Status window
toggle the display between the Thermal Cycler Status and Optical Read Status screens.

Thermal Cycler Status Screen

Thermal-cycler status window

The run status is graphically displayed in the top portion of the Thermal Cycler Stafus
window. Select the appropriate boxes in the graph-selection panel to display a graph of
the Sample, Block, and/or Lid temperatures over fime. To more clearly view a small sec-
tion of the graphls), use the X and Y zoom sliders to the left of the graph, or right click and
drag a box around the area of the graph that you wish to magnify. The protocol is listed
in the bottom portion of the window with the current step highlighted. The END step is
highlighted if the run has finished.
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Optical Read Status

Click the Optical Read Status tab to monitor realime data colleciion.

'Optical read status window

A graph of fluorescence versus cycle number can be displayed for the selected wells. Use
the Plate diagram to select the wells o be included in the graph (see the “Selecting Wells
Using the Plate Diagram” section in Chapter 6 for additional information). Note that no
data will appear in the graph until you select a well. Select Color 1 to display the graph
for dye 1, Color 2 to display the graph for dye 2, efc. Each dye will be ploited with o
different line style.

Selected wells will appear outlined in color. The color outlining the well corresponds to
the color of the well coordinates in the Graphed Samples list and to the color of the fluo-
rescence infensity frace in the graph.

Deselect all wells by clicking on any selected well. To deselect a subsst of wells, hold
down the control key, and click on the well(s) you wish to deselect. The well(s) will no
longer appear outlined in color, and the corresponding fluorescence intensity frace will
be removed from the graph.
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To highlight the results for a particular sample in the Plate diagram, Data and Standards
graph, and the Graphed Samples list:

e Move the cursor over a well on the Plate diagram. The column number and row letter
coordinates of the well will be highlighted in the Plate diagram. The well will also be
highlighted in the Graphed Samples list, and ifs trace will be thickened on the Data
and Standards graph.

e Move the cursor over a particular frace on the graph to thicken the frace and display
the x and y coordinates corresponding to the position of the cursor on the frace. The
corresponding well in the Plate diagram and the well coordinates in the Graphed
Samples list will also be highlighted

e Select a well from the Graphed Samples list to highlight the well coordinates in the
Plate diagram and thicken its trace on the Data and Standards graph.

Use the Step field in the Parameters panel fo display the signal intensity data for a par-
ficular step, if a plate read is included in more than one step of the protocol. This can be
particularly useful if, for example, you wish to monitor a plate read in sfep 3 and later a
melting curve in step 6.

Performing Data Analysis During a Run

The Opticon Monitor software allows users fo analyze data while a protocol is running.
Quanfitation, Analysis, and Melfing Curve screens can be used to view the data collected
so far in the current run {see Chapter 8 for more details about these screens]. It is also
possible to analyze data collected during a previous run while a current run is in progress.
To analyze previously gathered data during a run, select the File>Open->Data File path
you would normally use o open a data file. The Status, Quantitation, Melting Curve and
Analysis windows will display the data from the previous run and data analysis can be
performed as usual in these windows. The Protocol Info in the run-status box (in the lower-
left corner of the screen) will continue to display the siatus of the current run. In order to
close the data set and return to the current protocol running, select the Reatfach to Run
option located under the File menu.

It is also possible to open a second Opticon Monitor session while a run is in progress—
simply follow the same steps used to open the inifial session.
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Basic Principles of Quantitation

Confinuous reaHtime fluorescence detection of amplification products allows accurate
calculation of the initial quantity of template present in a sample. This is possible because
there is @ highly reproducible relationship betwsen the initial amount of template present
and the number of cycles required before a significant increase in fluorescence signal is
observed during the exponential phase of amplification. The larger the initial template
number, the fewer cycles required before significant fluorescence signal is detected. Based
on this relationship, the number of cycles completed before signal is defected can be
used to calculate the initial quantity of template in @ somple.

To caleulate the initial quantity of template in a sample, one must first define the threshold
above which fluorescence signal is deemed significant, using a graph of fluorescence
vs. cycle number. The threshold line is positioned on a graph of baseline-subiracted data
at a point where the signals surpass background levels and begin to increase exponen-
tially. The threshold cycle, Cft}, for an individual sample is then defined as the cycle at
which the sample’s fluorescence trace crosses the threshold line.

By including quantitation standards with a range of known initial amounts of template in
the run, one can generate a linear standard curve of the log of the template quantity vs.
Clf) value. The quantity of initial template in unknown samples can then be calculated by
interpolating the sample’s threshold cycle against the standard curve. On initial runs, or
for applications requiring a high degree of precision, including replicate quantitation
standards in the run can aid in positioning the threshold line. The use of replicates allows
one to determine which options for seffing the threshold line' parameters—described later
in this chapter—provide the tighiest fit of the replicates onfo the standard curve.

Quantitation in Opticon Monitor™ Software

Use the Quantitation window fo analyze Data and Standards graphs, adjust the data
analysis options, position the threshold line, adjust the automatically generated standard
curve, and calculate the quantity of sample initially present in a reaction. If @ run is in
progress or has just completed, click the Quantitation button on the toolbar o analyze
the quantitation data.

To access a previously generated data file, select Open and then Data File from the File
menu. Select the desired file from the standard browsing window. To view a recently cre-
ated data file, select the desired file from the Recent Data Files list accessible from the
File menu. When the data file loads, the Quantitation window is displayed.
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Managing Well Groups

In some cases, you may want to analyze only a subset of the data coliected during a run,
for example if two separate experiments were run af the same time. The Manage Well
Groups function allows you fo define subsets of wells fo be independently analyzed. This
is especially useful if two experiments with different quantitation standards were run si-
multanecusly. By default, Opticon Monitor software uses all wells classified as standards
fo generate a standard curve, as described in the next section. IF the Manage Well Groups
function is used to define subsets of wells, then when one of those groups is selected, the
Standards graph will include only the standards present in that particular group.

To define well groups, select Manage Well Groups from the Quantitation menu. A win-
daw listing any defined groups will appear. To create a new group, click the Add New...
button. A new window will open, with a plate diagram from which you can select the
wells to include in this group (see “Selecting Wells Using the Plate Diagram” in Chapiter ¢).

Once you have selected all wells to include, enter a name in the Group Name field and
click OK. The newly defined group now appears in the Well Groups list. You may now
define addifional groups by clicking Add New..., edit an existing group by highlighting
it and clicking Edit..., delete a group by highlighting it and clicking Delefe, or perform
quantitation and analysis on a group by highlighting it and clicking Activate. When you
click on Activate, the Well Groups window automatically closes, and all the wells that
are not in the activated group appear as empty in the Plate diagram {i.e. they are white
with an X through them). To activate a different group, you may either re-select Manage
Wells from the Quantitation menu and proceed as above, or simply select a defined group
from the Selsct Well Group submenu of the Quantitation menu.

When a well group is activated, its name appears in the title bar at the top of the Opticon
Monitor window.
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Graphs

The Graphs screen is the default Quanfifation screen.

¥ Optican Manitor1 Quantitation - 102803-Famerbb2+viche

4 i e

Lhiei K

The Quantitation Graphs Screen

. A Data graph of fluorescence (or log fluorescence] versus cycle number, a Standards graph
of log quantity versus C(f) Cycle, or Both can be displayed by clicking on the appropriate
iab on the left side of the botiom panel of the Quaniitation window.

Using the Plate Diagram to View Fluorescence Intensity

The Plate diagram can be useful for selecting wells to include in the Data graph and for
defermining approximate fluorescence intensity that was measured in the wells during
each cycle. The interior color of a well in the Plate diagram correlates with the signal
intensity measured in that well for the specific Color, Step, and Cycle specified in the
fields below the diagram. Dark grey or black wells indicate weak or no signal, whereas
white or light grey wells indicate strong signal. Normally, if you use the arrows adjacent
to the Cycle field to scroll through the cycles, the wells will get lighter as the cycle number
increases, indicating that the fluorescence infensily is increasing. By scrolling to the last
cycle, you can get an indication of the endpoint fluorescence intensity in each well.
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Use the Color field to view the fluorescence intensity for dye 1, 2, 3, or 4 in both the Plate
diagram and the Data graph (see the “Data Graph” section immediately below). To dis-
play the fluorescence data for a particular step, if plate read was performed at more
than one step of the protocol, enter the step number in the Step field or use the arrows to
scroll to the desired step. Use the Cycle field to view (in the Plate diagram) the signal
infensity measured during @ specific cycle. You can also use the Cycle field to mark
parficular cycle in the Data graph with a vertical dotted line.

Data Graph:

Use the Plate diagram to select the wells to be included in the Data graph. See the “Se-
lecting Wells Using the Plate Diagram” section in Chapter 6 for additional information.
Note that no graph will be displayed until a well is selected.

Click the Data tab on the left side of the graph panel o display a large graph of fluores-
cence vs. cycle number.

Selected wells will appear outlined in color in the Plate diagram. The color that outlines a
well is the same as that used fo color that well’s coordinates in the Graphed Samples ist,
and to color that well's flucrescence intensity frace in the Data graph. The fluorescence
intensity data for the color that is selected in the Color field (below the Plate diagram) will
be displayed in the Data graph. If the Alf colors option is selected in the box af the top of
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the Data graph panel, the intensity data for the dye selected in the Color field will be
drawn with a solid line, and the data for the other dyes will be drawn as differently styled
(dash, dot-dash, dot-dot-dash] lines of the same color.

Deselect all wells by clicking on any selected or empty well. To deselect a subset of wells,
hold down the conirol key, and click on the well{s}) you wish to deselect. The well(s] will
no longer appear outlined in color, and the corresponding fluorescence tracefs) will be
removed form the graph.

Select the Auto scale option to scale the y-axis to accommodate the fluorescence

data displayed.

To display the log of fluorescence vs. cycle number, select the Log scale option in the
Data graph panel.
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To expand regions of the graph, use the X and Y sliders to the left of the graph to zoom
along the x and y axes. The scroll bars can be used to position the region of interest in

the display panel. Alternatively, right click and drag a box around the area of the graph
that you wish to magnify.

Moving the cursor over the data trace for a well will thicken the trace and display the C{f
. value, along with the x and y coordinates corresponding to the current position of the cur-
sor over the frace [see figure on page 8-8). Moving the cursor over a well in the Plate dic-
gram or selecting a well in the Graphed Samples list will thicken the correspanding frace.

The Smooth slider bar, located at the top of the graph panel, allows the user to smooth
the data display by creating a running average over a variabie number of points. For
example, 3-point smoothing takes each particular data point, along with the point before
and after it, and takes an average of the three. This average is then plotted on the graph
in place of the'original data point. The default Smooth seffing is 3. The vser can furn off
all smoothing by setting the slider all the way to the left. Smoothing of the data for each
dye is done independently. In the Plate diagram panel, select Color 1, 2, 3, or 410 smooth
the data for that particular dye. :

Note: Smoothing the daia can change the Clt) values.
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Adjusting Data Analysis Options

After viewing a graph of the fluorescence data versus cycle number, you may wish to
adjust some of the data analysis options. You can adjust the following data-analysis op-
tions in the Options panel of the Quantitation window:

* Subtract blanks: If this option is selected, for each cycle, the fluorescence measured
in all wells designated as blanks (blue] will be averaged and subiracted from the
Huorescence measured in all wells designated as samples {red) or quantitation stan-
dards (green). : '

® Subfract baseline: If this option is selected, the baseline signal, an absolute fluores-
cence value (or set of values in the case of the Trend option), will be subtracted from
the fluorescence data collected in each well. This value i calculated based on the
signals measured in each well and thus will vary from well to well.

There are four options for defining the baseline signal value for a well:

* Minimum over cycle range: The baseline signal value is defined as the minimum
fluorescence value measured over the range of cycles specified in the Cycle
range boxes.

* Average over cycle range: The baseline signal value is defined as the average of
the measured fluorescence calculated from the range of cycles specified in the
Cycle range boxes.

* Global minimum: The baseline signal is defined as the lowest Hluorescence signal
measured in the well, over all cycles. This is done for each well,

* Trend: Opticon Monitor software looks for a frend of increasing or decreasing
fluorescence and calculates o baseline fo subtract from the signals that will elimi-
nate this irend. When this option is selected, Global minimum is used to sef the
baseline for the data from cycles beyond the trend.

*  Suppress pre-threshold data: This option can be used fo specify the earliest cycle for
which data is displayed on the Data graph. If the option is selected and the slider is
positioned all the way to the right, the fluorescent data for selected wells will be
plotted only for the cycle af which the threshold fluorescence is surpassed (the thresh-
old cycle) and for subsequent cycles. Moving the slider to the left increases the num-
ber of cycles preceding the cycle threshold that are displayed. When the slider is
positioned all the way to the left, the earliest cycle for which fluorescence data are
plotied will be 10 cycles before the threshold eycle.

* Threshold: This quantitation option positions the threshold line, which defines each
fluorescent curve's cycle threshold for use in quantitation of starting copy number
(see “Adjusting the Cycle Threshold Line” immediately below).
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Adjusting the Cycle Threshold Line

The threshold line, also known as the cycle threshold, or C{i) line, oppears as a dashed
horizontal line on the Data graph. Normally, this line should be positioned such that, on
a graph of baseline-subtracted data, it intersects the fluorescence traces af o point where
the signal intensities surpass background levels and begin to increase. To adjust the posi-
fion of the threshold line, select one of the Threshold options, or leftclick and drag the
threshold line on the graph fo the desired position. If no threshold line appears on the
Data graph, select Manual from the Threshold options and enter @ value for the threshold
that is less than the maximum fluorescence value displayed on the y-axis of the graph.
Then, drag the threshold line to the desired position.

G.‘lSq

hreshold line
N

Options for setting the threshold line include:

 Manual: The threshold line can be set mariually by entering a threshold value for
fluorescence intensity between 0-10, or by dragging the threshold line to the desired
position on the graph.

e Standard deviation over cycle range: The threshold line can be setfo a user-defined
multiple of the standard deviation above the mean fluorescence across the Cycle
range specified by the user (in the panel above the Threshold options). A maximum
of 10 standard deviations is allowed.

it is often useful to consider both the Data and the Standards graphs {if skandards were
used) when establishing the pesition of the threshold line. The best option for setting the
threshold line can often be determined by observing the effects of each option on the fit
of the quantitation standards to a linear standard curve. The effect the position of the
threshold line has on the siandard curve can easily be visualized by dragging the line
up and down.

In establishing the position of the threshold line, it may also be helpful to display the log
of fluorescence vs. cycle number by selecting the Log scale opfion. Viewing the log of
fluorescence may allow you to more accurately set the threshold line. In the log scale
view, the threshold line should be placed in the linear portion of the curve, not low on the
curve as it is in the fluorescence vs. cycle number view.
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Standards Graph

To display a large Standards graph, click the Standards tab on the lefthand side of the
graphs panel.
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Standard curves are automatically generated using the information provided in the Specify
Quanfitafion Standards screen during creation of the Plate file. The Standards graph(s)
displays the base-10 legarithm of initial quantity (ng, moles, molecules, genome equiva-
lents, copies, or user-defined units) versus the cycle threshold (C{t)) value, the cycle num-
ber at which the intensity trace intersects the threshold line. If Color 7 is selected in the
field below the Plate diagram, the standards data and line equation for dye 1 will be
displayed in the Standards graph. Similarly, if Color 2, 3, or 4 is selected, the standards
data and line equation for the appropriate dye will be displayed in the Standards graph.
The data for color 1 are plotted with circles, data for color 2 are plotted with triangles;
for color 3, squares; and for color 4, diamonds. If the All colors option is selected, the
standards data for the dye selected in the Colors field will be drawn with the symbol
listed above fitted with a solid line, while the data for the other dyes will be drawn with
their respecitve symbols fitted with a dotted line; the line equation for the dye selected in
the Colors field will be the only line equation displayed. Note that All cofors can only be
selected when the Data graph is showing.

Written above the Standards graph is the equation describing the linear standard curve
and the r-square value for the dye selected in the Colors box. To view the equation and r-
square value for another dye, select a that dye in the Colors box.
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The form of the equation is y = mx + b, where m is the slope of the line and b is the y-
intercept. Theorefically, if perfect doubling of the template is obtained during each cycle,
the slope of the line should be -0.30.

The rsquare {r"2) value is the square of the correlation coefficient, often called the coeffi-
cient of determination. This number indicates what proportion of the variation in one
variable is explained by variation in the other variable. In other words, the r-square value
tells how close to the regression line the data points lie. The value of rsquare can vary
between O and 1, with values closer to 1 signifying a good fit. An rsquare value of 0.999
indicates that the linear standard curve explains 99.9% of the variation in the data.

The Toggle Axis box in the bottom left corner of the Standards graph allows you to switch
the x and y axes of the graph, if you have a preference for how the data are viewed. The
default graph shows Clfj cycle on the x-axis and log quantity on the y-axis. Checking the
Toggle Axis box switches the axes so that C{ cycle is on the y-axis. Note that this also
changes the A2 value and the slope in the equation describing the standard curve.

Select the Show selected wells option fo interpolate the Graphed Samples against the
standard curvels). The samples will be plotted with gray symbols fitted to the standard
line {see figure on previous page).

If @ Standards graph is not automatically displayed, check that the C[t] line has been
appropriately set on the Data graph, and that the quantitation standards have been de-
fined in the Specify Quantitation Standards screen (see the “Changing the Values of Quan-
titation Standards” section below). :

Adjusting the Standard Curve

If desired, you can adjust the standard curve by deselecting outlying points. Moving the
cursor over a data point will increase the size of the point and highlight the correspond-
ing well in the Plate diagram, Graphed Samples list, and Data graph. To exclude a point
from the siandard curve, click on the point and it will turn red, indicating that it is no
longer being used in‘the calculation of the curve. The standard curve will be automaiti-
cally replotied to exclude the deselected point. Click the peint again to include the point
in the calculation of the curve; the point will again appear black.

I multiple sets of standards using the same dye have been included in a single run, points
may be excluded so that the standard curves of interest are serially displayed. Recall that
only the black [selected) standards are used in quantity caleulations.

8-10 Tech Support: {888) 652-9253 » Sales: (888) 735-8437 = tech@mir.com ® www.mjr.com



Data Analysis m

Changing the Values of Quantitation Standards

IF, during creation of the plate file, @ mistake was made in entering the values of quanti-
fation standards, or quantitation standards were not specified, itis possible to change or
add quantitation standards during the data analysis phase.

To change the values of the standards, first select the Master bufton on the toolbar. Select
the Edit button in the Plate Setup panel and make the desired changes fo the quantitation
standards, as described in Chapter 6. Click OK fo return to the Master File window, and
then select the Quantifation button on the toolbar fo continue analyzing data with the
madified standards.

Quantity Calculations

Click the Quantity Caleulations tab to display the Quantity Calculations screen.
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The Quantity Calculations table lists:

*  Well coordinates

* Assigned Dye

* The Type of well contents

* Adescriptive well Label (if specified)

* The Clt} value, the cycle number at which the fluorescence infensity trace for a well
intersects the threshold line on the Data graph. ' '

* The initial quantity of template calculated to be presenf in the reaction.
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To view the quantity calculations for only those wells selected in the plate diagram, choose
the Show selected wells option. To view the quantity calculations for all non-empty wells,
choose the Show all wells option.

Click the Copy fo Clipboard button to copy the quantity calculations to the clipboard for
pasfing into word processing or spread sheet programs.

Analysis of Fluorescence Data

The Opticon Monitor software allows you to plot the fluorescent output of one dye against
that of another: the resulfing scatter plot can be used to identify samples that share simi-
lar C{i} or Endpoint signal values.

Creating a Scatter Plot

If @ run is in progress or has just completed, click the Analysis button on the toolbar to ac-
cess the Analysis screen. To access a previously generated data file, select Open and then
Data Fife from the Fife menu. Once the data file loads, click the Analysis button on the toolbar.
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In the Data Selection panel, select which protacol step you want o analyze, which dye

you want displayed on each axis, and whether you want to compare the fluorescence
data based on Cftf or Endpoint.

1. Endpoint Plot
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1. Endpoint plot: The graph on the left plots the endpoint fluorescence data from each well in
a two-color experiment, with the fluorescence in the FAM channel plotted along the x-axis
and the fluorescence from the VIC channel ploited along the y-axis. The softiware has

. plotted the relative fluorescent infensities for each dye, as measured at the end of the run.

2. C{f)/C{t) plot: The graph on the right plots the C{t) values obtained in the same experiment
as in the graph on the left. The C[t) for FAM is plotted along the x-axis and the C{f] for VIC
is plotied along the y-axis. The dashed lines at the top and right edges of the graph are
separators that mark the last cycle of the experimental protocol. The fluorescence of

those samples plotted above or fo the right of these lines did nof rise above the Cfi) line
during this experiment.

As the circles in the above illustration show, these plots naturally sort well data info groups
defined by which dyes emitted above-background signals: the x-axis dye, the y-axis dye,
both dyes, or neither dye. Such plots are useful for assigning genotypes to particular

samples or groups of samples, in experiments in which each of two alleles is labeled with
a different dye.

Defining Subsets of Data

From the scatter plot, the user is able to identify subsets of data based on the clustering
pattern of the data points. For example, in genotyping, samples with the same geno-
type will tend to cluster in a similar C{t) range. Users can select samples that cluster

together, and assign particular group names, e.g. the genotype, fo the samples located
in these clusters.
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To group a cluster of data paints, click on the Add Group button in the center of the Analysis
window. This converts the mouse pointer to a set of cross hairs. Move the cross hairs to
the periphery of a clustered data sef. Leficlick the mouse fo sef an anchor point on cne
side of the data set, drag the cross hairs to the opposite edge of the data sef, and left-
click the mouse fo mark the end of the set. Dragging the cross hairs perpendicular fo the
ellipse that was just created causes the ellipse to radiate outward. Expand or confract the
radius fo include the data points that you wish to analyze. Data points turn from black to
a particular color (red, green, blue, eic.] when they are included in a set. When you are
satisfied with the area that you have defined, lefrclick the mouse a final time fo set the group.
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There are two ways to alter the ellipse dfter it has been drawn. To change the dimensions
of the ellipse, click on the one of the four paints that lie directly on the ellipse. (These will
appear when you position the mouse pointer on the éllipse). Dragging these points can
alter both the shape and radius of the ellipse. To move the ellipse without changing its
dimensions, click on the periphery of the ellipse and drag it to a new location.

When a group has been created, it will be listed in the Groups panel as a “New Group”,
along with the number of data poinis that are in the group. To rename the group, high-
light the group name, type the new name and then press Enfer. To delete a group, high-
light the group name and then click the Delete Selected Groups button.

A defined group will be color coded—the data points included in the set will be assigned
a color. Sample wells that correspond 1o these data points will turn this same calor in the
Plate diagram. Likewise, this color scheme will appear in the Groups panel to identify all
the linked data points. You can change the color of a group by highlighting its name in
the Groups panel then clicking the colored box to the left of the name. Select a different
color from the palette that appears.

When a group is selected {either by clicking on a group name from the Groups panel

or an ellipse in the scatter plot), its contents and sample description will be listed in
the Wells panel.
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Identifying Samples in the Endpoint and C(t) Plots

If no wells have been selected in the Plate diagram, all the points in the scatter plots ap-
pear either the color corresponding to their assigned group, or black, if they have not
been assigned to a group. If a well is then selected in the plate diagram, the color of its
corresponding data point in the scatter plot remains the same, whereas all other datg
points turn gray. If you now click on another well in the plate diagram, the point corre-
sponding lo the newly selected point will become colored according fo its group mem-
bership {or black if it has not been assigned to a group). The originally selected cell will
become deselected and turn gray unless you press the control key while clicking on the
additional well (see the section on “Selecting and Deselecting Wells” in chapter 6). Click-
ing the “*" in the upperleft corner of the Plate diagram will select all wells, thus refurning
them to the color(s) they were when no wells were selected :

By positioning the mouse above particular data points in the scatter plot, you can identify
the corresponding samples on both the Plate diagram, and in the Selected Wells panel (if
those wells have been selected in the Plate diagram).

Exporting and Printing Quantitation and Analysis Data

For information on exporting and printing quantifation data, refer to the “Exporting and
Printing Dafa” section near the end of this chapter.

Melting Curve

- A melting curve analysis can aid in product identification and determination of product
homageneity, often eliminating the need for fime-consuming electrophoresis. If a chemisiry’s
flucrescence is dependent on DNA annealing, a decrease in fluorescence is observed as
melting progresses. Because the melting femperature of nucleic acids is affected by length,
G+C content, and the presence of base mismatches, among other factors, products can
often be distinguished by their melting characteristics.

Farun is in progress or has just completed, click the Melting Curve button on the toolbar
to analyze the melting curve data. To access a previously generated data file, select Open
and then Data File from the File menu. Select the desired file from the standard browse
window. To view a recently created data file, select the desirad file from the Recent Data
Files list accessible from the File menu. Once the data file loads, click the Melting Curve
bution on the toolbar to analyze melting curve data.
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Display

The Display screen is the default screen in the Melting Curve analysis window. In this
screen, you can display a graph of Fluorescence versus Temperature, ~dl/dT versus Tem-
perature, or both, for wells selected in the Plate diagram.
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1. Use the Plate diagram fo select the wells to be included in the graph. See the "Selecting

Wells Usirig the Plate Diagram” section in Chapter & for additional information.

Selected wells appear outlined in color. The color outlining the well corresponds fo the
color of the well coordinates in the Graphed Samples list and fo the color of the trace in
the Meliing Curve Graph.

Deselect all wells by clicking on any selected or empty well. To deselect a subset of
wells, hold down the conirol key, and click on the well{s} you wish to deselect. The
well{s) will no longer appear outlined in coler, and the corresponding trace(s] will be
removed from the graph.

_ Select Color 7 in the Plate diagram to display the meliing curve data for dye 1 for all of
the selected wells. Select Color 2, 3, or 4 to display the meliing curve data for the
respective dyes for all of the selected wells.

3. The Temp. field can be used to highlight the results associated with a particular tempera-

ture, by drawing a datted vertical line on the graph at the designated temperature. Either
use the scroll bar to scroll to the desired temperature, or enter the desired temperature in
the box located to the right of the scroll bar.
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. Use the Display panel to choose how the melting curve data are graphed.
* Select Intensity to graph fluorescence infensity versus temperature.

* Select ~dl/dT to graph the negative first derivative of the fluorescence intensity versus
temperature. The doited vertical line, drawn in the same color as the corresponding
frace, marks the maximum —di/dT value, the temperature at which the rate of change in
fluorescence is the greatest. This is defined as the melting temperature (T } of the prod-
uct. The dotted horizontal line indicates the sharpness of the —d|/dT curve as the num-
ber of degrees Celsius over which the curve spans (i.e., the curve width) at half of the
maximum ~dl/dT value calculated for the well {i.e. the FWHM, or full width half max).

* Select Both to simultaneously display the Intensity and the —dI/dT graphs.

* Select Show Relative Infensities o display the relative infensifies of the signals for the
selected wells. If this option is not selected, the melting curves of all wells will be
automatically scaled so that the peaks are the same height.

Show Relative
Intensities deselected

Show Relative
Intensities selected
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5. Abter viewing a graph of the fluorescence data versus femperature, you may wish to
adjust some of the data analysis options. You can adijust the following data analysis
options in the Options panel of the Melting Curve window:

o  Subiract Blanks: If this option is selected, the fluorescence measured in all wells
designated as blanks (blue) will be averaged and subtracted, as background, from
the fluorescence measured in all wells designated as samples [red) or quantitation
standards (green).

e Sublract Baseline: If this option is selected, the baseline signal, an absolute fluores-
cence value, will be subtracted from the fluorescence data collected in each well.
This value is calculated based on the signals measured in each well and therefore
will vary from well to well.

There are three ways to define the baseline signal value for a well:

e  Minimum over femperature range: The baseline signal value is defined as the
minimum fluorescence value measured in the range of cycles specified in the
Temp. Range field. '

e Average over femperature range: The baseline signal value is defined as the
average of the measured flucrescence calculated from the range of cycles speci-

fied in the Temp. Range field.

s Global minimum: The baseline signal is defined as the weakest fluorescence
signal measured in the well. This value will be set to zero.
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6. The Peak Location Boundaries panel allows you fo limit the range of temperatures over
which Opticon Monitor software looks for peaks in the —dI/dT frace, thereby limiting the
range of possible calculated melting temperatures. This can be particularly useful for
excluding unwanted peaks, or for determining the melting temperature for a second,
smaller peck {e.g., when genotyping heterozygotes). You can set Left and Right peak
location boundaries by entering the temperature or by using the arrows to scroll to the

desired temperature. Alternatively, drag the peak location boundary guides to the de-
sired location on the graph.
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7. The Smooth slider allows you to change the number of points that are used in caleulating
a running average to smooth the melting curve graph. This can be particularly useful for
resolving peaks when many reads have been collected over small increments in tfempera-
ture, resulting in a choppy graph. The default setting for well-resolved data is 3.
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Melting Curve Calculations

Click on the Melfing Curve Calculations tab at the bottom of the Melting Curve window
to display the melting curve calculations screen.
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The melting curve calculations table lists:

Well coordinates

Dye used

The Type of well contents {blank, standard, etc.)

A descriptive well Label, if entered during creation of the plate file

Tm [~dI/dT Max): The melting temperature {T_}, the temperature at which —dl/dT is at
the maximum value calculated for the well.

dl/dT FWHM {Full Width Half Maximum): The width of the curve, in degrees Celsius,
at half of the maximum —dl/dT value calculated for the well; describes the sharpness

of the —dI/dT peak

Click the Copy to Clipboard button o copy the melting curve calculations to the clipbeard,
for pasting into word-processing or spreadsheet programs.
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Exporting and Printing Data
Export

For customized data analysis, Opticon Monitor software provides the option to write the
Aluorescence data collected during a run to a comma-separated-values (CSV) file, read-
able by Microsoft Excel. The Export command creates a CSV file listing all Aluorescence
measurements (for selected wells) that were collected during all plate read and melting
curve steps in an experimental run.

To export data for selected wells, choose Export {under the Quantitation, Melting Curve,
or Analysis menu, depending on which window is being viewed). Wells can be selected
in the window that appears.

Select Wells to Expart.
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I Export Protacol § elup

# Sail FIanMainr_ '
" Sout Column Hajor

. I‘Smtin_g Opliong T

. Iv. Inteeave Mulliple Dyes

B cancel

The user can also select the dye(s) for which data will be exported, by selecting Dye #1,
Dye #2, Dye #3, and/or Dye #4. The user can choose to sort the wells by row or by
column; and can choose whether to Interleave Multiple Dyes (i.e. to list data for all dyes
in each well together), or to first list the data for each well for the first dye, then list the
data for each well for the second dye, and so forth.
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In addition to exporting flucrescence data, the user can choose to export the plate and/
or protocal setup information by checking Export Plate Setup and/or Export Protocol Setup.
The plate information that is exported includes the well number, dye used, well contents,
and well descriptions. IF the plate sefup is exported, the information can later be pasted
inta a different master file to easily reconstruct the plate file (see “Pasting from Microsoft
Excel” in Chapter 4).

By default, the exported CSV file also lists analysis options (i.e. Subtract Blanks, Subtract
Baseline, Baseline Start cycle, Baseline End cycle, and Suppress Pre-Threshold) that were
chosen in the Analysis window for each protocol step at which daia were collected.

Copy to Clipboard

The Copy to Clipboard opfion {under the Quantifation, Melting Curve, or Analysis menu,
depending on which window is being viewed) allows the user fo paste run information
and graphical data into a variety of applications for presentation or storage. The follow-
ing items can be copied using Copy to Clipboard from the specified windows:

From the Quantitation Window

The Data Graph {a plot of fluorescence—or log fluorescence—against C{t) cycle), Stan-
dards Graph, Microtitre plate {the Plate diagram), or Quantity calculations can be cop-
ied to the clipboard and pasted into several applications. Selecting Quantity Calculation
from the Copy to Clipboard menu generates a CSV table fo be pasted subsequently into
an Excel spreadsheet. The table has the same content as the Quantity Calculations screen:
for each well in the experiment, the fable lists the name of the sample, the flucrescent dye
used, the well contents {i.e., blank, standard, or sample}, the C{i] value, and the speci-
fied (for standards) or calculated {for samples, by interpolation against the standard curve}
quantity of template present in the well at the initiation of amplification. This table can
also be copied to the clipboard by clicking on the Copy to Clipboard button on the Quanfity
Calculations screen.

From the Melting Curve Window

The Data Graph {the plot of luorescence intensity or —d|/dT or both), Micratitre plate (the
Plate diagram) or Melting Temp Calculations can be copied to the clipboard. Selecting
Melting Temp Calculations generates a CSV file with information idenfical to that shown
on the Melting Curve Calculations screen: well coordinates, dye used, well content (i.e.,
blank, standard, or sample), Label, if one was given, T_ {~dl/dT Max), and dI/dT FWHM
(see the section on “Melting Curve Calculations” for more details of this table]. This table
can also be copied to the clipboard by clicking on the Copy fo Clipboard button on the
“Melting Curve calculations screen. :

From the Analysis Window

The Data Graph {the plot of Clt} or Endpoint flucrescence), Microfiire Plate, or Analysis
List can be copied to the clipboard. Selecting Analysis List generates a CSV file listing the
Group Name, Well, Label (if previously specified by the user), and the Dye contents {stan-
dard, sample, etc.) for each sample contained by a Group in the scatter plof {as defined
by the user — see section on “Defining Subsets of Data”).
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Print

Opticon Monitor software can assemble a report of the realfime run and send it di-
rectly fo a networked printer. This can be done from either the Quantfitation window or
the Melting Curve window,

If Print is selected from the Quantitation menu, the software creates a report that con-
tains: the user’s name; the name and location of the data file on the Opticon Monitor
computer’s hard drive; an indication of the active color; the position of the C{t} line; and
an indication of whether the Cft) level was set manually or “via signakto-noise”. The re-
port will alse include the Plate diagram with selected wells highlighted; the Data graph
of fluorescence (or log fluorescence) versus Cit} cycle; and the Standards graph along
with the equation detailing the fit of the data. Finally, the report will include a table listing
which wells-were selected. In addition, the user can select other options to be included in
the table, from the window that appears after Print is selected:
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The Data Options list allows the user to incorporate the following additional features into
the table presented in the report: Well Type (sample, standard or blank), Well Label (the
contents of the well as entered by the user}, the Cff) for each individual sample, and Quantity
(the starting copy number of each quantitated DNA species in each well).

The Well List Sorting Options box allows the user to select how the data will be sorted.
By default, Interleave Multiple Colors is selected {i.e., well A1, dye 1; well A1, dye 2;
well A1, dye 3; well A1, dye 4; well A2, dye 1; well A2, dye 2; well A2, dye 3; well
A2, dye 4; etc.). To sort by dye (i.e., well A1, dye 1; well A2, dye 1; well A3, dye 1;
etc.), deselect this option.
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If Print is selected from the Melting Curve menu, the software creates a report that con-
fains: the user's name; the name and location of the data file on the Opticon Monitor
computer’s hard drive; and an indication of Display Type, i.e., whether intensity, —dI/dT,
or both are plotted in the graph. The report will also include the Plate diagram with se-
lectad wells highlighted; and the Melting Curve Graph of fluarescence intensity and/or ~
dl/dT vs. temperature. Finally, the report will include a table listing the wells that are plot-
ted. In addition, the user can select other options to be included in the table, from the
window that appears after Print is selected:
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T Pintwell Type . . . T~7 Interlzave Muitipla Colose . ’
- T Pt Well Ll
TR

T2 Piint PwH

The Data Options list allows the user to incorporate the following additional features
into the table presented in the report: Well Type (sample, standard or blank), Well La-
bel (the contents of the well as entered by the user}, The melting temperature, TM , for
each individual sample, and FWHM (the full width of the melting curve peak, at half
it's maximum height).

The Well List Sorfing Options box allows the user to select how the data will be sorted.
By default, Interfeave Multiple Colors is selected [i.e., well A1, dye 1; well A1, dye 2;
well A1, dye 3; well A1, dye 4; well A2, dye 1; well A2, dye 2; well A2, dye 3; well
A2, dye 4; etc.). To sort by dye {i.e., well A1, dye 1; well A2, dye 1; well A3, dye 1;
efc.}, deselect this option.

Create HTML Report

For users interested in publishing their results on the web, Opficon Monitor software
will generate a folder that'is HTML:ready. This folder includes all .bmp versions of
graphical images as well as the HTML code and syntax for posting the data report.
Select Create HTML Report from the Quantitation or Melfing Curve menu, and you will
be presented with a window similar fo the one above. Again, you will be allowed to
include the well type, well label, C{t] value, and initial DNA quantity for each sample,
as well as the ability to sort these data by well or by dye.
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Cleaning the Optics, 9-2
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9-2

Cleaning the Chromo 4™ Unit

Cleaning the Chassis and Block

Clean the outside of the Chromo4 unit with a damp, soft cloth or tissue whenever some-
thing has been spilled on it, or when the chassis is dusty. A mild soap solution may be
used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or & 1:100 dilution of
bleach in water. If using bleach, swab wells with water afterward to remove all fraces of
bleach. Clean spilled liquids out of the block as saon as possible: dried Huids can be diffi-
cultto remove. Do not clean the block with caustic or strongly alkaline solutions {e.g., strong
soaps, ammonia, or bleach at @ higher concentration than specified above). These will
damage the block's protective ancdized coating, and possibly lead to electrical shorting.

then heat the block, in an attempt to clean it. Severe damage to the

:E Caution: Do not pour any cleaning solution into the block’s wells and

Tip

block, the heated lid, and the chassis can result.

Cleaning the Air Vents

With the Chromo4 detector and DNA Engine® cycler turned off, clean the air intake and

. exhaust vents with a softbristle brush, a damp cloth, or a vacuum cleaner whenever dust

is visible (see figure 2-1). If these vents become clogged with dust and debris, airflow to
the heat sink will be hampered, causing performance problems related to overheating.

To prevent problems with overheating, chieck regularly for dust buildup.

Cleaning the Optics

The optical components of the defector should not be cleaned by the user.

Should you suspect difficulty with the opfics, please contact the cusiomer service staff of
MJ Research at 888-652-9253, or your local distributor.
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Calibration

The Chromo4™ detector is calibrated at the factory to accommodate eleven of fluorescent
dye chemistries (SYBR Green |, FAM, TET, HEX, VIC, JOE, TAMRA, ROX, Texas Red, Cy3,
and Cy5) and two microtiter plates {white wells and clear wells). Calibrations may be
added, edited or removed via the Dye Calibration interface from the Tools menu. How-
ever it is strongly recommended that the factory calibrations not be removed or changed
as this may adversely affect the performance of the instrument.

Testing Calibration

An accurately calibrated instrument will detect the same fluorescence intensity in every
well when reading samples of uniform composition. '

To determine if the Chromo4 detector is accurately calibrated:

1. Prepare a fest plate by accurctely pipetting 50ul of a carefully prepared dye solution
into each of the 26 wells of a microplate.

2. Program the following protocol:
» Temperature step of 30°C for 30 seconds
¢ Plate Read step |
e Gofo line 1 for a fofal of 2 more fimes

¢ End.

3. Analyze the fluorescence data for all 96 wells using the Optical Read Status screen.
If the instrument is accurately calibrated, the fAuorescence data should appear as
relatively straight, horizonta! lines that are tightly clustered—within the accuracy of
pipetiing. Several test plates should be measured fo defermine the error resulting
from pipetting.

4. If the fluorescence data do not appear as tightly clustered straight lines, follow the
instructions below for recalibrating the instrument.
Recalibrating
1. Select Dye Calibration from the Tools menu.

2. The Dye Calibration Wizard will launch and provide basic instructions for creating
new calibrations.

3. Dye calibrations are performed by first scanning o blank plate {an empty microplate
that is sealed with clear optical caps), followed by scanning the same plate contain-
ing the fluorophore of interest (also sealed with clear optical caps). Differences in the
collected signals from the “dye plate” and the “empty plate” are used to determine
color separation matrices that resolve the dye of interest from mixtures. It is strongly
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recommended that the same plate be used for both the “empty” plate read and the
“dye” plate read, as variations from plate fo plate can be significant and interfere
with obtaining an optimal color separation matrix.

Follow the instructions provided by the Wizard and begin by selecting or entering a
Plate fype into the appropriate field on the first screen. This plate type description will
identfify the type of microplate used for this particular calibration {e.g., White, Clear).

ve l:a!lhratlon-\'ﬂzad

.  Welcoma 1o e I:;‘:ﬂih;é_llh.ﬁ. R st it
i ouiley 1o cabibrate o insument fof & given fuatonhoie wbu Wil need i acquie o
"+ dala fiorit a'sealed emply plale and then sequie data hem'a sealed plate conlaining . -
H . ”_pu.u_[f].umuphme‘_. : . S e et . E

e Hingly fecamimsndzil thal jou ws iha sams plae fir bolh dela acqul.:ﬂnn: N
- ; -iabich cate you woukd sélect ¥ plateiiactuire Hats fromel wihile tie sealedand - : -
{7 -emply: B & with gy and thah acquite data itom the realed and f

lied phate: -0 5

ler:2 plate lype ard flictophore ner belaw 15 begin

| Plale pe |

Alter selecting a plate fype, enter the dye to be calibrated or select the dye from the
Dye name-drop-down Iist (e.g., FAM, VIC). )

Proceed to the next screen by clicking on the Next > button.

IF a calibration already exisis for this particular dye/plate combination, a warning
message will appear. If you wish fo continue, click on the Yes button.

Insert the sealed empty plate, close the door and click on the Go button. The Chromo4
system will begin the calibration procedure.
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9. Remove the plate and rotate it 180 degrees when prompted. Close the door and
click on the Go button to confinue.

New remave your.plale, ictate il 180
degees, and place il back inthe
instrurment.

Click on the butlan beloa 1 conlinug
when you are 1eady.

N (Back-"_l. _ tiewd s - ‘ \ " Canesl ]

10. Alter the empty plate has been scanned, you will be able to view the acquired data
and check it for anomalies that may indicate a problem with the plate (i.e., unusually
high signal in certain wells). See Example below:

Note that you can view the results for different channels, temperatures, orientations
and wells

11.Click on the Next > button to proceed to the dye plate section.

12.Remove the empty plate from the Chromo4 instrument. Remove the optical caps and
fill each well with 50ul of dye diluted in reaction buffer. The fluorophore should be
present at a relatively high concentration to insure the signal obtained is largely from
the dye itself.

13.Seal the filled dye plate with clear optical caps and place the plate inside the Chromo4
instrument.

14.Click on the Go bution to continue the calibration.
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15.Remove the plate and rotate it 180 degrees when prompted. Close the door and
click on the Go buiton to confinue.

16. Alfter the dye plate has been scanned, you will be able to view the acquired data and
again check it for anomalous readings. Ideally, the average signal on at least one of
the channels should be af least 10X greater than the blank plate signals for that

channel. This insures that the dye is providing the vast majority of the tofal signal and
will insure a robust color separation mafrix.

& Calibration Wiz

17.Use the fields above the bar graph to select which channels to view. The graph will
display the Huorescence readings for the dye plate. These values should be very

consistent with respect to one another. If this is not the case, you may need to redo
the dye plate.

18. I the results are satisfactory, click on the Next > button to proceed to the final screen.

19. Add comments (i desired) fo the calibration {e.g., record the date, or other conditions).

Dy “c:alib'f_aﬁpn iz complate. ¥ ou may énhd!'a_rfé th?:_baﬁl;iéiibh'h l_he_:pa_:_é helu‘:{a_: :
i, Cliglian lheF‘mh bitlen to Euzﬂplé;e-dal_i:}élinn'é?-a'séve:;pbut_'i_esutt‘:_;: R
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20.Click on Finish to save and complete the calibration process.

21.To run another calibration with the same plate type, click the Yes button when the
Opticon Monitor software asks if you want to calibrate ancther dye.

Dye c_aﬁhr;!iqﬁ is camplele. Yeu may annotate this calibration in the space baléw.

: Chick o lise Firdsh Bultoe 1o compléte callratian and save your jesUts.

22.You will then be instructed to click the Next bution at the emply plate scan page
instead of clicking the Go button. This will allow you to recycle the empty plate scan
you taok earlier. (Repeat steps 16-19.)

g yau vrank bo:rause ths. émpty plats scans
e cdtbrﬁti@'rgst tomplsted; cieh st
 eiply plete scan paga instead of o

To run another calibration with a different plate type, close the wizard and restart the
calibration process from the beginning.

Software Error Messages

The following tables list software error messages along with their probable causes and
suggested resolutions. For help resolving software problems or for additional informa-
tion, contact MJ Research technical support at 888-652-9253 {in the US or Canada] or
contact your local distributor {outside the US or Canada).
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Error Message

Cause

Resclution

Opticon Menitor must run at a
screen resolution of af least
1024 x 768. Please adjust
your resolution and restart
Opticon Monitor.

The resolution of the
computer monifor is set too
low.

increase the resolution and
restart the Opticon Menitor

software.

The protocol exited with a
‘failure indication.

Opticon Monitor could not
access the thermal cycler to
start/run a protocol

Check power and serial cable
connections

The Chromo4 is not
responding. Please check that
all communication and power
cables are secured, the power
switch is in the on position and
the door is closed.

Opticon Monitor could not
communicate with the
Chromod4,

Check that the door is closed.
Check power and serial
conneciions.

The load was aborted because
the file contains improper or
corrupted data.

The data file has been
damaged in a way that
Opticon Monitor cannot
open it.

Contact MIR Technical
Support,

The door is open. Please
close it and click OK to-
confinue; click Cancel if you
do not wish fo start the
protocol now.

A protocol was commenced
with the door open.

Shut the door completely and
try again.

Opticon Monitor seems fo be
running a protocol. Are you
sure you want fo exite

User attempted to exit
Opticon Monitor while a
run was in progress.

Either cancel the exit fo
continue the run, click the
Stop button fo stop the run, or
exit leaving the pratocol
running.

Your protocol is empty. You
must set up a protocol before
confinuing.

User attempted to start a run
with no profocol.

Create or open a protocol file
and fry again.

Dye file(s) on plate <PLATE>
don’ t exist. Please fix these
dyes : <DYE1>, <DYE2>. Yes
to fix dyes, No to continue
with identities in place of dyes,
Cancel to cancel.

The plate setup contains
dyes that do not exist on the
computer.

Clicking YES will give the user
the opportunity to choose
different dyes. Clicking NO
will allow the user to continve
with the run using id1 and id2
{non-color separated).Cancel
will cancel the run.

Your username cannot have
the characier “ <CHAR>" in it.
Please choose a new
username.

The following characters
are invalid for file names:

\/*2" <.

Change username so that
illegal characters are not
used.
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Error Message

Cause

Resolution

<FILENAME> The above file

name is invalid.

User tried fo save a file
with illegal characters in it.

Change file name so that
illegal characters are not

Please correct the plate type
and dye name as follows: *
The current dye name contains
one of: \/" *2" <>|_ Please
choose o name that doesn’ t
use any of these characters.

User tried to save a dye file
with illegal characters in it.

Change dye name so that
illegal characters are not
used.

Please correct the plate type
and dye name as follows: *
The current plafe type contains
one of: \/" *2”<>|_ Please
choose a name that doesn’ t
use any of these characters.

User fried o save a plate
type with illegal characters
in if.

Change plate fype name so
that illegal characters are not
used.

Please close the insirument’ s
door.

The deor was opened
during a calibration pass.

Close the door and continue.

Would you like to proceed to
the next protocol step?
{Skipping in a loop or during @
melting curve skips the rest of
the loop or melting curve)

User pressed the skip
button during a protocol.

Opticon Monitar cannot skip

| steps inside @ quantitation

loop or a melting curve.
Rather it will skip to the first
protocol step outside the
current quantitation loop or
melting curve. {This may take
a several seconds)

Are you sure that you want fo
stop the run in progress?

User pressed the stop
button during a protocol.

User may either stop the
protocol or choose not to
stop.

There appears o be a run with
no copy of Opticon Monitor
watching it. Would you like to
maonitor this run?

Opticon Monitor detected a
run-in-progress when it was
launched.

User is given the opportunity
to connect fo this run and
monitor it or open a copy of
Opticon Monitor that does not
monifor this run.

Do you want to save the
changes you made to

<FILENAME>

User is opening/closing a
data file or creating a new
master file. Opticon
Monifor detected changes
to the open file.

User may either select the
option to save changes or
nof.
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Appendix A

How a Peltier Heat.Pump Works

The functional heart of every DNA Engine® thermal cycler is a high-performance Peltiereffect heat
pump (also known as a “thermoelectric module”}. The “MJ” module version is a solid-state device
manufactured to withstand the thermal stresses associated with rapidly cycling temperatures.

A thermoelectric module consists of numerous pairs of Figure A-T A thermoeleciric module.

crystalline semiconductor blocks precisely sandwiched
between two layers of ceramic substrate {fig. A-1). The
blocks are of two varieties: “N-ype,” which has a sur- o

plus of electrons in its crystalline structure, and “P-type, ” T TATTRIT TTT L
which has a deficit of electrons. The twe types are posi- ' e

tioned in alternating pairs within the innermost layer of Fm(f"i"' £ N g
the sandwich. - o

vt " « "7

.4 T 5 ——— Hole
Miypo Miype
bim);slh bismulh
selfurida salluride

i

The two types of blocks are wired together in alternat-
ing pairs. When electrical current is passed through the
blocks, electrons in the N-ype blocks and the “holes,”
or emply electron spaces, in the Ptype blocks are excited
at one conductor-semiconductor interface, which ab-
sorbs a small amount of heat. The elecirons and holes
How through the crystalline blocks and return fo @ low-energy state at the other conductor-semicon-
ductor interface, with the release of the previously absorbed heat. A thermal gradient of up to 70°C
can be generated across the blocks in this manner.

! Plypn
: biamuth 3
“Hellurida

i

Pawar input

The direction of heat pumping is reversed by reversing the polarity of current flow through the ther-
moelectric module, and the amount of heat pumped is changed by changing the amount of current
passed. Both direction and amount of current flow are dictated by a microprocessor, allowing pre-
cise control of thermal cycling in the Alpha™ unit block.
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Appendix B

How a Switching Power Supply Works

Almost all solid-siate electronic devices, including the DNA Engine® thermoelectric modules, re-
quire direct current (DC) for operation. However, electric utilities supply low-Hertz alternating
current {AC), which varies in voliage and frequency from nation to nation. The Chromo4 system

uses swifching transistors, combined with high-frequency, resonant fransformers, to convert the
incoming AC to DC.

The power supply first chops the AC power into small bursts of energy {over 100,000 per sec-
ond) with the aid of high-current switching transistors called MOSFETs {metal-oxide semiconduc-
tor field-effect fransistors). The energy bursts are channeled into a highfrequency iransformer. By
changing the duration of the bursts that charge the transformer’s magnetic core [pulse-width
modulation), a specific voltage output can be maintained even when the incoming voltage varies
(between 100 and 240 volts in the case of the Chromo4 system). Because the incoming power is
being chopped so rapidly, the incoming frequency is unimportant; it can even be DC, Spikes
and surges in the incoming power.no longer pose a problem since they are chopped nearly to
oblivion. The addition of resonance o the transformer design gives it extraordinary efficiency.
These design innovations have made the Chromo4 system’s power supply small in size, univer-
sal in input, and resistant to noise.

How a Switching Power Supply Works B-1






Appendix C

Shipping Instructions for US Residents

Users residing in the United States should follow these instructions for shipping a machine to M
Research for factory repair or an upgrade. Users outside of the United States should send ma-
chines to their distributor, in accordance with shipping instructions obtained from the distributor.

1. Call MJ Research (888-652-9253) to obtain a return materials authorization (RMA) num-
ber. Machines returned without an RMA will be refused by the Receiving Department. .

- 2. Thoroughly clean the machine, removing excess oil and radioactive and other
bichazardous substances. To profect the health of our employees, MJ Research will not
repair or upgrade any machine that is excessively oily or that emits ionizing radiation
upon arrival at our factory. PLEASE ELIMINATE ALL BIOHAZARDS AND RADIA-
TION!

3. Pack the machine in its original packaging. If this has been misplaced or discarded, call
M Research to request shipment of packaging materials.

4. . Write the RMA number on the outside of the box.

5. Ship the machine (freight prepaid) to the following address. We recommend you pur-
chase insurance from your shipper.

Shipto: - Repair Department
M] Research, Incorporated
590 Lincoln Street
Waltham, MA 02451

Shipping Instructions C-1
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Appendix D

Warranties

The Chromo4™ detector {CFD 3240 & ALS-3296) is warranted against defects in materials and
workmanship. For specitic Warranty information, contact your local BioRad office. If any de-
fects should occur during the warranty period, BioRad will replace the defective parts without

charge. However, the following defects are specifically excluded:
1. Defects caused by improper operation or by improper packaging of returned goods.

2. Repair or modifications done by anyone other than Bio-Rad Laboratories.

3. Use with tubes, plates, or sealing materials not specified by Bio-Rad Laborafories for use
with the Chromo4 system.

4. Deliberate or accidental misuse.
5. Damage caused by disaster.
6. Damage due 16 use of improper solvent or sample.

The warranty does not apply to fuses.

For inquiry or request for repair service, contact Bio-Rad Laboratories after confirming the model
and serial number of your instrument.

For Technical Service call your local distributor or in the U.S. call 1-888-652-9253, or visif our
website at www.mijr.com.
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Appendix E

END-USER AGREEMENT AND LICENSE
FOR
MJ RESEARCH OPTICON MONITOR™ SOFTWARE
(ALL VERSIONS)
IMPORTANT! PLEASE READ THE FOLLOWING LICENSE AGREEMENT.

YOU HAVE PURCHASED AN MJ RESEARCH® CHROMO4™ CONTINUOQUS FLUORESCENCE DE-
TECTION SYSTEM THAT INCLUDES CERTAIN EQUIPMENT, DEVICES AND INSTRUMENTATION
AS WELLAS A LICENSE TO COMPUTER SOFTWARE.

This End-User License Agreement (‘{ AGREEMENT”) is a legal agreement between vou (either an individual or a
single legal entity) (hereinafter ‘LICENSEE’) and MTJ Research, Incorporated (¢ MJIR’) for the MJ Research
Chromo4™ Continuous Fluorescence Detection System (the ‘SYSTEM’) which includes certain equipment, de-
vices, or instrumentation, MIJR proprietary computer software (‘SOFTWARE PRODUCT"), and may include

“online” or electronic documentation, associated media, and printed materials, including an operator’s manual
(‘MANUAL’). The SYSTEM also contains software owned and produced by third parties (‘THIRD PARTY
SOFTWARE’) which is licensed for use on the equipment, devices and instromentation of the SYSTEM only,
and the terms of the SOFTWARE PRODUCT license below apply.

BY OPERATING THE SYSTEM OR INSTALLING, COPYING, OR OTHERWISE USING THE SOFT-
WARE PRODUCT, OR ANY UPDATE THERETO, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT AND ANY ACCOMPANYING AGREEMENTS. IF YOU DO NOT AGREE TO
THE TERMS OF THIS AGREEMENT OR ANY ACCOMPANYING AGREEMENTS, DO NOT OPER-
ATE THE SYSTEM OR INSTALL, COPY, OR OTHERWISE USE THE SOFTWARE PRODUCT. IF
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU MAY RETURN THE SYSTEM
AND SOFTWARE PRODUCT TO MJR OR THE AUTHORIZED SELLER FROM WHICH YOU PUR-
CHASED THE SYSTEM AND SOFTWARE PRODUCT, BEFORE OPERATING THE SYSTEM, IN-
STALLING, COPYING, OR OTHERWISE USING THE SOFTWARE PRODUCT, FOR A FULL RE-
FUND OF THE PURCHASE PRICE THEREOF. IN ADDITION, BY INSTALLING, COPYING, OR
OTHERWISE USING ANY UPDATES OR OTHER COMPONENTS OF THE SOFTWARE PRODUCT
THAT YOU RECEIVE SEPARATELY AS PART OF THE SOFTWARE PRODUCT, YOU AGREE TO BE
BOUND BY THIS AGREEMENT AND BY ANY ADDITIONAL LICENSING TERMS THAT ACCOM-
PANY SUCH UPDATES. IF YOU DO NOT AGREE TO THE ADDITIONAL LICENSE TERMS THAT
ACCOMPANY SUCH UPDATES, YOU MAY NOT INSTALL, COPY, OR OTHERWISE USE SUCH
UPDATES, BUT MAY RETURN SUCH UPDATES TO MJR FORA FULLREFUND OF THE PURCHASE
PRICE THEREOF, IF ANY.

End-User Agreement and License E-1



1. SCOPE OF AGREEMENT

1.1 No License to Trademarks. No license is granted hereunder in connection with any trademarks or service
marks of MJR or its suppliers.

W al sl na-nal e LL7E T2

This AGREEMENT does not effect any transler of title in the SOFTWARE PRODUCT.

—
]

1.3 The equipment, devices, and instrumentaiion included in the SYSTEM are not specifically warranted under
this AGREEMENT and any warranties related to the equipment, devices, and instrumentation are provided
solely by the manufacturers of the equipntent, devices, and instrumentation provided in the SYSTEM.,

2. SOFTWARE PRODUCT LICENSE GRANT
2.1 MJR hereby grants LICENSEE, a limited, non-exclusive, license to:

(a) Use the SOFTWARE PRODUCT on a number of computer central processing units at any one
time, but expressly provided that LICENSEE may use THIRD PARTY SOFTWARE only with
the SYSTEM.

(b}  Use the MANUAL and other documentation in support of LICENSEE’s use of the SOFTWARE
PRODUCT,

() Install the SOFTWARE PRODUCT into memory on any number of computers and make one (1)

copy of the SOFTWARE PRODUCT for backup purposes only, provided that such backup copy is

a complete copy containing all copyright and tradermark notices and any other restrictive property

.. legends of MIJR that appear on and in the SOFTWARE PRODUCT as originally provided to LIC-
- - ENSEE by MJR.

(d} Make a one-time permanent transfer of the license granted herein and copies of the SOFTWARE
PRODUCT and THIRD PARTY SOFTWARE directly to a third party end user in connection with
the sale of the SYSTEM to such third party end user provided that (i) the SOFTWARE PRODUCT
and THIRD PARTY SOFTWARE are transferred in their entirety to the third party, including all
component parts, along with all associated media and printed materials, including this AGREE-
MENT, as originally received by LICENSEE, (ii) LICENSEE does not retain any copies of the
SOFTWARE PRODUCT or THIRD PARTY SOFTWARE, or any portion thereof, after transfer
thereof to the third party, and (iii) the third party agrees in writing to comply with all of the terms and
conditions contained in this AGREEMENT, including the obligation not to further transfer this
AGREEMENT and SOFTWARE PRODYUCT. Such transfer may not be by way of consignment
or any other indirect transfer.

[
28]

Restrictions. LICENSEE agices that LICENSEE shall not:
(a)  Separate the components of the SOFTWARE PRODUCT for use by more than one user.

(b)  Copy the SOFTWARE PRODUCT, THIRD PARTY SOFTWARE or the MANUAL except and
to the extent provided in Paragraph 2.1(c).

(c)  Sublicense, distribute, disclose or transfer the SOFTWARE PRODUCT or THIRD PARTY SOFT-

WARE in whole or in part, to any third party, except to the extent as provided in Paragraph 2.1(d)
and 2.2(d).

End-User Agreement and License E-2
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(d)  Sublicense the SOFTWARE PRODUCT or the THIRD PARTY SOFTWARE, except in connec-
tion with the rental or leasing of the entire SYSTEM to a single end user in a bona fide commercial
rental or leasing transaction, and only if said end user agrees in writing to be bound by the terms of
this Agreement.

{e}  De-compile, reverse-compile, reverse-engineer, disassembie, or modify the SOFTWARE PROD-
UCT or THIRD PARTY SOFTWARE, or any portion thereof, in any way.

(f)  Use the SOFTWARE PRODUCT or THIRD PARTY SOFTWARE, or any portion thereof, for
development of any infringing or derivative works.

Notice. The SOFTWARE PRODUCT and THIRD PARTY SOFTWARE are protected by copyrigflt laws
and international copyright treaties, as well as other intellectual property laws and treaties. The SOFT-
WARE PRODUCT and THIRD PARTY SOFTWARY are licensed to LICENSEE, not sold.

Ne License to Methods of Use. No license is granted hereunder to any process, method or use for which the
SOFTWARE PRODUCT may be used either by itseif or in combination with an analytical instrument
except to the extent such a process is described in the MANUAL and MJR has the right to grant a license to
such a process hereunder.

SOFTWARE PRODUCT LIMITED WARRANTY

Limited Warranty. MJR warrants that the SOFTWARE PRODUCT will petform substantizlly as described
in the MANUAL, if used in the manner described therein, for a period of ninety (90) days from the date of
receipt. MJR also warrants that the media on which the software is distributed is free from defects in
materials and workmanship. To the extent allowed by applicable law, implied warranties on the SOFT-
WARE PRODUCT, if any, are limited to the same ninety (90)days. .

Customer Remedies. MJR’s entire liability and your exclusive remedy shall be, at MIR’s sole option, either
(a) return of the purchase price paid by LICENSEE, if any, for the SOFTWARE PRODUCT that does not
meet MJR’s limited warranty or (b) repair of the SOFTWARE. PRODUCT that does not meet MJR’s
limited warranty, or (c) replacement of the SOFTWARE, PRODUCT that does not meet MJR's limited
warranty, provided that under (a), (b), or (c) above the SOFTWARE PRODUCT that does not meet MIR’s
limited warranty is returned in its entirety to MIR or the authorized seller from which the SOFTWARE
PRODUCT was purchased, complete with a dated proof of payment, within 90 days of the date of delivery.
Any repaired or replaced SOFTWARE PRODUCT will be warranted as described in Paragraph 3.1 for the
remainder of the original warranty period or thirty (30) days, whichever is longer.

Warranty Void. The limited warranty of Paragraph 3.1 and remedies of Paragraph 3.2 are void if:

(2)  failure of the SOFTWARE PRODUCT has resulted from accident, abuse, or misapplication of the
SYSTEM or SOFTWARE PRODUCT;

()  the SOFTWARE PRODUCT is installed in any computer or is used with any operating system
other than the computer and operating system included in the SYSTEM;

(c) the SOFTWARE PRODUCT is used for the analysis of data generated by any analytical instrument
other than the MJR analytical instruments with which the SOFTWARE PRODUCT was designed
to be employed and which are specifically listed in the MANUAL:
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(d) failure of the SOFTWARE PRODUCT has resulted from anyone other than MJR or its authorized
representative installing or running any software on the computer running the SOFTWARE PROD-
UCT, other than the SOFTWARLE PRODUCT itself; or

(e)  for failure to comply with any of the provisions of this License Agreement.

3.4 NOOTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MJR DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR TM-
PLIED, INCLUDING, BUT NOT LIMITED TQ, IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGE-
MENT, WITH REGARD TO THE SOFTWARE PRODUCT.

4.0 LIMITATION OF LIABILITY

4.1 LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, IN NO EVENT SHALL MJR OR ITS SUPPLIERS OR EMPLOYEES BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (IN-
CLUDING, WITHOUT LIMITATION, DAMAGLES FOR L.OSS OF BUSINESS PROFITS, BUSI-
NESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE SYSTEM OR SOFTWARE
PRODUCT OR THE FAILURE TO PROVIDE SUPPORT SERVICLES, EVEN TF MJR HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MJR’s ENTIRE LI-
ABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE PUR-
CHASE PRICE PAID BY LICENSEE FOR THE SYSTEM AND SOFTWARE PRODUCT.

42 The SYSTEM, SOFTWARE PRODUCT and THIRD PARTY SOFTWARE are not intended for HIGH
RISK ACTIVITIES (as defined below). Inparticular, the SYSTEM, SOFTWARE PRODUCT and THIRD
PARTY SOFTWARE are not fault-tolerant and are not designed, manufactured or intended for use or resale
as on-line control equipment in hazardous environments requiring fail-safe performance, or any other appli-
cations or situations in which the failure of the SYSTEM or SOFTWARE PRODUCT could lead directly
to death, personal injury, or severe physical or environmental damage (“HIGH RISK ACTIVITIES").
Accordingly, MJR specifically disclaims any express or implied warranty of fitness for HIGH RISK AC-
TIVITIES. LICENSEE agrees that MIR will not be liable for any claims or damages arising from the use
of the SYSTEM or SOFTWARE PRODUCT in such applications or situations.

5. INDEMNIFICATION .

5.1 LICENSEE agrees to indemnify and hold harmless MJR (including its officers, directors, employees, and
agents) and suppliers from and against any claims or lawsuits, including attorney fees, that arise or result
from any negligent, unlawful, or unauthorized use, transfer, or distribution of the SOFTWARE PRODUCT
or THIRD PARTY SOFTWARE by LICENSEE.

6. TERM AND TERMINATION

6.1 Term. The term of this AGREEMENT and the license granted hereunder shall commence upon first use of
the SYSTEM or first copying of the SOFTWARE PRODUCT by LICENSEE arid shall terminate upon
LICENSEE’s discontinued use of the SOFTWARE PRODUCT or the transfer of the SOFTWARE PROD-
UCT as provided in Paragraph 2.1(d), whichever occurs earlier; provided, however, that this AGREEMENT
and the license granted hereunder shall survive and continue as to the transferee.
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6.2 Termination. This AGREEMENT and the license granted hereunder may be terminated by MJR, without
prejudice to any other rights, by written notice to LICENSEE only in the event that LICENSER is in breach
of any material provision of this AGREEMENT, which breach is not cured after reasonable notice. In the
event of termination by MJR, LICENSEE shall destroy all copies of the SOFTWARE PRODUCT in
LICENSEE’s possession, and all of its component parts, LICENSEE may terminate any license granted

Xy

hereunder by returning the SOFTWARE PRODUCT and any documentation, including the MANUAL, to

MJR.
7. GENERAL PROVISIONS

7.1 Entire Agreement. This AGREEMENT is the entire agreement and understanding of the parties hereto with
respect to the SOFTWARE PRODUCT, and supersedes all prior oral, written, or other representations and
agreements. This AGREEMENT may only be amended in writing by an authorized agent of MJR.

7.2 If any provision of this AGREEMENT is held invalid, the offending clause will be modified so as to be
enforceable and, as modified, shall be fully enforced, and the remainder of the AGREEMENT will continue
in full force and effect.

7.3 Intellectual Property Rights. All title and intellectual property rights, including copyrights, in and to the
SOFTWARE PRODUCT, the THIRD PARTY SOFTWARE, the accompanying printed materials, in-
cluding the MANUAL, and any copies of the SOFTWARE PRODUCT, are owned by MJR or its suppli-
ers. All rights not expressly granted are reserved by MJR.

7.4 U.S. Government Restricted Rights. The SOFTWARE PRODUCT and any documentation are provided
with RESTRICTED RIGHTS, Use, duplication, or disclosure by the Government is subject to restrictions as
set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software- Restricted Rights
clause at 48 CFR 52.227-19, as applicable. Manufacturer is MJ Research, Incorporated, 590 Lincoln Street,
‘Waltham, MA 02451,

7.5 Export Restrictions. The SOFTWARE PRODUCT, the THIRD PARTY SOFTWARE, any part thereof,
and any accompanying documentation, including the MANUAL, shall not be exported or re-exported out-
side of the United States without MJR’s prior writien permission, and, if MJR gives such permission, the
SOFTWARE PRODUCT, THIRD PARTY SOFTWARE, any part thereof, or accompanying documenta-
tion shall not be exported or re-exported to any country, person, entity or end user subject to U.S. export
restrictions.

7.6 Applicable Law. This AGREEMENT shail be governed by the laws of the Commonwealth of
Massachusetts.

7.7 Survival. Sections2.2,2.3,2.4,3,4,5, and 7 shall survive termination, cancellation or completion of this
AGREEMENT.

BY USING THE SYSTEM OR BY USING OR COPYING THE SOFTWARE PRODUCT YOU ACKNOWLEDGE

THAT YOU HAVE READ AND UNDERSTOOD THE FOREGOING AND AGREE TO BE BOUND THEREBY AS
LICENSEE OF THE SOFTWARE PRODUCT
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Declaration of Conformity

Bio-Rad Laboratories, Inc., 1000 Alfred Nobel Drive, Hercules, California,
94547, U.S A., declares that the product

CFD-3240, The Chromo4! Detection System
to which this declaration relates, is in conformity to the following standards or

normative documents.

IEC61010-1
EN61326: CLASS A

following the provisions of the 73/23/EEC, 89/336/EEC & 93/68/EEC Directive.

Test Data to verify this conformity are available for inspection at our European
Representative Office at Literbuen 10B, 2740 Skovlunde, Denmark.

13 September, 2004
date of issue

Brad Crutchfield
Vice President

11149 rav AA
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Copyright ©2004, Bio-Rad Laboratories, Incorporated. Al rights reserved. Reproduction in any
form, either print or electronic, is prohibited without written permission of Bio-Rad Laboratories, Inc.

05434 revC.A DRAFT

Alpha, Chillout, DNA Engine, DNA Engine Tetrad, Hot Bonnet, Microseal, MJ Research and the
helix logo, Moto Alpha, Remote Alpha Dock, Slide Chambers and Tetrad are trademarks of Bio-Rad

Laboratories, Inc.

This instrument, Serial No , is an Authorized Thermal Cycler. lts purchase price
includes the upfront fee component of a license under United States Patent Nos. 4,683,195,
4,683,202 and 4,965,188, owned by Roche Molecular Systems, Inc., and under corresponding
claims in patents outside the United States, owned by F. Hoffmann-laRoche Ltd, covering the
Polymerase Chain Reaction {"PCR"} process, to practice the PCR process for internal research and
development using this insirument. The running royalty component of that license may be purchased
from Applied Biosystems or obtained by purchasing Authorized Reagents. This instrument is also an
Authorized Thermal Cycler for use with applications licenses available from Applied Biosystems. lis
use with Authorized Reagents also provides a limited PCR license in accordance with the label rights
accompanying such reagents. Purchase of this product does not itself convey fo the purchaser a
complete license or right fo perform the PCR process. Further information on purchasing licenses to
practice the PCR process may be obtained by contacting the Director of Licensing, Applied Biosystems,
850 Lincoln Centre Drive, Foster City, California, 94404, USA.

No rights are conveyed expressly, by implication or estoppel fo any patents on reakime PCR.

Applied Biosystems does not guarantee the performance of this instrument.
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Explanation of Symbols

A CAUTION: Risk of Danger! Wherever this symbol appears, always consult note
in this manual for further information before proceeding. This symbol identifies com-
ponents that pose a risk of personal injury or damage to the instrument if improperly

handled.

A CAUTION: Risk of Electrical Shock! This symbol identifies components that pose
a risk of electrical shock if improperly handled.

CAUTION: Hot Surface! This symbol identifies components that pose a risk of per-

sonal injury due fo excessive heat if improperly handled.

Safety Warnings

Warning:
& Warning:

A Caution:

Operating the DNA Engine® or DNA Engine Tetrad® cycler before reading
this manual can constitute a personal injury hazard. Only qualified labora-
tory personnel trained in the safe use of electrical equipment should oper-
ate these machines.

Do not open or attempt to repair the DNA Engine or DNA Engine Tetrad
base, the DNA Engine Tetrad power supply, any Alpha™ unit, or other DNA
Engine or DNA Engine Tetrad accessory. Doing so will void your warran-
ties and can put you at risk for electrical shock. Return the DNA Engine or
DNA Engine Tetrad instrument to the factory (US customers) or an autho-
rized distributor {all other customers) if repairs are needed.

All Alpha unit blocks can become hot enough during the course of normal
operation to cause burns or cause liquids to boil explosively. Wear safety
gogeles or other eye protection at all times during operation.

The DNA Engine and DNA Engine Tetrad instruments incorporate neutral
fusing, which means that live power may still be available inside the ma-
chines even when a fuse has blown or been removed. Never open the DNA
Engine or DNA Engine Tetrad base; you could receive a serious electrical
shock. Opening the base will also void your warranties.

Never remove an Alpha unit from the DNA Engine or DNA Engine Tetrad
base with the power turned on and a program running. Doing so can cause
electrical arcing that can melt the contacts in the connector joining the Al-
pha unit to the DNA Engine or DNA Engine Tetrad base.



Safe Use Guidelines

The DNA Engine and DNA Engine Tetrad instruments are designed to be safe to operate un-
der the following conditions:

* Indoor use

¢ Altitude up to 4000m

¢ Ambient temperature 5°-31°C

* Maximum relative humidity 90%, noncondensing

* Transient overvoltage per Installation Category 11, IEC 664

* Pollution degree 2, in accordance with TEC 664

Electromagnetic Interference

These devices comply with Part 15 of the FCC Rules. Operation is subject fo the following
two conditions: (1) these devices may not cause harmful interference, and (2) these de-
vices must accept any interference received, including inferference that may cause un-
desired operation. ‘

These devices have been tested and found to comply with the EMC standards for emis-
sions and susceptibility established by the European Union at time of manufacture.

This digital apparatus does not exceed the Class A limits for radio noise emissions from
digital apparatus set out in the Radio Inferference Regulations of the Canadian Depart-
ment of Communications.

LE PRESENT APPAREIL NUMERIQUE N'EMET PAS DE BRUITS RADIOELECTRIQUES
DEPASSANT LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A
PRESCRITES DANS LE REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR
LE MINISTERE DES COMMUNICATIONS DU CANADA,

FCC Warning

Warning: Changes or modifications to these units not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant o Part 15 of the FCC Rules. These limils are designed fo provide
reasonable profection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radiofrequency
energy and, if not installed and used in accordance with the instruction manual, may
cause harmful interference fo radio communications. Operation of this equipment in a
residential area is likely fo cause harmful interference in which case the user will be re-
quired to correct the inferference at his own expense.
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Documentation Conventions

Typographic Conventions

The names of keyboard keys are set in sans serif type and encased in
double angle brackets:

Example  «Proceed»
Items in programming menus are italicized:

Example  Select Edit from the Main Menu.

Graphic Conventions

Terminology

The programming screens displayed in the LCD window are represented
by a box containing four lines of text:

Example

Run: 2-STEP

1= 92.6 for B:85
Cycle: 1

Calc: 65.0

A programming option is termed “selected” when the cursor is positioned
in front of it. Use the «Select» keys (see fig. 2-2) to move the cursor. In
some screens selected items are also displayed in all-capital letters.



Part |

The DNA Engine®
Peltier Thermal Cycler






Infroduction

Meet the DNA Engine Thermal Cycler, 1-2
Using This Manual, 1-2
Important Safety Information, 1-3

1-1



M DNA Engine & DNA Engine Tetrad Operations Manual

Meet the DNA Engine® Thermal Cycler

Thank you for purchasing an MJ Researci® PTC-200 DNA Engine ther-
mal cycler. Designed by a team of molecular biclogists and engineers,
the DNA Engine will meet your needs for a versatile, easy-to-use, reli-
able, and compact programmable thermal cycler:

» Interchangeable sample blocks—the Alpha™ unit family— that ac-
commodate many types of tubes, microplates, and slides

e HotBonnet® heated lid (or its remote-controlled version, the Power Bon-
net) for oil-free cycling

¢ Intuitive software with easy-to-read interface for quick and painless
programming, editing, file management, password protection, and
much more

» Choice of calculated sample temperature control for highest speed
and accuracy, or block or probe control for compatibility with proto-
cols designed for a variety of instrument types

* Space-saving design for easy setup and transportation
* Instant Incubate feature for continuous-temperature incubations

¢ Networking for up to 15 machines, for convenient remote operation
and documentation of runs

* Customizable factory-installed protocols

When multiple users or high-throughput operations must be accommo-
dated, the PTC-225 DNA Engine Tetrad® cycler is available. Essentially
consisting of four DNA Engines placed in one chassis, the DNA Engine
Tetrad has the same features and ease-of-use of the stand-alone DNA

Engine.

Using This Manual

This manual contains all the information you need to operate your DNA
Engine or DNA Engine Tetrad safely and productively:

* Chapter 2 acquaints you with the physical characteristics of the DNA
Engine.

* Chapters 3-5 present the basics of installing and operating the DNA
Engine.

* Chapters 6 and 7 describe programming the DNA Engine.

¢ Chapter 8 outlines the utilities available for the DNA Engine.

» Chapter 9 describes how to network and remotely operate the DNA



Introduction A

Engine and DNA Engine Tetrad.
* Chapter 10 explains the proper maintenance of the DNA Engine.
* Chapter 11 offers troubleshooting information for the DNA Engine.
* Chapter 12 describes the operation of the DNA Engine Tetrad.

* Chapter 13 describes the operation of the Remote Alpha Dock™ ac-
Cessory.

Important Safety Information

safe operation of the DNA Engine or DNA Engine Tetrad begins with a
complete understanding of how the machine works. Please read this en-
tire manual before attempting to operate the DNA Engine or DNA En-
gine Tetrad. Do not allow anyone who has not read this manual to oper-
ate the machine.

The DNA Engine and DNA Engine Tetrad can generate enough heat to
inflict serious burns and can deliver strong electrical shocks if not used
according to the instructions in this manual. Please read the safety warn-
ings and guidelines at the front of this manual, and exercise all precau-
tions outlined in them.
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Front View

(Figure 2-1)

Control panel

Control Panel

(Figure 2-2)
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Alpha Units

2.4

| Single-Block Models

60V Alpha:  Holds 60 x 0.5ml tubes

96V Alpha:  Holds 96 x 0.2ml tubes or one 96-well
microplate

384 Alpha:  Holds one 384-well microplate or
one 96-well microplate

Dual-Block Models
30/30 Dual Alpha:  Holds 2 x 30 x 0.5ml tubes

30/48 Dual Alpha: Holds 1 x 30 x 0.5ml tubes
and 1 x 48 x 0.2ml tubes

48/48 Dual Alpha:  Holds 2 x 48 x 0.2ml tubes or
half plates

Slide Block

Slide Chambers Alpha unit: Holds 2 x 16 standard
slides

[m} 5

(HIm

Moto Alpha™ unit

Permits remote control of Alpha unit lid opening; avail-
able in 96-, 384-well and flat-block formats.




Specifications

Thermal range:

Accuracy:

Thermal homogeneity:

Ramping speed:

Sample capacity:

Line voltage:

Frequency:
Power:
Fuses:
Displays:

Ports;

Memory:
Weight:

Size:

Layout and Specifications M

—5" to 105°C, but no more than 30°C below ambient
temperature

10.3°C of programmed target @ 90°C, NIST-traceable

10.4°C well-to-well within 30 seconds of arrival at
90°C (for most Alpha units; see specifications for in-
dividual Alpha units)

Up to 3°C/sec for all single- and dual-block Alpha
units; 1.2°C/sec for the Slide Chambers Alpha unit.

Varies with installed Alpha unit

100-240VAC rms (no adjustment needed among volt-
ages within these ranges)

50-60Hz single phase

850W maximum

Two 6.3A, 250V, 5 x 20mm

One 20 x 4 LCD alphanumeric display

One 25-pin 8-bit parallel interface printer port

One 9-pin R5-232 serial port for printer or remote use

One [EEE-488 bidirectional general purpose interface
bus

200 typical programs in up to 12 individual folders

7.6-9.3kg, varies with installed Alpha unit (DNA
Engine Tetrad: 29kg, including Alpha units and
power supply)

24 x 35 x 17cm (DNA Engine Tetrad: 37 x 55 x 25cm)

2.5



Gradient Specifications (96V Alpha module only)

Accuracy: + 0.4°C of programmed target at end columns, 30

seconds after the timer starts for the gradient step,
NIST-traceable

Column uniformity: + 0.4°C, well-to-well within column, within 30 sec-
onds of reaching target temperature

Calculator accuracy: +0.4°C of actual well temperature
Lowest programmable 30°C
temperature

Highest programmable 105°C
temperature

Temperature differential 1-24°C
range
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Packing Checklist

After unpacking the DNA Engine, check to see that you have received
the following:

* One DNA Engine base

* One Alpha unit (more if additional units were ordered)
» Two spare fuses

*  One power cord

*  One probe, if purchased

* PTC-200 DNA Engine & PTC-225 DNA Engine Tetrad Operations Manual
(this document)

If any of these components are missing or damaged, contact MJ ResearRcH
or the authorized distributor from whom you purchased the DNA En-
gine to obtain a replacement. Please save the original packing materials
in case you need to return the DNA Engine for service. See appendix C
for shipping instructions.

Setting Up the DNA Engine

The DNA Engine requires only minimal assembly: plugging in the power
cord and inserting an Alpha unit. Insert the power cord plug into its jack
at the back of the machine (see fig. 2-3 for location of jack), then plug the
cord into an electrical outlet. With the machine turned off, insert an Alpha
unit (see “Installing an Alpha Unit,” chapter 4).

& Caution: Do not insert or remove an Alpha unit with the DNA

Engine turned on; electrical arcing can result. Read the
safety warning at the front of this manual regarding elec-
trical safety when inserting or removing an Alpha unit.

Environmental Requirements

32

Ensure that the area where the DNA Engine is installed meets the follow-
ing conditions, for reasons of safety and performance:

* Nonexplosive environment

* Normal air pressure (altitude below 4000m)
+ Ambient temperature 5°-31°C

* Relative humidity up to 90%

¢ TUnobstructed access to air that is 31°C or cooler (see below)
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* Protection from excessive heat and accidental spills (Do not place
the DNA Engine near such heat sources as radiators, and protect it
from danger of having water or other fluids splashed on it, which
can cause shorting in its elecirical circuits.)

Power Supply Requirements

The DNA Engine requires 100-240VAC, 50-60Hz, and a grounded out-
let. The DNA Engine can use current in the specified range without
adjustment, so there is no voltage-setting switch.

Power cords for outlets other than the US 120V outlet may be purchased
from computer stores, since they are also used for most desktop computers
and printers and meetinternational standard IEC-320. The power cord must
be rated to carry at least 10A at 125V or 250V, depending on the voltage
available in your nation. The quality of the power cord can be further en-
sured by making certain it is inscribed with the trademark of UL, CSA, TUV,
VDE, or another national testing agency.

Note: Do not cut the supplied 120V power cord and attach a different con-
nector. Use a one-piece molded connector of the type specified above.

Air Supply Requirements

The DNA Engine requires a constant supply of air that is 31°C or cooler in
order to remove heat from the Alpha unit's heat sink. Air is taken in from
vents at the front, back, and bottom of the machine and exhausted from
vents on both sides (see figs. 2-1, 2-3, and 2-4). If the air supply is inadequate
ar too hot, the machine can overheat, causing performance problems, soft-
ware error messages (particularly “HS Overheating” and “Slow Block Cy-
cling”), and even automatic shutdowns. Special attention should be paid to
airflow and air temperature in robotics installations of DNA Engines.

Ensuring an Adequate Air Supply
* Do not block the air intake vents.

Position the DNA Engine at least 10cm from vertical surfaces and
other thermal cyclers (greater distances may be required; see be-
low). Do not put loose papers under the machine; they can be sucked
into the air intake vents on the bottom of the machine.

* Do not allow dust or debris to collect in the air infake vents.

The bottom air vents are particularly liable to collect dust and debris,
sometimes completely clogging up. Check for dust and debris every
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few months, and clean the intake vents as needed. Remove light col-
lections of dust with a soft-bristle brush or damp cloth. Severe col-
lections of dust and debris should be vacuumed out. Turn the ma-
chine off prior to cleaning or vacuuming air vents.

Ensuring That Air Is Cool Enough

Dao not position two or more DNA Engines (or other thermal cyclers)
so that the hot exhaust air of one blows directly into the air intake
vents of another.

Make sure the DNA Engine receives air that is 31°C or cooler by mea-
suring the temperature of air entering the machine through its air
intake vents.

Place the DNA Engine where you plan to use it, and turn it on. Try to
reproduce what will be typical operating conditions for the machine
in that location, particularly any heat-producing factors (e.g., nearby
equipment running, window blinds open, lights on). Run a typical
protocol (e.g., 2-Step) for 30 minutes to warm up the DNA Engine,
then measure the air temperature at the back air intake vents. If more
than one machine is involved, measure the air temperature for each.

If the air intake temperature of any machine is warmer than 31°C,
use table 3-1 to troubleshoot the problem. Some experimentation
may be required to determine the best solution when more than one
cause is involved. After taking steps to solve the problem, verify that
the temperature of the air entering the air intake vents has been low-
ered, using the procedure outlined above.

Table 3-1 Troubleshooting Air Supply Problems

Possuble 'Remedles L

3-4

Provide more space around madune or ad]ust room ventilation.

CC IldlthIlIl‘lg to IoWer amblent air temperature :

Move machme away from, oT pmtect mac}une from, such heat
sources as radlators, heaters, other eqmpment or brlght sunhght

‘xhaust alr does not en_er intake
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Requirements for Robotics Installations

Robotics installations require special attention to airflow and air tempera-
ture. Typically in these installations, DNA Engines and other thermal cy-
clers are crowded into a small area, along with other heat-generating equip-
ment. Overheating can quickly occur when many of these machines are
operating at once, unless preventive measures are taken.

Follow the procedures described above to ensure adequate airflow and
an air intake temperature of 31°C or cooler. Air intake temperature must
be verified by measurement.

Do not use oil to thermally couple sample vessels to the blocks of ma-
chines in a robotics installation. Oil makes plates difficult to remove.
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Turning the DNA Engine On

Move the power switch to “1” (the “On” position). In most The fan will
turn on, and the power light on the keyboard will glow red. In most
cases a self-test of the heat pumps will begin running (see note below).
Its progress is tracked on a screen in the LCD window:

PTC-200:

Self testing

This screen disappears in 1 minute. If a problem is detected, the display
shows an error message.

Note: If the Alpha unit’s block or heat sink is not at ambient tempera-
ture (typically because the Alpha unit was recently in use), the machine

will skip the self-test.

If the self-test does not detect any problems, the Main Menu is displayed:

PTC-200:

_RUN Enter
List Edit
Files Setup

The DNA Engine is now ready to execute programs.

Understanding the Main Menu

42

The Main Menu is the common access point to all programming and
machine configuration screens:

* Run: Executes a program.

* Enter: Allows new programs to be entered.

* List: Accesses utilities that display or print a program'’s steps.
» Edit: Allows modification of stored programs.

« Files: Accesses file management utilities.

= Setup: Accesses machine and networking configuration screens.
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Using the Conirol Panel

The control panel (see fig. 2-2) includes operation keys, status indicator
lights, an LCD window for displaying programming and machine status
text, and a numeric keypad for entering values into programs.

Operation Keys

Select keys (left and right arrows): Move the cursor one space or op-
tion to the left or right in the LCD window; display time and cycle
information during a protocol run.

Proceed: Accepts a selected menu or screen option; 'during a protocol
run, advances the program to its next step.

Cancel: Terminates a running protocol; during program creation or
editing, cancels the last entry.

Stop: Terminates a running protocol.

Pause: Pauses a protocol during execution; accesses Japanese Katakana
syllabary.

Instant Incubate: Initiates a program that sets up the DNA Engine as
a simple incubator.

Block: Selects a different block when using a dual-block Alpha unit;
switches between block screens and the Main Menu in the LCD win-
dow during a protocol run.

Status Indicator Lights

Power light: Glows red when the DNA Engine is powered up.

Block Status lights: Indicate which blocks are in use; glow red when
blocks are heating and green when blocks are cooling.

Using the Data Ports

The DNA Engine has three data ports located at the rear of the machine:
an R5-232 port, an IEEE-488 port, and a parallel (printer) port. See chap-
ters 8 and 9 for information on using these ports to network machines,
connect them to a computer, or print data.
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Operating Alpha Units

Note: Operation of the Slide Chambers Alpha unit will not be discussed,
owing to the many differences between this type of Alpha unit and the
others. Please see the Slide Chanibers Operations Manual for operating in-
structions.

Note: Moto Alpha™ units are installed and removed as described below.
See the Moto Alpha Uit Operations Manual for instructions on opening and
closing Moto Alpha units.

Installing an Alpha Unit

1.

Turn the DNA Engine off (see the Caution on p. 4-5).
Hold the Alpha unit at its front and back edges.

Lower the Alpha unit into the DNA Engine base, leaving at least 3cm
between the front edge of the Alpha unit and the front of the base.

Raise the handle at the back of the Alpha unit, and slide the block
forward as far as it will go (fig. 4-1A).

Push the handle down until it is completely vertical (fig. 4-1B); firm
pressure may be required. A definite click signals that the Alpha unit's
connectors have mated with the DNA Engine’s connectors.

When the handle is in the down position, the Alpha unit is locked into place.

Figure 4-1 Installing an Alpha unit.
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Removing an Alpha Unit
1. Turn the DNA Engine off (see the Caution below).

2. Pull upward on the handle. When the lock releases, you will hear a
click, and the Alpha unit will slide a little toward the back of the DNA
Engine. The electrical connectors of the Alpha unit and the DNA En-
gine are now disengaged, so there is no danger of electrical shock.

Slide the Alpha unit toward the rear of the DNA Engine about 3cm.

4. Grasp the front and back edges of the Alpha unit, and Iift it out of
the machine.

A Caution: Do not insert or remove an Alpha unit with the DNA
Engine turned on; electrical arcing can result. Read the
safety warning at the front of this manual regarding elec-
trical safety when inserting or removing an Alpha unit.

Opening an Alpha Unit

Grip the front edge of the top lever of the Hot Bonnet® as shown in figure
4-2A, and pull upward firmly. The top lever will pop open to reveal the
entire thumbwheel (fig. 4-2B). Continue pulling upward to open the Hot
Bonnet. The Hot Bonnet will tip backward, revealing the entire block.

& Caution: Do not pull on the thumbwheel to open the unit. This can
damage the Hot Bonnet’s closing mechanism.

Figure 4-2 Opening an Alpha unit.
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Closing an Alpha Unit

Press down on the top lever. The lever will close down over the thumbwheel
as the Hot Bonnet closes down over the sample block. A click signifies that
the Hot Bonnet's latch has engaged.

Selecting the Correct Sample Vessel

46

The DNA Engine’s wide variety of interchangeable Alpha units affords
you great scope in choosing sample vessels. Keep in mind that differ-
ences in tube and plate composition and wall thickness among the many
brands available can affect reaction performance. Protocols may require
some adjustment to ensure optimum performance when using a new
vessel type. M] ResearcH offers a full range of tubes and microplates,
manufactured to the specifications of each type of Alpha unit to ensure a
precise fit. See chapter appendix 4-A for a complete list.

0.5-ml Tubes

Make sure thick-walled 0.5-m! tubes fit the wells snugly. Since these tubes
were originally designed for centrifuges, some brands may not fit ightly
in thermal cycler wells. Thin-walled 0.5-ml tubes were specifically de-
signed for thermal cycling, and the higher quality brands provide a good
and consistent fit. MJ ResearcH provides thin- and thick-walled 0.5~-ml
tubes designed for precise block fit.

0.2-ml Tubes

All types of thin-walled 0.2-ml tubes may be used. MJ ResearcH sells
high-quality 0.2ml tubes in a number of styles, including individual tubes
and strips.

Microplates

A variety of 96-well polycarbonate or polypropylene microplates can be
used in 96V Alpha units as long as they fit the wells snugly. Polypropy-
lene microplates are usually preferred because they exhibit very low pro-
tein binding and, unlike polycarbonate microplates, do not lose water
vapor through the vessel walls. This allows smaller sample volumes to
be used—as little as 5-10ul. Polypropylene microplates and compatible
Microseal® ‘A’ film, mats, or strip caps for sealing are available from M]
ReseARCH. (See “Sealing with the Hot Bonnet and Caps or Film Sheets,” p.
X, for a description of Microseal ‘A’.)
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Thin-Walled Vs. Thick-Walled Tubes

The thickness of sample tubes directly affects the speed of sample heat-
ing and thus the amount of time required for incubations. Thick-walled
tubes delay sample heating, since heat transfers more slowly through the
tubes” walls. For the earliest types of thermal cyclers this delay mattered
little. These machines’ ramping rates were so slow (below 1°C/sec) that
there was plenty of time for heat to transfer through the tube wall to the
sample, during a given incubation.

Modern thermal cyclers have much faster ramping rates (up to 2-3°C/
second), 50 the faster heat transfer provided by thin-walled tubes allows
protocols to be significantly shortened. For example, in the reaction illus-
trated in figure 4-x, over 30 seconds can be saved per cycle by using thin-
walled tubes, for an overall savings of 15 minutes in a 30-cycle run.

Sealing Sample Vessels

Steps must be taken to prevent the evaporation of water from reaction
mixtures during thermal cycling, to avoid changing the concentration of
reactants. Only a layer of oil or wax will completely prevent evaporation
from sample vessels. However, an adequate degree of protection can be
achieved by sealing with Microseal film or caps, then cycling the samples
using the heated lid to prevent condensation/refluxing.

Sealing with Oil or Wax

Mineral oil, silicone oil, paraffin wax, or Chill-out™ liquid wax may be
used to seal sample vessels. Use only a small amount of oil or wax; 1-3
drops (15-50]) are usually sufficient. (Include this volume in the total
volume when setting up a calculated-control protocol; see “Setting Up a
Calculated-Control Protocal,” chapter 5.) Use the same amount of oil or
wax in all sample vessels to ensure a uniform thermal profile.

Most paraffin waxes solidify at room temperature. The wax can then be
pierced with a micropipette and the samples drawn off from below the
wax. Silicone oil and mineral oil can be poured off or aspirated from tubes
if the samples are first frozen (~15° to —20°C). The samples are usually
pure enough for analysis without an extraction.

Chill-out liquid wax (available from MJ REsEaRCH) is an easy-to-use alter-
native to oil. This purified paraffinic oil solidifies at 14°C and is liquid at

. room temperature. By programming a hold at low temperature, the wax
can be solidified at the end of a run. A pipette can then be used to pierce
the wax in the tubes and remove the samples. The wax is dyed red to
assist in monitoring its use. The dye has no adverse effects on fluorescent
gel analysis of reaction products.

4.7
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Sealing with the Hot Bonnet and Caps or Film Sheets

The Hot Bonnet’s heated inner lid maintains the air in the upper part of
sample vessels at a higher temperature than the reaction mixture. This
prevents condensation of evaporated water vapor onto the vessel walls,
so that solution concentrations are unchanged by thermal cycling. The
Hot Bonnet also exerts pressure on the tops of vessels loaded into the
block, helping to maintain a vapor-tight seal and to firmly seat tubes or
the plate in the block.

Caps, film, or mats must be used along with the Hot Bonnet to prevent
evaporative losses. Tight-fitting caps do the best job of preventing vapor
loss (and should be used for long-term storage of reaction products).

Microseal ‘A’ film is a quick way to seal Multiplate and “Concord”
microplates or large arrays of tubes. This film is specially designed to
seal tightly during cycling yet release smoothly, which minimizes the risk
of aerosol formation and cross-contamination of samples. Microseal ‘A’
is easily cut for use with fewer than 96 wells.

Microseal ‘M’ rubber sealing mats are an economical means to seal 96-
well microplates. An array of 96 dimples on the mat helps orient it on the
microplate and prevents the mat from sticking to the Hot Bonnet's heated
lid. The mats may be cleaned with sodium hypochlorite for reuse and are
autoclavable.

Note: After a hold at below-ambient temperatures, a ring of condensa-
tion may form in tubes above the liquid level but below the top of the
sample block. This is not a cause for concern since it occurs only at the
final cool-down step, when thermal cycling is finished.

Adjusting the Hot Bonnet’s Lid Pressure

The pressure exerted by the inner lid of the Hot Bonnet must be manually
adjusted to fit the sample vessels being used in a given reaction. Once set,
the Hot Bonnet can be opened and closed repeatedly without readjustment
as long as neither the tube or microplate type nor the sealing method
changes. Any change in vessel type or sealing method requires readjust-
ment of the Hot Bonnet's lid.

Follow these steps to adjust the pressure exerted by the Hot Bonnet's

inner lid:

1. Make sure the block’s wells are clean. Even tiny amounts of extraneous
material can interfere with the proper seating of a microplate or tubes,

which would prevent the inner lid from exerting uniform pressure
on the loaded microplate or tubes.

2. Open the Hot Bonnet. Turn the blue thumbwheel all the way counter-
clockwise to completely raise the inner lid.
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3. Load either a microplate or at least eight individual tubes into the
sample block. The inner lid pivots around a central point, so it is im-
portant to distribute individual tubes evenly: Load at least four tubes
in the center of the block and at least one tube in each of the four
corners of the block. If using a sealing film or mat, apply it to the
loaded microplate according to the manufacturer’s directions.

4. Close the Hot Bonnet by pressing down on the top lever. Turn the
thumbwheel clockwise to lower the Hot Bonnet's inner lid onto the
loaded microplate / tubes. The thumbwheel turns easily at first since
the inner lid has not yet come into contact with anything. Stop turn-
ing the thumbwheel when you feel increased resistance, which indi-
cates that the inner lid has touched the microplate / tubes.

5. Open the Hot Bonnet. Turn the thumbwheel clockwise an extra half
to three-quarters of a turn to set an appropriate lid pressure.

A Caution: Do not turn the thumbwheel more than three-quarters of a
turn. This can make it hard or impossible to close the lid
and puis excessive strain on the latch holding the lid closed.

An extra half to three-quarters of a turn ensures the correct pressure for
most types of reaction vessels. Some empirical testing may be required
to determine the optimum pressure required for certain vessels. Once
this pressure has been determined, the thumbwheel position that deliv-
ers it may be marked with a colored marking pen or piece of tape.

Note: As an aid in gauging how much the thumbwheel has been
turned, mark it at the quarter turn positions, or every sixth “bump”
on the thumbwheel (there are 24 total “bumps”).

6. Close the Hot Bonnet.

Loading Sample Vessels into the Block

When using a small number of tubes, they should all be placed in the

center of the block, to ensure uniform thermal cycling of all samples. Also

load at least one empty tube in each corner of the block, to ensure that the
| Hot Bonnet exerts even pressure on the sample tubes (see “Adjusting the
Hot Bonnet's Lid Pressure,” p. 4-8).

To ensure uniform heating and cooling of samples, sample vessels must
be in complete contact with the block. Adequate contact is ensured by
| always doing the following:
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* Ensure that the block is clean before loading samples (see chapter 10
for deaning instructions)

» Firmly press individual tubes or the microplate into the block wells.

Using Oil to Thermally Couple Sample Vessels to the
Block

With two exceptions (see below), MJ ResearcH does not recommend
using oil to thermally couple sample vessels to the block, for the fol-
lowing reasons:

* Calculated-control protocols do not run accurately when oil is used.

* Oil traps dirt, which interferes with thermal contact between vessels
and the block.

A Caution:  If you use oil in the block, use only mineral oil. Never use
silicone oil. It can damage the Alpha unit.

One exception to this recommendation involves the use of volatile radioac-
tive ¥5 nucleotides. A small amount of oil in the block can help prevent
escape of these compounds. See chapter appendix 4-B for important infor-
mation regarding safe use of these compounds in polypropylene tubes and
polypropylene and polycarbonate microplates. A second exception involves
the use of thick-wall 0.5-ml tubes. Certain brands of these tubes fit poorly in
the block, in which case oil may somewhat improve thermal contact. When-
ever possible, use high-quality thin-wall tubes intended for thermal cycling
(see chapter appendix 4-A for a tube and plate selecton chart).

Figure 4-3 A, Probe. B, Location of probe jack.

410

™~

Frobe tube

E

= — Probe

N

jack
Probe plug 1

7
W




Operation

Using the Optional Probe

The probe consists of a precision thermistor mounted in a thin-walled
plastic tube. A thin wire, encased in a small plastic tube, runs from the
thermistor to the probe’s plug, which is inserted into a slot at the back of
the Alpha unit (fig. 4-3). A small amount of oil is added to the probe tube
to serve as the representative sample. The tube is loaded into the block,
where it can serve as the control reference for any programmed target
temperature between 0° and 100°C.

When a probe-control protocol is run, the DNA Engine controls block
temperature to keep the probe vessel at the programmed temperature,
using feedback information from the thermistor. (See chapters 5 and 6
for information on programming protocols for probe control.)

Note: Because the thermal characteristics of a probe can never precisely
match those of a sample, calculated control is often a better choice than
probe control.

Customizing the Probe Vessel

For the most precise control of sample temperatures, install the probe’s
thermistor in the same type of tube that the samples will be placed in.
This is particularly important when the sample tubes have much thicker
walls than the probe’s tube.

Follow these steps to customize the probe vessel:

1. Cut the hinge to the probe tube’s lid, if there is one. Remove the lid
and the attached the amber-colored thermistor.

2

Remove the lid from the new probe tube. Add oil to the probe tube as
described below under “Adding thie Oil.”

3. Gently place the thermistor in the new tube, and snap the lid closed.
Make sure that the lid from the original probe tube fits the new tube
tightly . The probe wire may touch the sides of the tube. The ther-
mistor should rest on the bottom of the tube.

A Caution:  The thermistor is extremely fragile. Handle it with great care.

Adding the Oil

Viscous oils are the best choice for the probe tube’s representative
sample. They closely mimic the thermal characteristics of buffer solu-
tion, which changes temperature sluggishly due to the high specific
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heat of water. M] ResearcH recommends using heavy mineral oil, for
the following reasons:

* The calculations required to determine the correct volume of oil are easy.

* Itis widely available and inexpensive.

Add mineral oil to the probe tube in the following proportions: 1 x the
volume of the buffer in an individual tube, plus 1 x the volume of oil
overlay if one is used. It is important to use the correct amount of oil, so
that the representative sample changes temperature at the same rate as
the actual samples. To add the oil, open the sample tube and pipette in
the appropriate amount. The oil must completely cover the thermistor.

Light and heavy silicone oil may also be used but necessitate more com-
plex calculations to determine the amount to add to the probe tube. See
chapter appendix 4-C for information on using these oils.

Note: Use only mineral oil or silicone oil as the representative sample.
Do not use paraffin wax or Chill-out iquid wax, or the probe readings
will not be accurate.

Figure 4-4 Correcily inserted probe.
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Operation ll

A Caution: Do not use water, saline, or any other aqueous solution
as a representative sample. Aqueous solutions will de-
stroy the thermistor.

Loading and Connecting the Probe

Seat the probe tube in the center of the block (fig. 4-4, p. 4-12). If oil is
used to thermally couple samples to the block, it must also be used on
the probe tube (but see “Using Oil to Thermally Couple Sample Vessels
to the Block,” p. 4-9).

Plug the probe into the jack at the back of the block, so that the wire is to
the left of the plug (fig. 4-4).

Detecting a Faulty Probe

If the DNA Engine detects that the probe is broken or missing when a
protocol begins running, the protocol’s temperature control method is
automatically switched from probe control to calculated control, and the
following message is immediately displayed:

Run: CUSTOMZ

Probe Sensor Failure
Used Calc Control

If the probe malfunctions during a protocol run, the temperature control
method is also switched to calculated control, and the run-time screen
changes to say “Calc” instead of “Probe.” When the run finishes, the fol-
lowing message is displayed:

Run: CUSTOM1

CALC control:
Probe not present
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Appendix 4-A Tube, Microplate, and Sealing
System Selection Chart

Key

® Reaction vessel fits block without modification.
O Reaction vessel must be cut to fit this block.

M] Research Thermal - - |Reaction Vessels = * |Sealing Options for Oil-Free Cycling 7
Cyclet Bloeks - . | L T I R N HE
m m a0 | 0 |vene be,cr;pﬁon MJ Rescanch | Microrea! [ p— | BSiip | 125tip | SeffSaal .fmmrSmI
oz | 0| 01| 0300 | Cavlag # | ity | M7 | 7ot | o | o | | o
e | O Multiplate 96-well microplates { MLP-9601| = * ] ® ®
o | w Multiplate 48-well microplates | MLP-4801| e * . . O
e | e Multiplate 24-well microplates | MLP-2401| e o | e ® o]
e | Multiplate 25-well microplates | MLP-2501| e . {4 Q Q
* "Concord" 96-well microplates | CON-9601| e
L] B-strip 0.2-m] tubes ‘ TBS-0201f e * . e o
® (O 12-strip (h2-ml tubes TBS-1201| e *: L o
] 0.2-ml tubes, no caps TBR0201| e L 3 . L] ]
e | e 0.2-ml tubes w/ caps TWI-0201
e | e 0.5-ml tubes w/caps, thin wall TBI-0501
o e 0.5-ml tubes w/caps, thick wall Te-1000
® |Glass slides SLS-series ) L L]
*

Microseal ‘M’ and ‘T’ sealers are sized for 96-well blacks but can be used with fewer than 96
wells if the vessels are placed symmetrically in the block. Microseal ‘P’ pads are intended for
use with Power Bonnet motorized lids.

Note: All tubes and multiplate microplates are made from polypropylene plastic, the optimal

material for this application. “Concord” microplates are made from polycarbonate plastic, which
is more prone to poor sealing and vapor leakage.
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Appendix 4-B Safety Warning Regarding Use
Of 33S Nucleotides

Some researchers have experienced a problem with radioactive contamination when using S in
thermal cyclers. This problem has occurred with all types of reaction vessels.

The Problem

When *5 nucleotides are thermally cycled, a volatile chemical breakdown product forms, prob-
ably 5O,. This product can escape the vessel and contaminate the sample block of a thermal cycler,

and possibly the air in the laboratory. Contamination has been reported with microassay plates,
0.2-ml tubes, and 0.5-ml tubes.

96-Well Polycarbonate Microplates

These microplates present the largest risk of contamination. Polycarbonate is somewhat perme-
able both to water and the *S breakdown product. This problem is exacerbated when polycarbon-

ate plates are held at high temperatures for long periods of time, or when the plates are sealed for
oil-free thermal cycling.

0.2-ml Polypropylene Tubes and 96-Well Polypropylene Microplates

These tubes are manufactured with very thin walls to enhance thermal transfer. The thin walls
are somewhat fragile and can “craze” or develop small cracks when subject to mechanical
stress. Undamaged thin polypropylene tubes may also be somewhat permeable to the 5 break-
down product. Either way, there have been reports of S passing through the walls of 0.2-m]
tubes of several different brands during thermal cycling. No data are yet available on radio-
active contamination with polypropylene microplates.

0.5-ml Polypropylene Tubes

Contamination problems are rarer with this type of tube, but instances have been reported.

The Solution

1. Substitute the low-energy beta emitter *P in cycle sequencing. *P nucleotides are not subject
to the same kind of chemical breakdown as ¥S nucleotides, and they have not been associated
with volatile breakdown products.

I

If *S must be used, three things will help control contamination: an oil overlay inside the
tubes, mineral oil in the thermal cydler outside the tubes, and use of thick-walled 0.5-ml tubes.
Always run *5 thermal cycling reactions in a fume hood, and be aware that vessels may be
contaminated on the outside after thermal cycling. Please be certain that you are using the
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appropriate detection methods and cleaning procedures for this isotope. Consult your radia-
tion safety officer for his or her recommendations.

If mild cleaning agents do not remove radioactivity, harsher cleaners may be used. Users have
suggested the detergent PCC-54 (Pierce Chemical Co., Rockford, Illinois; Pierce Eurochemie B.V,,
Holland), Micro Cleaning Solution {Cole-Parmer, Niles, lllinois), and Dow Bathroom Cleaner (avail-
able in supermarkets).

A Caution: Harsh cleaning agents are corrosive to aluminum and must never be used on bare
aluminum blocks. M] ResearcH blocks are anodized, so they have a protective coating
of aluminum oxide. Stll, harsh agents (such as those above) must be thoroughly rinsed
away within a few minutes of application, or the anodization will degrade.
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Appendix 4-C Using Silicone Oil in the Probe Tube

The following light and heavy silicone oils may be used instead of mineral oil as the representa-
tive sample in a probe tube:

* Dow Corning #200 light silicone oil {dimethypolysiloxane, Sigma #DMPS-5X)
Density: 0.97g/ml
Viscosity: 50cs

Volume to use: 1.7 x volume of buffer in individual sample tube, plus one volume of oil overlay.

* Dow Corning #200 heavy silicone oil (dimethypolysiloxane, Sigma #DMPS-V)
Density: 0.97g/ml
Viscosily: Scs

Volume to use: 2.7 x volume of buffer in individual sample tube, plus one volume of oil averlay.

Note: Use these oils only in the proportions outlined above. Using them in any other proportion
(for example, 1:1 with sample tube volumes) will lead to inaccurate sample heating.
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Running a Protocol

52

Running a protocol on the DNA Engine involves three steps:

1. Choosing a stored protocol to run

I

Choosing a block to run it on, if a dual-block Alpha unit is installed
3. Setting up the temperature control method

Either a custom-designed protocol or one of the factory-installed resi-
dent protocols may be run. See appendix E for descriptions of the resi-
dent protocols, which may be edited to fit your needs (see chapter 7). All -
the factory-installed protocols are stored in a single folder, called the
<MAIN> folder, at the time of shipping.

Choosing a Stored Protocol to Run

With the Main Menu displayed, select Run, then press «Proceed». One
of two types of screen will be displayed, depending on whether custom
protocols have been stored in the <MAIN> folder or in custom folders:

» If all protocols have been stored in the <MAIN> folder:

The first of three or more screens listing the protocols will be displayed.
Custom protocols are listed first, then the 14 factory-installed programs:

Run: <MATN>
_CUSTOM1  CUSTOMZ
QUIKSTEP 2-STEP
3-STEP EXTEND

Use the «Select» keys to scroll through the listed protocols. Scroll
past the Iast- or first-listed protocol to see the next screen down or up.
Select the desired protocol, then press «Proceed».

* If custom protacols have been stored in one or more custom folders:

One or more screens listing all the folders residing in the machine will
be displayed:

Run:
<MAIN> <FOLDER1>
<FOLDERZ> <FOLDER3>

Select the folder that contains the protocol, then press «Proceed». One
or more screens listing the protocols stored in the folder will be dis-
played. Use the «8Select» keys to scroll through the listed protocols.
Select the desired protoco), then press «Proceed».
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In either instance, after you press «Proceed», a screen similar to the fol-
lowing example will be displayed:

Run: 2-STEP

Vessel Type:
_TUBES Plate

The top line of the screen will identify the selected protocol (2-STEP in
the example). The other lines on the screen will request information
needed to set up the temperature control method (explained below).

Choosing a Block to Run the Protocol On

If a dual-block Alpha unit is installed (or if networked Alpha units are
available; see chapter 9), one of the blocks must be designated to run the
protocol. The first available block is automatically designated when a
protocol is chosen. Press «Block» to choose a different block. The selected
block’s letter is identified in the upper right-hand corner of the screen:

Run: 2-STEP on A

Vessel Type:
_TUBES  Plate

The status indicator light for the selected block will flash green.

Setting Up the Temperature Control Method

When the protocol is selected (and the correct block is designated for a
dual-block Alpha unit), one or more screens will be displayed. These
screens will ask for information needed to set up the block’s temperature
control method. The DNA Engine can control the block’s temperature in
three different ways: block control, calculated control, and probe con-
trol. Chapter 6 explains in detail how these methods work and their im-
plications for protocol design. The following describes how to respond
to the screens that are displayed for each control method. When these
screens have been dealt with, the protocol will begin to run.

Setting Up a Block-Control Protocol
A single screen asking about use of the heated lid will be displayed:

Run: ICEBUKET

Use heated 1id?
Yes _NO
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5-4

Select Yes or No, then press «Proceed». The protocol will begin running.

Setting Up a Calculated-Control Protocol

Three screens will be presented:

A screen asking for sample vessel information:

Run: Z2-S5TEP

Vessel Type:
_TUBES  Plate

Select from the options shown (may include tubes, plates, and slides),
then press «Proceed». Choose Plate for polycarbonate microplates and
Tutbe for polypropylene tubes or polypropylene microplates. For blocks
that hold only tubes, choose Thin or Thick, depending on the type of
tube loaded.

Note: See “Using Calculated Control” in the Slide Chambers Alpha
Linit Operations Manual for information on specifying slide format.

A screen asking for the sample reaction volume (last line in example
below);

Run: 2-STEP

Vessel Type: TUBES

Volume (pl): - 1@

Use the keypad to enter a sample volume in microliters, then press
«Proceed». If sample vessels are sealed with oil or wax, include the
volume of the oil or wax in the total sample volume entered.

Note: Specify 10p! for any volume less than 10ul.

Note: Verify that your vessel sealing system is adequately tight be-
fore performing 5-j1l reactions.

A screen asking about use of the heated lid. Select Yes or No, then
press «Proceed». The protocol will begin running,.

—
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Setting Up a Probe-Confrol Profocol

A single screen asking about use of the heated lid will be displayed. Se-
lect Yes or No, then press «Proceed». If the probe is installed, the probe
verification screen will be displayed:

Run: PROBE1

PROBE control:
Verify probe ready

Ensure that the probe is correctly installed (see “Loading and Connecting the
Probe,” chapter 4), then press «Proceed». The protocol will begin running.

If the probe is not installed, a warning message will be displayed:

RUN: PROBE1

CALC control:
Probe not present

This screen says that since the probe is missing, the DNA Engine will
run the protocol using calculated control if «Proceed» is pressed now. To
avoid this, press «Cancel», install the probe, and set the protocol up again.
When the probe verification screen is displayed, press «Proceed» to be-
gin the protocol run.

Reading the Runtime Screen

During a protocol run a runtime screen will be displayed:

Run: 2-STEP

1- 92.@" for @:05
Cycle: 1

Calc: 68.0°

The screen lists the protocol name (2-5TEP in the example above), proto-
col step that is running (1 ), cycle number (1), method of temperature
control (Calc), and the block temperature for block-control protocols, the
calculated sample temperature for calculated-control protocols (68.0), and
the probe temperature for probe-control protocols. When the step’s tar-
get temperature is reached, a timer begins running in the lower right-
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hand corner of the screen. The first digit is the minutes elapsed; the two
digits after the colon are the seconds elapsed.

For protocols using calculated control or probe control, press the left «Se-
iect» key to display the block’s temperature on the third line of the screen:

Run: Z2-STEP

1= 972.8° for 0:05
Block: 62.1
Calc: 68.0°

This screen shows only as long as the left «Select» key is pressed. The
runtime screen returns when you stop pressing the key.

Press the right «Select» key to see a screen listing the cycle number (if a
GoTo step is executing), time elapsed so far for the protocol run, and
estimated remaining time left in the rurn:

Run: 2-5TEP
Cycle: 1
Total time: 0:20
Est remain: 1:01:51

This screen is also displayed only as long as the key is pressed. The runtime
screen returns when you stop pressing the key.

Switching Between the Runtime Screen and the Main
Menu

Press «Block» to toggle between the runtime display and the Main Menu.
This allows you to edit a stored program, enter a new one, print a pro-
gram, run another protocol on a dual-block Alpha unit or networked DNA
Engine, or use the file utilities, while the protocol runs.

Reading the Protocol Completion Screen

5-6

When the protocol run finishes, a long beep sounds, and a notification
screen is displayed:

Run: 2-STEP
PROGRAM COMPLETE

Total time: 56:31

Certain error messages may also be displayed in this screen (see chap-
ter 11). Press «Proceed» to return to the Main Menu.
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Printing a Log for a Running Protocol

If the DNA Engine is connected to a printer, you can print a log for the
run that includes

* The DNA Engine’s serial number and software version
* The protocol’s name

* The temperature control method for the protocol

» Alist of the protoco!'s steps

* The runtime thermal data

To print a runtime protocol log, first ensure that a printer is connected to
the machine. See “Printing a Program,” chapter 8, for information about
compatible printers.

Follow the instructions under “Choosing a Printer Port,” chapter 8, to
prepare the DNA Engine to communicate with your printer.

As long as a printer is connected to the machine, the following screen
will appear whenever a protocol is run:

Run: 2-STEP

Printer output?
_YES No

To print the protocol as it runs, select Yes, then press «Proceed».

Note: If no printer is connected to the machine, the screen allowing you
to select printer output is not displayed at all.
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Manudlly Stepping Through a Protocol

Once a protocol is running, pressing «Proceed» gives you the option
of immediately advancing the protocol to the next programmed step,
even if the machine is currently ramping the block’s temperature (see
chapter 6 for information on ramping). A confirmation screen will be
displayed:

Run: 2-STEP

Go on to next step?
_YES No

Select Yes, then press «Proceed». The protocol will advance to its next step.

Pausing a Running Protocol

Press «Pause» to temporarily stop a running program. The timer in the lower

right-hand corner of the runtime screen will be replaced by the word “Pause”:

Run: Z-STEP

1= 92" for 0:05
Cycle: 1
Calc: 92° PAUSE

The samples are held at the displayed temperature until either the «Pause»
or the «Proceed» key is pressed, which causes the protocol run to re-
sume.

A protocol cannot be paused before the target temperature for a given
step has been reached. If «Pause» is pressed before this point, the block
continues heating or cooling until the target is reached, and then the pro-
tocol is paused.

Stopping a Running Protocol

58

Press either «Stop» or «Cancel» to stop a running protocol. A cancella-
tion confirmation screen will be displayed:

Run: Z2-STEP

Stop 2-STEP?
Yes _NO
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Select Yes, then press «Proceed» to cancel the protocol. The total run time
for the protocol will be displayed:

Run: 2-STEP
PROGRAM CANCELED

Total time: 1:15

Press «Proceed» to return to the Main Menu.

Note: Turning off the machine does not stop a running protocol. The
DNA Engine will assume the protocol was stopped by a power outage
and will resume running the protocol when the machine is turned back
on (see below).

Resuming a Protocol after a Power Outage

If a power failure occurs when a protocol is running, the DNA Engine
will hold the protocol in memory for a minimum of 24 hours to a maxi-
mum of 7 days, depending on environmental conditions.

When power is restored, the protocol will begin running again at the
point at which it was stopped, and a notice about the power interruption
will be displayed. The notice will identify the step and the cycle that were
running when the power failure occurred, and the block’s temperature
at the time power was restored:

Run: 2-STEP

A/C POWER FAILED
Cycle 1 Step 1
Recovered at 20.2°

Press «Proceed» to remove this screen. The protocol’'s runtime screen
will immediately be displayed.
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Using the Instant Incubation Feature

5.10

The DNA Engine may be converted to a constant-temperature incubator
by pressing «Instant Incubate». A screen allowing use of the heated lid
will be displayed:

INCUBATE:

Use heated 1id?
Yes _No

Use the «Select» keys to enable or disable the heated lid, then press «Pro-
ceed». A screen allowing entry of the incubation temperature will be
displayed.

INCUBATE:
1= 2@.%° for ever
Use heated 1id?
Yes _No

Use the keypad to enter any incubation temperature from -5.0°C to
105.0°C, then press «Proceed». The DNA Engine will incubate the sample
at the specified temperature until «Cancel» or «Stop» is pressed.

When the sample block reaches the incubation temperature, a timer be-
gins running in the lower right-hand corner of the screen. To stop and
start the timer, press «Pause». |

v Tip: The Pause feature is useful if you need to temporarily remove
samples that must be incubated for a precise period of time.
Pausing the timer while samples are not in the block allows
you to track the exact duration of their incubation.
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The Elements of a Program

é-2

DNA Engine programs consist of a series of steps encoding a protocol.
These steps are run using one of three possible temperature control meth-
ods: calculated control, block control, and probe control.

Programs may contain five types of steps. Two of the steps are manda-
tory, and two are optional:

1.

N

Temperature step (mandatory): Sets a temperature for the block and
the length of time it is held at that temperature. The DNA Engine
brings the block to this temperature at its maximum rate of heating
or cooling, unless modifying instructions are added to the program.
(The maximum rate of heating and cooling is up to 3°C/sec for all
single- and dual-block Alpha units; 1.2°C/ sec for the Slide Chambers
Alpha unit.)

Gradient step (optional): allows you to program a temperature gra-
dient across the sample block. The range of any single gradient can
be as great as 24°C from left to right. The maximum programmable

temperature is 105°C; the minimum programmable temperature is
30°C.

Ramp step (optional): Sets a slower-than-maximum rate of heating
or cooling,.

GoTo step (optional): Causes the program to cycle back to an earlier
step for a specified number of times (up to 9,999 times).

End step (mandatory): Instructs the DNA Engine to shut down its
heat pump because the program is complete.

Additional instructions, termed “options,” can be added to certain pro-
gram steps to modify their effects:

1.

I

Increment: Modifies a temperature step to allow a progressive increase
or decrease of temperature (0.1°-10.0°C per cycle) each time the step is
executed in a cycle. This is useful in “touchdown” programs, when the
annealing temperature of an oligonucleotide is not known.

Extend: Modifies a temperature step to allow progressive lengthen-
ing or shortening of a temperature step hold (by 1-60 sec/cycle) each
time a step is executed in a cycle. This is useful for accommodating
an enzyme with diminishing activity.

Beep: Modifies a temperature step or ramp step to make the machine
beep when the target temperature is reached.



Creating Programs Wl

Designing a New Program

Translating a Protocol inte a Program

Until you are completely familiar with programming the DNA Engine,
you may find it helpful to first translate the protocol into DNA Engine
program steps and options on paper. Write down the protocol to be pro-
grammed, one step per line. Then write the type of program step that
goes with the protocol steps, at the end of each line. If a protocol step
involves an option as well as a program step, write both names down on
the same line. Finally, write the End step at the bottom of the list; pro-
grams will not run without this step. Number the lines 1 through N, where
N is the final, End line.

Using the GoTo Step to Write Short Programs

The GoTo step allows programs of many repetitious steps to be short-
ened to just a few lines. When the program encounters a GoTo step, it
returns to a specified step, repeats that step, and repeats all steps that
follow, back to the GoTo step. When the program has returned, or cycled,
back to the step a specified number of times, the program moves on to
the step that follows the GoTo step.

For example, consider a basic cycle sequencing protocol consisting of 30
repeats of a denaturation, and an annealing / extension step. Rather than
listing all 60 steps, use a GoTo step to design a short, easy-to-enter pro-

gram:

Raw program: DNA Engine program:

1. 92° for 30 sec 1. 92° for 30 sec

2. 60° for 3 min 2. 60° for 3 min

3. 92° for 30 sec 3. GoTo step 1, 29 times (i.e.,
4. 60° for 3 min cycleback to step 1 and repeat
5. 92° for 30 sec steps 1 and 2, 29 times )

6. 60° for 3 min 5. End

7. 927 for 30 sec

[continues for total of 60 lines)

Choosing a Temperature Control Method

The DNA Engine can control block temperature in three possible ways,
each of which has different implications for the speed and accuracy of
sample heating:

* Calculated control: The DNA Engine adjusts the block’s tempera-
ture to maintain samples of a specific volume in a specific vessel type
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at programmed temperatures. This includes optimized “overshoots”
of the block by a few degrees for a few seconds, which bring the
samples to the programmed temperatures.

* Block control: The DNA Engine adjusts the block’s temperature to
maintain the block at programmed temperatures, independent of
sample temperature.

* Probe control: The DNA Engine adjusts the block’s temperature to
maintain the probe at programmed temperatures.

Calculated Conirol

Calculated control is the method of choice for most types of programs,
yielding the most consistent, most reliable, and fastest programs. When
using calculated control, the DNA Engine maintains a running estimate
of sample temperatures based on the block’s thermal profile, the rate of
heat transfer through the sample tube or slide, and the sample volume or
mass (this information about the samples is provided when a program is
run; see “Setting Up the Temperature Control Method,” chapter 5). Since
this estimate is based on known quantities and the laws of thermody-
namics, sample temperatures are controlled much more accurately than
with block or probe control.

Hold times can be shortened significantly when protocols are run under
calculated control. In addition to the simple convenience of spending less
time running reactions, shorter protocols also help preserve enzyme activ-
ity and minimize false priming. Cycling denaturations run under calculated
control are usually optimal at 5 seconds. Annealing/extension steps can
also be shortened, but the periods for these will be reaction specific.

Calculated control provides for shorter protocols in three ways:

1. Brief and precise block temperature overshoots are used to bring
samples to temperature rapidly.

3

Incubation periods are timed according to how long the samples, not
the block, reside at the target temperature.

3. The machine automatically compensates for vessel type and reaction
volume.

Block Control

Block control provides less accurate control of sample temperatures than
calculated control provides. Under block control, the temperature of
samples always lags behind the temperature of the block. The length of
the time lag depends on the vessel type and sample volume but typically
is between 10 and 30 seconds. Block control is chiefly used to run proto-
cols developed for other thermal cyclers that use block control.
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Probe Control

Probe control is available for unusual circumstances that may require it.
Ordinarily, though, it should be used with caution. While the DNA En-
gine will have no trouble heating the probe to the target temperature, if
the probe is seated or prepared differently from the sample tubes, actual
sample temperatures can vary widely from the probe’s temperature. Probe
control also cannot be used with microplates or slides.

Modifying Block- and Probe -Conirol Programs for Calculated Control

Probe-control programs will generally run well under calculated control,
with no modification other than changing the method of temperature
control. Block-control programs can be changed to calculated control by
subtracting at least 15-20 seconds from each temperature step. Some
empirical testing may be required to adjust modified programs for opti-
mum performance.

Modifying a Program Designed for a Different Machine

The ramp programming step can be used to adapt programs designed
for thermal cyclers with slower maximum heating and cooling rates than
the DNA Engine. In addition, a given protocol will occasionally work
better with a slower rate of temperature change; the ramp step can be
used to optimize the program for such a protocol.

Entering a New Program

Programming the DNA Engine moves through five steps:
1. Initiating the program

2. Naming the program

3. Choosing a temperature control method

4. Entering the program’s steps

5. Entering the End step

Each step involves entering values from the keyboard or making
selections from a menu. Programs may be edited as they are being
entered.

Programs are automatically saved when the End step is entered. They
are stored in the <MAIN> folder unless folders have been created for
them.
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Initiating the Program

To initiate a new program, select Enfer from the Main Menu, then press
«Proceed». A naming screen will be displayed:

Enter:

Name: A

Naming the Program

Name the program an eight-character word consisting of any combina-
tion of letters (Roman and Greek), numbers, punctuation marks, or Japa-
nese Katakana.

Press the right «Select» key to seroll forward and the left «Select» key to
scroll backward through the alphabets and characters available, which are
presented in this order: Roman alphabet, selected Greek letters, punctua-
tion marks, numbers. To access the Japanese Katakana syllabary, press the «.»
key. A second press of «.» returns the machine to Western characters.

When the character needed is displayed next to Name, press «Proceed».
The character will be accepted, and the cursor will move one space to the
right. Numbers and dashes may also be inserted by pressing the corre-
sponding keys on the keypad.

When the name is complete, press «Proceed» once to accept the last char-
acter and again to accept the whole name. If the name is already in use
for a program, a screen saying “Name In Use” will be displayed. If this
happens, press «Proceed», then enter a different name.

Choosing a Temperature Conirol Method

When the name has been entered (“CUSTOM1" is used in the following
and all succeeding examples), a screen requesting selection of a tempera-
ture control method will be displayed:

Enter: CUSTOM1
Control method:
Block Praobe
_CALCULATED

Select a control method, then press «Proceeds.

Entering the Program’s Steps

When a temperature control method has been chosen, the Enter Menu
will be displayed:
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Enter: CUSTOM1

Step 1= _TEMP
Gradient
Ramp End

Use this menu to enter each step of the program:
* Temp enters a temperature step.
¢ Gradient enters a Gradient step.

¢ GoTo enters a GoTo step (note: since a protocol can not begin with a
GoTo step,GoTo does not appear on the initial Enter Menu).

* Ramp enters a ramp step.

* End enters the End step.

Entering a Temperature Step

To enter a temperature step, select Tenip from the Enter Menu, then press
«Proceed». The first Temp screen will be displayed:

Enter: CUSTOM1
1:

Temp "C:

The second line of this screen shows the number of the step being
programmed (1 is used in the example above). The last line of the
screen allows a target temperature (in degrees Celsius) to be entered
for the step.

Use the keyboard to enter any number between —5.0 and 105.0 as the
target temperature (92.0 is used in the example below):

Enter: CUSTOM1
1=

Temp "C: 92.8

Press «Proceed». The target temperature will move to the second line of
the screen, and a line allowing a hold time to be entered for the step will
be displayed:

Enter: CUSTOM1
1= 92.0°

Time:

Enter the hold time for the step (30 seconds is used in the example be-
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low):
Enter: CUSTOM1
1= 92.6°
Time: 36

Note: If a hold time of zero (0) is entered, the DNA Engine will hold the
block at the target temperature indefinitely.

Press «Proceed». The hold time will move to the second line of the screen,
and a confirmation menu will be displayed on the last line:

Enter: CUSTOML1
iI= 92.8° for @:30

QK? _YES No Option

Select one of the displayed choices, then press «Proceed»:

* Yes accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

* No allows reentry of the target temperature and hold time for the
step.

* Option displays the Options Menu (see “Modifying a Program Step
with the Options,” p. 6-11).

v Tip: Avoid programming many short holds of only a few seconds
each. This can overheat the block, causing the “HS Overheat-
ing” or “P5 Overheating” error messages to be displayed and
triggering automatic Alpha unit shutdowns if the block exceeds
its maximum allowable temperature.

Entering a Gradient Step

When you reach the step at which a gradient is desired, select Gradient
from the Enter Menu and then press the «Proceed» key. For the purpose
of this example the step in which the gradient will be entered shall be
Step 2:

Enter: CUSTOM1

Step 2= Temp Goto
_GRADIENT
Ramp End
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The gradient screen will appear:

Enter: CUSTOM1

Lower Temp °C:

Enter the lower limit temperature (for the purposes of this example, 50°),
then press «Proceed». The upper temperature screen will appear:

Enter: CUSTOM1
5@.0°

Upper Temp °C:

Enter the upper temperature (for the purposes of this example, 70°), then
press «Proceed». (Use integers only; decimals are not accepted).

The next screen requires you to enter a hold time for the temperature
gradient step:

Enter: CUSTOM1
2= 58.8° to 78.0@°

Time:

Enter the hold time in the form of min:sec. Press «Proceed». A confirma-
tion screen will appear:

Enter: CUSTOM1

2= 50.@° to 70.@°
for 9:30
OK? Yes No Option

Select “Yes” to enter the step into memory and proceed to the next step;
select “No” to reject or edit the current step. To preview, select Option,
then Preview. Preview gives the predicted temperatures for each of the
wells along the sample block’s long axis. (The lines do not all appear in
the display; use the «Select» keys to scroll up or down.)

Gradient Preview:

Column 1- 52.@° left
Column 2— 51.8°
Column 3- 53.6°
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Editing a gradient step

To edit a gradient step, select Edit from the Main Menu. The program
will be displayed as follows:

List: CUSTOM1
1= 92.8° for 0:20

2= 5@.0° to 70.@°
for @:30

Use the «Select» kéys to scroll to the step you want to edit.

Reviewing o gradient program

After the protocol has been run, the Program Complete screen will be dis-
played. Press the «Proceed» key, and the next screen will display a re-
view of the gradient well temperatures:

Grodient Review:

Column 1- 50.8° left
Column 2- 5@.5°

Column 3- 51.5°
Column 4- 53.7°
Column 5- 55.5°
Column o- 58.4°
Column 7- 61.8°
Column 8- 6&64.6°
Column 9- 66.8°
Column 18- ©8.4°
Column 11- &9.6°
Column 12- 7@.@°right

Scroll up and down the screen using the «Select» keys. When scrolling
the “Gradient Review” line will be held constant while the lower 3 lines
can be manipulated up or down. The temperatures displayed will be for
each of the twelve wells along the long-axis of the sample block. These
temperatures will be predicted from an algorithm as a steady-state tem-
perature of the block and the sample. You may then return to the main
menu by pressing the «Proceed» key.

Using the gradient calculator

The gradient calculator predicts, for a given gradient, the temperatures
for each of the twelve wells along the long-axis of the sample block. These
temperatures will be predicted from an algorithm as a steady-state tem-
perature of the block and the sample. To use the gradient calculator,
select the List command from the main menu and then press the «Pro-
ceed» key. You will see a List screem:

1



Creating Programs Il

List:

Progra
_GRADI

ms
ENT CALCULATOR

Select Gradient Calculator and press the «Proceed» key :

Lower Temp °C:
Upper Temp °C:

50.0°
70.0°

Enter lower limit temperature of the gradient using the number keys

and then press the «Proceed» key. Enter the upper temperature for the

gradient using the number keys and «Proceed» key. You may enter inte-

gers without decimal points. The following screen will be displayed:
Gradient Calculator:

Column
Column
Column
Column
Column
Calumn
Column
Column
Column
Column
Column
Column

1- 50
2- 50.
3- 51,
4- 53.
5- 55,
6- 58
/- 61,
B- o64.
8- 66.
10- ©8
11- 69.
12- 7@.

.@° left

5::
Sc
29
5::

A0

8(:
60
8::

.40

Gc
@° right

You may scroll up and down the screen using the «Select» keys. When
scrolling, the “Gradient Calculator” line will be held constant while the
lower 3 lines can be manipulated up or down.
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Entering a Ramp Step

To enter a ramp step, select Ramyp from the Enter Menu. The first Ramp
screen will be displayed:

Enter: CUSTOM1
3:
Rate "C / s: _

The second line of this screen shows the number of the step being pro-
grammed (3 is used in the example above). The last line of the screen
allows a ramp rate (in degrees Celsius per second) to be entered for the
step.

Use the keyboard to enter any rate up to 2.5°C/sec (1°C/secis used in the
example below):

Enter: CUSTOM1
3=

Rate "C / s: 1

Note: If a ramp rate faster than the Alpha unit's maximum rate of heat-
ing and cooling is entered, the maximum rate will be used.

Press «Proceed». The ramp rate will move to the second line of the screen,
and a line allowing entry of a finish temperature for the ramp step will
be displayed:

Enter: CUSTOM1
3= 2.0°/s

Finish temp: -

Enter the finish temperature for the ramp step (69°C is used in the ex-
ample below):

Enter: CUSTOML
3= 2.@'/_5

Finish temp: 69

Press «Proceed». The finish temperature will be moved to the second line of
the screen, and a confirmation menu will be displayed on the last line:
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Enter: CUSTOM1
3=2.8"/s to 69.0°

OK? _YES No Option

Select one of the displayed choices, then press «Proceed»:

* Yes accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

* No allows reentry of the ramp rate and finish temperature.

* Option displays the Options Menu (see “Modifying a Program Step
with the Options,” p. 6-11).

v Tip: A ramp step will not hold the block at its finish tempera-
ture. Instead, as soon as finish temperature is reached, the
next step of the program will immediately be executed. To
hold the block for some period of time at a ramp step’s fin-
ish temperature, make sure a temperature step immediately
follows the ramp step, and program the hold at the finish
temperature into this step.

Entering a GoTo Step

To enter a GoTo step, select GoTo from the Enter Menu. The first GoTo
screen will be displayed:

Enter: CUSTOM1
5=GoTo

GoTo step: _

The second line of this screen shows the number of the step being pro-
grammed (5 is used in the example above). The last line of the screen
allows entry of the number of the step the program should cycle back to.

Enter the number of the step the program should cycle back to (1 is used
in the example below):

Enter: CUSTOML
5=GoTo
GoTo step: 1
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Press «Proceed». The step number will move to the second line of the
screen, and a line allowing an additional number of cycles to be entered
will be displayed:

Enter: CUSTOM1
3=6oTo 1

Addtnl cycles:

Enter the additional number of times the program should cycle back to
the step (3 is used in the example below):

Enter: CUSTOM1
3=GoTo 1

Addtnl cycles: 3

Press «Proceed». The number of additional cycles will move to the sec-

ond line of the screen, and a confirmation menu will be displayed on the
last line:

Enter: CUSTOM1
3= GoTo 1, 3 times

10K? _YES No

Select one of the displayed choices, then press «Proceed»:

* Yes accepts the step and displays the Enter Menu again. Use the En-
ter Menu to enter the next step in the program.

* Noallows reentry of the step number and number of additional cycles.

Entering the End Step

To enter the End step, select End from the Enter Menu. The single End
screen will be displayed:

Enter: CUSTCOM1
4=End
OK? _YES No

This screen automatically enters “End” on on the second line of ’_d1e screen,
next to a step number, and displays a confirmation menu for the step on
the last line of the screen.
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Select one of the displayed choices, then press «Proceed»:
* Yes accepts the step, stores the program, and displays the Main Menu.
* No displays the Enter Menu so that additional steps can be added.

If you have created custom folders for your programs (see chapter 8),
choosing Yes brings up a screen listing the folders:

Save program in:
<MAIN> <FOLDER1>
<FOLDERZ>

Select the folder you want to store the program in, then press «Proceed». The
program will be stored in the folder, and the Main Menu will be displayed.

Modifying a Program Step with the Options

The Options Menu is accessible from the confirmation menus of tempera-
ture steps and ramp steps. To access the Options Menu, select Option from
the confirmation menu of a temperature or ramp step, then press «Proceed».
The Options Menu will be displayed on the bottom line of the screen:

Enter: CUSTOM1
1= 92.2° for @:30

Option:_TINC Ext Beep

* Inc modifies a temperature step with an increment option. An incre-
ment option allows a progressive increase or decrease of temperature
each time the step is executed in a GoTo cycle.

* Extmodifies a temperature step with an extend option. An extend op-

tion allows a progressive lengthening or shortening of hold times each
time the step is executed in a GoTo cyde.

* Beep modifies a temperature step or a ramp step, causing the ma-
chine to beep when a specified target temperature is reached.

Entering an Increment Option

To enter an increment option, select Inc from the Options Menu for a
temperature step, then press «Proceed». The first Inc screen will be dis-
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played:

Enter: CUSTOML

1= 92.0° for @:30
+

'C / cycle: +

The temperature step being modified appears on the second line of this
screen. The plus sign on the third line means that the screen is set up to
enter a progressive increase in temperature per cycle. Press «—» to switch
to a minus sign, allowing entry of a progressive decrease in temperature.
Press «Cancel» to change back to a plus sign.

Enter the numerical value of the temperature increase or decrease (1.2 is
used in the example below):

Enter: CUSTOM1

1= 92.8° for 0:36
+

C / cycle: + 1.2

Press «Proceed». The Inc value just entered will move to the third line of the
screen, and a confirmation menu will be displayed on the last line:

Enter: CUSTOM1

1= 92.8° for ©:30
+ 1.27 per cycle

OK? _YES No Option

Select one of the displayed choices, then press «Proceed»:

*  Yes accepts the Inc value and displays the Enter Menu again. Use the
Enter Menu to enter the next step in the program.

* No allows reentry of the Inc value.

* Option displays the Options Menu again. Use the Options Menu to
enter another option for the step.

Entering an Extend Option

To enter an extend option, select Ext from the Options Menu of a tem-
perature step, then press «Proceed». The first Ext screen will be dis-
played:

Enter: CUSTOM1

1= 92.8° for 0:3@
+

Sec / cycle: +
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As for Inc, the temperature step being modified appears on the second
line of this screen. The plus sign on the third line means that the screen is
set up to enter progressive lengthening of hold time. Press «—» to switch
to a minus sign, allowing entry of a progressive shortening of hold time.
Press «Cancel» to change back to a plus sign.

Enter the numerical value of the increase or decrease in hold time (1.0 is
used in the example below):

Enter: CUSTOM1

1= 22.0° for @:30
+

Sec / cycle: + 1

Press «Proceed». The Ext value just entered will move to the third
line of the screen, and a confirmation menu will be displayed on the
last line:

Enter: CUSTOM1

1= 92.0° for @:30
+ 1 sec / cycle

0K? _YES No Option

Select one of the displayed choices, then press «Proceeds:

* Yes accepts the Ext value and displays the Enter Menu again. Use the
Enter Menu to enter the next step in the program.

* No allows reentry of the Ext value.

* Option displays the Options Menu again. Use the Options Menu to
enter another option for the step.

Entering a Beep Option

To enter a beep, select Beep from the Options Menu for a temperature
step or a ramp step, then press «Proceed». The word “Beep” will be dis-
played on the third line of the screen, and a confirmation menu will be
displayed on the last line:

Enter: CUSTOM1

1= 92.9" for ©:30
Beep

0K? _YES No Option

Select one of the displayed choices, then press «Proceeds»:

* Yes accepts the Beep option and displays the Enter Menu again. Use
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the Enter Menu to enter the next step in the progran.
* No cancels the Beep option.

* Option displays the Options Menu again, if a temperature step is
being modified. Use the Options Menu to enter another option for
the step. (Option will not be displayed if a ramp step is being modi-
fied, since Beep is the only option available for ramp steps.)

Revising During Programming

418

To change values in a program you are entering, follow the procedures
described below. This editing method should be used to change just a
few values at a time. To make many changes, or to delete or add entire
steps, use Edit mode (see chapter 7).

To Change the Last Value Entered or Menu Option
Chosen

Press «Cancel». The choice just made will be cancelled, so that another

‘value may be entered or another menu option chosen. Press «Proceed»

after changing a value, so that the program will accept it.

To Change All the Values in the Step Being Entered

Repeatedly press «Cancel». Each time you press the key, the cursor will
move backward through the values for the step, deleting the values as it
moves. When all values for the step have been deleted, enter new val-
ues, or press «Gancel» one more time to display the Enter Menu for the
step. At this point you can change the step to a different type.

To Change Values for Earlier Steps in the Program

Repeatedly press «Cancel» until the Enter Menu for the step you are
working on is displayed. Press «Cancel» one more time to display a list
of all steps entered so far. The list will show the step number and the
values for each step, including any options chosen. The last-entered steps
will be displayed first:

Enter: CUSTOM1

3= 55.8° for 0:30
4= 72.0° for 1:00
5=
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At this point, you can choose to change selected values in program steps,
to add an option, to enter Edit mode, or to delete the entire program.

Press the «Select» keys to scroll through the program. The left «Select»
key moves the cursor backward through the steps, and the right «Se-
lect» key moves it forward.

* Tochange selected values or add an option: To change a value, move
the cursor to it, then press «Cancel». Enter the new value, then press
«Proceed». If you change your mind, press «Cancel» again; the de-
leted value will be restored.

To add an option to a step, move the cursor to the step number, then
press «Proceed». The Edit Menu will be displayed:

Enter: CUSTOM1.

2= 92.@° for 0:40
_EDIT Insert

Step: Option Delete

Select Option, then press «Proceed», and follow the procedure for
adding an option. To abandon the Edit Menu and return to the list of
program steps, press «Gancel».

* To enter Edit mode: Move the cursor to the number of the step you
wish to edit, then press «Proceed». See chapter 7 for information on
entering Edit mode. If you do not wish to enter Edit mode, press «Can-
cel». The screen will return to the list of program steps.

* To delete the program: Position the cursor on any step number and
press «Cancel». A cancellation confirmation screen will be displayed.

Enter: CUSTOM1

Cancel program?
_YES NO

Select Yes, then press «Proceed». The program will be deleted, and
the Main Menu will be displayed.

Deleting a Program

To delete a program after at least one complete step has been entered, see
“Revising During Programming,” (p. 6-14).

To delete a program before one complete step has been entered, repeat-
edly press «Cancel». The cursor will move backward through the step’s
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values, deleting them as it goes. When all values have been deleted, keep
pressing «Cancel» to move backward through Enter mode screens until
the Main Menu reappears, at which point you can begin a new program.

Keeping a Permanent Record of Programs

46-20

Occasionally in the course of repairing a defective DNA Engine, it is
necessary to replace the chip that stores all custom user protocols. To
avoid losing your protocols in such an event, always maintain an up-to-
date record of them. Protocols may be printed out using the List utility
(see chapter 8), stored on a computer using the DNA Engine Driver Soft-
ware, or writtenn down in a notebook.
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Editing a Stored Program

The DNA Engine’s editing tools, available through Edit on the Main Menu,
make it easy to extensively edit stored programs by

Changing individual values in program steps,
Adding new steps,
Deleting steps, and

Adding options to temperature and ramp steps.

Note: The editing tools do not include a renaming function. To re-
name a program, see “Renaming a Program,” chapter 8.

Initiating Editing

To initiate editing, select Edit from the Main Menu, then press «Pro-
ceed». One of two types of screen will be displayed, depending on
whether your programs have been stored in the <MAIN> folder or in
custom folders.

If all programs have been stored in <MAIN>:
The screen will list the contents of <MAIN>:

Edit: <MATIN>

_CusToM1  CuSTOMZ
CUSTOM3  QUIKSTEP
2-STEP 3-STEP

Select the program to be edited, then press «Proceed».

If programs have been stored in custom folders:

The screen will list all the folders residing in the machine:

Edit:
_<MAIN> <FOLDER1>
<FOLDERZ>

Select the folder containing the program, then press «Proceed». Alist

oof all programs in the folder will be displayed. Select the program to

be edited (CUSTOM]1 is used in the following and all succeeding ex-
amples in this chapter), then press «Proceed».

In either instance, after you press «Proceed», the first editing screen will
be displayed (see next section).
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v/ Tip: To retain the original version of a program, copy the program
(see “Copying a Program,” chapter 8), and then edit the copy.

Editing the Program

The first editing screen displays all three temperature control methods.
The program’s current temperature control method is displayed in all-
capital letters:

Edit: CUSTOM1

Control method:
Blocle Probe
_CALCULATED

Select a different temperature control method if desired, then press «Pro-
ceed» The first three lines of the program will be displayed:

Edit: CUSTOM1

1= 92.0° for @:10
2= 63.0° for 1:00
3=GoTo 1, 24 times

Use the «Select» keys to scroll up and down through the program. The
cursor will progressively move to the step number and the individual
values for each step.

To change an individual value in a step, position the cursor on it and
type the new value, then press «Proceed». The new value will be dis-
played on the screen. To cancel a change, press «Cancel». The original
value will be restored.

To add or delete a step, or to modify a step with an option, position the
cursor on the step number, then press «Proceed». The Edit Menu will be
displayed for that step:

Edit: CUSTOM1

2= 63.@8° for 1:00
_EDIT 1Insert

Step: Option Delete

* Editdisplays the previous screen again, but with the cursor positioned
on the first value for the step, so that it may be changed.

* Insert allows a step to be added before the displayed step.
* Delete deletes the displayed step.

* Option allows an option to be added to the displayed step if itis a
temperature or a ramp step.
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Inserting a New Step

To insert a new step, select Insert from the Edit Menu, then press «Pro-
ceed». The Enter Menu will be displayed for the new step (a new step 2
is added in the example below):

Edit: CUSTOM1

Step Z= _TEMP GoTo
Ramp End

Use the Enter Menu to create the new step (see “Entering the Program’s
Steps,” chapter 6). When the step is complete, select Yes from the confir-
mation menu, then press «Proceed». The program being edited will be
displayed again, with the new step appearing among the listed steps.

Deleting a Step

To delete a step, select Delefe from the Edit Menu, then press «Proceed».
The step will immediately be deleted, and the program being edited will
be displayed again, minus the deleted step.

To cancel a deletion, see “Cancelling Editing Changes,” p. 7-5.

Note: Be careful when using Delete. Once a step has been deleted, it
cannot be recovered without abandoning all editing changes that have
been made in the program. This could be inconvenient if the program
has been extensively edited.

Adding an Option

To add an option to a step, select Option from the Edit Menu, then
press «Proceed». The option menu will be displayed for the step. Add
the desired option to the step (see “Modifying a Program Step with
the Options,” chapter 6). When the option is complete, select Yes from
the confirmation menu, then press «Proceed». The steps of the pro-
gram being edited will be displayed again, with the new option ap-
pearing in the list.

Saving an Edited Program

To save an edited program, use the right «Select» key to scroll to the End
step of the program. Position the cursor on the number for the step, then

7-4
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press «Proceed». A line allowing the editing session to be ended will be
displayed on the last line of the screen:

Edit: CUSTOM1
2=End

Step: _END Insert

* End saves the changes and displays the Main Menu. This ends the
editing session.

* TInsertallows another step to be added just before the End step.

Cancelling Editing Changes

To cancel all editing changes made to a program, use the «Select» keys to
move the cursor to any step number, then press «Cancel». A cancellation
confirmation screen will be displayed:

Edit: CUSTOM1

Cancel changes?
_YES No

Select Yes, then press «Proceed». All editing changes will be abandoned,
and the Main Menu will be displayed.
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Locating a Stored Program

File Utilities
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Many of the DN A Engine’s utilities require you to locate a program stored
in the machine. The actions necessary to do this depend on whether your
programs have been stored in the <MAIN> folder or in custom folders.

e If all programs have been stored in <MAIN>:

The screen will list all the programs that <MAIN> contains:

Copy: <MATN>
_CusToM1  CUSTOMZ
QUIKSTEP 2-STEP
3-STEP EXTEND

Select the desired program from this list.
» If programs have been stored in custom folders:

The screen will list all the folders residing in the machine:

Copy:
<MATN> <FOLDER1>
<FOLDERZ2> <FOLDER3>

Select the folder containing the program, then press «Proceed». Alist
of all programs in the folder will be displayed. Select the desired pro-
gram, then press «Proceeds.

Use these utilities, available from the Files Menu, to accomplish the fol-
lowing tasks:

* (reate folders to store programs in
* Assign passwords to folders
* Copy, delete, rename, or move programs

To display the Files Menu, select Files from the Main Menu, then press
«Proceed»:

Files:

_CopY Delete
Move Rename
Folder Secure
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Creating a Folder

The DNA Engine’s memory can hold up to 11 folders, including the
<MAIN= folder. New programs are placed in the <MAIN> folder by de-
fault unless a different folder is specified.

To create a folder, select Folder from the Files Menu, then press «Pro-
ceed». A naming screen will be displayed:

New Folder:

Name: A

Name the folder, using the instructions found under “Naming the Pro-
gram” in chapter 6, then press «Proceed». The name will be assigned to
the new folder, the folder will be stored, and the Main Menu will be dis-
played.

Assigning a Password to a Folder

Protocols in a password-protected folder cannot be edited, renamed, or
deleted, nor can new protocols be placed in the folder without the pass-
word. Users without knowledge of the password can still run, copy, and
view a program.

Note: A password cannot be assigned to the <MAIN> folder.

To assign a password to a folder, select Secure from the Files Menu, then
press «Proceed». A list of all folders in the machine will be displayed.
Select the desired folder (other than <MAIN>), then press «Proceed».
The password assignment screen will be displayed:

Secure: <FOLDER1>

New password:

Valid passwords consist of numbers up to four digits long. For passwords
of three digits or less, press «Proceed» after the password has been en-
tered. Passwords four digits long will be automatically accepted as soon
as typed, and the Main Menu will be displayed.
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Passwords can be changed at any time. Follow the steps described above
to select the desired folder, then press «Proceed». A screen asking for the
old password will be displayed:

Secure: <FOLDER1>

0ld password: _

Enter the old password, then press «Proceed». The password assignment

screen be displayed. Enter the new password, then press «Proceed». The -

new password will be assigned to the folder, and the Main Menu will be
displayed again.

Deleting a Folder

A folder must be empty before it can be deleted. After all programs have
been moved or deleted from the folder, select Delete from the Files Menu,
then press «Proceed». A list of all folders in the machine will be displayed.
Select the folder to be deleted, then press «Proceed». A confirmation screen
will be displayed:

Delete: <FOLDER1>

Delete empty folder?

-YES No

Select Yes, then press «Proceed». The folder will be deleted, and the Main
Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceeds.

Copying a Program

The copy utility copies a program and gives the copy a new name. Cop-
ies can be placed in the original folder or a new one.

To copy a program, select Copy from the Files Menu, then press «Pro-
ceed». Locate the program to be copied (see “Locating a Stored Program,”
p- 8-2), then press «Proceed». If more than one folder of programs is
present in the machine, a screen allowing you to specify the folder the
program will be copied to will be displayed:

Copy CUSTOM1 to:
_<FOLDER1> <FOLDERZ>
<FOLDERZ>
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Select a folder to copy the program to, then press «Proceed». A naming
screen will be displayed:

Copy CUSTOM1 to:

New name: A

Name the copied program (see “Naming the Program,” chapter 6), then
press «Proceed». The program will be copied to the specified folder un-
der the new name, and the Main Menu will be displayed.

Renaming a Program

To rename a prograrri, select Rename from the File Menu, then press «Pro-
ceed». Locate the program to be renamed (see “Locating a Stored Pro-
gram,” p. 8-2), then press «Proceed». A naming screen will be displayed:

Rename: CUSTOM1

New name: A

Name the new program (see “Naming the Program,” chapter 6), then
press «Proceed». The program will be renamed and stored, and the Main
Menu will be displayed.

Moving a Program

To move a program, select Mowve from the Files Menu, then press «Pro-
ceed». Locate the program to be moved (see “Locating a Stored Pro-
gram,” p. 8-2), then press «Proceed». A screen listing all folders will be
displayed. Select the folder the program should be moved to, then press
«Proceed». The program will be moved to the new folder, and the Main
Menu will be displayed.

Deleting a Program

To delete a program, select Delete from the Files Menu, then press «Pro-
ceed». Locate the program to be deleted (see “Locating a Stored Program,”
p. 8-2), then press «Proceed». A confirmation screen will be displayed:

Delete: CUSTOM3

Delete program?
_YES No

8-5



I DNA Engine & DNA Engine Tetrad Operations Manual

List Utilities
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Select Yes, then press «Proceed». The program will be deleted, and the
Main Menu will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Pro-
ceed».

Use these utilities, available under List, to accomplish the following task:

* View and print program steps

Viewing a Program in the LCD Window

To view a program in the LCD window;, select List from the Main Menu,
then press «Proceed». Locate the program to be viewed (see “Locating a
Stored Program,” p. 8-2), then press «Proceed». What happens next de-
pends on whether a printer is connected to the DNA Engine.

e If a printer is connected:

A screen will be displayed asking whether the program should be
sent to the printer:

List: CUSTOM1

Printer output?
Yes _NO

Select No, then press «Proceed». The program will be listed in the
LCD window. The first listed screen will show the program’s control
method. Press «Proceed» to view subsequent screens listing each
program step, including any options. Use the «Select» keys to scroll
up or down through the steps one line at a time. To return to the
Main Menu, press «Cancel» at any time, or press either the right «Se-
lect» key or «Proceed» when the last step appears on the screen.

* If a printer is not connected:

The program will immediately be listed in the LCD window. You will
not be given the option of printing at all.

Note: Listed programs cannot be edited. To edit programs, select Edit
from the Main Menu (see chapter 7).
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Printing a Program

First ensure that the DNA Engine is connected to a printer. If no printer is
connected, you will not be given the option of printing at all. The DNA
Engine’s parallel interface is compatible with most serial and laser printers,
the Epson®LX-810 dot-matrix printer parallel interface, and dot-matrix print-
ers using interfaces similar to the Epson’s. Use a standard DB-25/ Centronics
paraliel interface cable to connect the DNA Engine’s parallel port to the
printer’s parallel port. A null-modem serial cable will usually be required to
connect the DNA Engine’s serial port to a printer’s serial port.

Use the Setup utilities to choose a printer port for the DNA Engine (see
“Choosing a Printer Port,” p. 8-8).

Select List from the Main Menu, then press «Proceed». Locate the program
to be printed (see “Locating a Stored Program,” p. 8-2), then press «Pro-
ceed». The screen asking whether the program should be sent to the
printer will be displayed (see above). Select Yes, then press «Proceed».
The program will be printed.

Use these utilities, available from the Setup Menu, to accomplish the
following tasks:

* Choose a remote port and a printer port
¢ Choose a temperature control method for the Hot Bonnet's heated lid
* Look up the DNA Engine’s software version number

To display the Setup Menu, select Setup from the Main Menu, then press
«Proceed»:

Setup:
_REMOTE Printer
Lid Version

Choosing a Remote Port

To choose either the serial port or the IEEE-488 port, select Remote from
the Setup Menu, then press «Proceed». The port selection screen will be
displayed:

Remote:
Serial  _IEEE-488
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The cursor will be positioned at the port currently in use.

To choose the serial port, select Serial, then press «Proceed». The cursor
will move to Serial, and a line allowing a baud rate to be specified will be
displayed on the last line of the screen:

Printer:
_SERTAL TIEEE-488

Baud: 9680 2490_1200

Select a baud rate, then press «Proceed». The remote port assignment
will change to serial, and the Main Menu will be displayed.

To choose the IEEE-488 port, select IEEE-488, then press «Proceed».
The cursor will move to IEEE-488, and a line allowing the DNA En-
gine to be assigned an IEEE-488 address will be displayed on the last
line of the screen:

Printer:
Serial _TEEE-488

Address (8-32): @

The machine’s current address will be displayed. To change it, enter a
number from 0-30, then press «Proceed». The remote port assign-
ment will change to IEEE-488, the address number will be assigned
to the machine, and the Main Menu will be displayed.

Note: Do not choose 0 for the machine address unless the DNA Engine
will be a controller in a network (see chapter 9).

Choosing a Printer Port

To choose a printer port, select Printer from the Setup Menu, then press
«Proceed». The port selection screen will be displayed:

Printer:
Parallel _SERIAL

Select the desired port, then press «Proceed». If serial was chosen, specify
the printer’s baud rate as for “Choosing a Remote Port” (p. 8-7).
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Choosing a Minimum Block Temperature for the Hot
Bonnet

To set a minimum block temperature below which the Hot Bonnet will
automatically turn off, select Lid from the Setup Menu, then press «Pro-
ceed». The following screen will be displayed:

Lid:
Mode ~MINIMUM

Select «MINIMUM» and press «Proceed». The following screen will be
displayed:

Lid Minimum:

Turn off heated
1id below: 23°C

Use the keypad to enter the temperature, then press «Proceed» to enter
the value and return to the main menu.

Choosing a Temperature Control Mode for the Hot
Bonnet

Two temperature control modes are available for the Hot Bonnet:

* Tracking: Offsets the temperature of the heated inner lid at least a
specified number of degrees Celsius in comparison to the tempera-
ture of the sample block.

* Constant: Keeps the inner lid at a specified temperature ("C).

The DNA Engine is set for the tracking mode at the factory, using an
offset of 5°C, which should be adequate for most reactions. The constant
mode is provided for unusual reactions requiring the inner lid to be hot
at all times. When using the constant mode, specify a lid temperature at
least 10°C higher than any temperature used in the protocol; we suggest
105°C.

To choose a control mode, select Lid from the Setup Menu, then press
«Proceed». The following screen will appear.

Lid:

_MODE Minimum

Select «Mode», then press «Proceed» (to select a minimum block tem-
perature, see “Choosing a Minimum Block Temperature for the Hot Bon-
net,” above).
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The mode currently in use will be selected in the screen; select a different
control mode if desired, then press «Proceed» to enter the mode and re-
turn to the main menu.

If the tracking mode is chosen, a lid offset (up to 45°C above the block,
but not to exceed 110°C) must be specified. A line for this will appear at
the bottom of the screen: “Lid offset °C: 15.” If the constant mode is cho-
ser, a lid target temperature (up to 110°C) must be specified. A line for
this will appear at the bottom of the screen: “Lid target °C: _.” In either
case, enter a number, then press «Proceed». The tracking control mode
will be implemented, and the Main menu will be displayed.

Determining the Software Version Number

At times it is necessary to determine the version number of the software
installed in the DNA Engine (e.g., to report a problem to MJ RESEARCH).
To do this, select Version from the Setup Menu, then press «Proceed».
The current version number will be displayed:

Version: 1.1L

CTRL L EXEC L

USER L COMM L

The top line reports the software version number (1.1L in the example).
The other two lines refer to the four “pages” that the software has been
broken into and their associated versions (L in the example).

MJ ResearcH periodically updates the DNA Engine’s software to incor-
porate new features or allow new Alpha units to be used. Most upgrades
are available free of charge for units under warranty and may be installed
into a DNA Engine electronically from a desktop computer. Contact your
M] ReseARCH sales representative or an authorized distributor for details.
Occasionally upgrades may require a hardware change. These upgrades

require return of the DNA Engine base to MJ ResearcH or an authorized
distributor.
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Overview of Networking

Up to 15 machines consisting of any combination of DNA Engines and
DNA Engine Tetrads may be networked, with or without a computer as
the controller. When networking with a computer, all the machines are
controlled from the computer’s keyboard. When networking without a
computer, a specially designated DNA Engine controls the other machines
in the network. Any combination of single- and dual-block Alpha units
may be loaded into networked machines, and different protocols can be
run independently on them.

Networked machines can help save time for a busy laboratory. For ex-
ample, in a DNA Engine—controlled network, protocols can be entered
into the controlling machine and then be run on all the other machines
connected to the network.

Networking Machines Without a Computer

9-2

Connecting the Machines

Connect DNA Engines and DNA Engine Tetrads via the IEEE-488 port on
the back of each machine (see figs. 2-3 and 12-4), using high-quality cables.
Although several connection configurations are possible, we recommend a
simple daisy chain or star pattern. The DNA Engine’s IEEE-488 interface is
fully compatible with both the [EEE-488.2 and the I[EEE-488.1 standards.

Assigning Address Numbers to Machines

Each machine must have a unique address number, which is assigned from
its control panel. Address numbers cannot be assigned from the controller.

To assign an address number to a machine, select Setup from the Main
Menu, then press «Proceed». The Setup Menu will be displayed:

Setup:
_REMOTE Printer
Lid Version

Select Renwote, then press «Proceed». A screen allowing choice of a port
will be displayed:

Remcte:
_SERTAL TEEE-488
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Select IEEE-488, then press «Proceed». The remote addressing screen will
be displayed:

Remote:
Serial _IEEE-488

Address (0-30): @

Enter an address number for the machine. Set the controller DNA Engine's
address to 0. Give the other machines in the network any number from 1
to 30. Press «Cancel» to delete a number and enter a new one.

Running a Protocol on Networked Machines

To run a protocol on networked machines, use the controller to select a
protocol (see “Choosing a Stored Protocol to Run,” chapter 5), then press
«Proceed». The network screen for the controller will be displayed:

Run: 2-5TEP on *

Block: Local (96V)

The protocol will be identified on the top line (2-STEP in the example above).
The single asterisk in the upper right-hand corner indicates that a single-
block Alpha unit is loaded into the controller. “Local” indicates that this is
the controller’s network screen, and “96V* indicates the type of Alpha unit
loaded into the controller.

If a dual-block Alpha unit is loaded into the controller, press «Proceed»
until the letter designating the desired block is displayed after the aster-
isk in the upper right-hand corner of the screen. The letter A designates
the right-hand block, and the letter B the left-hand one (e.g., *A, *B).

To run the protocol on the controller’s block, press «Proceed». One or
more screens for setting up the protocol’s temperature control method
will be displayed (see “Running a Protocol,” chapter 5). When these
screens have been worked through, the protocol will begin running.

To run the protocol on a different machine’s block, press «Block» until
the screen identifies the desired block (22 in the example below):

Run: 2-STEP on 22

Block: Remote 6@V
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The machine’s address number will be identified in the upper right-hand
corner of the screen. “Remote” indicates that this is the network screen
for a slave unit, and “60V” indicates the type of Alpha unit that has been
selected. The status light for the selected block will flash on the control
panel of the machine holding the block.

If the right or left block of a dual-block Alpha unit has been selected, an A
or a B will appear after the address number (e.g., 7-3A for the right-hand
block in a dual-block Alpha unit loaded into quadrant 3 of a DNA Engine
Tetrad at address 7. See figure 12-1 for a diagram of the layout of quad-
rants in the Tetrad™ cycler).

Press «Cancel» at any time to abandon the selection process and display
the Main Menu again.

When the desired block is identified in the LCD window, press «Proceed».
When you have worked through the screens that set up the protocol’s tem-
perature control method, the protocol will begin running.

The protocol’s runtime screen will appear on the controller’s LCD win-
dow. The LCD window of the machine holding the active block will con-
tinue to show whatever screen it was displaying before the protocol be-
gan running.

Press «Block» to display the Main Menu on the controller again. Repeat
the procedure to run protocols on other networked blocks. Press «Block»
on the controller to progressively display the runtime screens of all net-
worked blocks that are running protocols.

While protocols are running, other DNA Engine functions (Edit, Enter,
Files, etc.) can be accessed on any individual machine in the network,
from that machine’s front panel.

Networking Machines with a Computer

9-4

Networked machines may be conveniently controlled by a computer us-
ing DNA Engine Driver software, which allows you to

* Read and run protocols on any networked machine
* Monitor block temperatures on a real-time graphical display

« Save runtime data to the hard drive for later viewing in spreadsheet
or graphical format

* Verify results and keep records of runs

Contact MJ ResearcH or an authorized distributor if you do not already
have a copy of this software. A complete manual is provided with the
software. Also available from M] ResearcH is a list of ASCII commands
used to communicate with DNA Engines and DNA Engine Tetrads, which

T
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may be used to write your own driver software.

A computer-controlled network can be connected via IEEE-488 cables or
R5-232 (serial) cables. In either case, the computer acts as the controller
of the network and uses the driver software to communicate with the
networked machines.

Creating a Computer-Controlled IEEE-488 Network

To connect DNA Engines and DNA Engine Tetrads in a computer-con-
trolled IEEE-488 network, the computer must be equipped with an I[EEE-
488 (GPIB) interface card (contact National Instruments, MJ REsearcH, or
an authorized distributor for information about purchasing this card).
Connect the machines and assign addresses as described under “Net-
working Machines Without a Computer” (p. 9-2). Make sure that none of
the networked machines have been assigned 1IEEE-488 address 0, as this
will cause communication problems with the computer. Install the MJ
ResearcH DNA Engine Driver software on the computer, and use it to
control the network.

Creating a Computer-Controlled R5-232 Network

In a computer-controlled R5-232 (serial) network, each machine in the
network is connected directly to the controlling computer via a serial
port. The number of machines that can be included in such a network
thus depends on the number of serial ports available on the controlling
computer. Use high-quality serial cables to connect the serial port on each
machine (see figs. 2-3 and 12-4) to a serial port on the computer. Use the
Setup utilities to configure each machine for serial communications (see
“Choosing a Remote Port,” chapter 8, and select the serial port and the
9600 baud rate). Install the MJ ResearcH DN A Engine Driver software on
the computer and use it to control the network.
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Cleaning the DNA Engine

102

Cleaning the Chassis and Block

Clean the outside of the DNA Engine and Alpha unit with a damp, soft
cloth or tissue whenever something has been spilled on it or the chassis
is dusty. A mild soap solution may be used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or a
1:100 dilution of bleach in water (see the Slide Chmmbers Afpha Unit Opera-
tions Manual for instructions on cleaning the Slide Chambers’ slide slots).
If using bleach, swab wells with water afterward to remove all traces of
bleach. Clean spilled liquids out of the block as soon as possible; dried
fluids can be difficult to remove. Do not clean the block with caustic or
strongly alkaline solutions (e.g., strong soaps, ammonia, bleach at a higher
concentration than specified above). These will damage the block’s pro-
tective anodized coating, possibly causing electrical shorting.

If you use oil in the block (a practice not recommended by MJ ResearcH;
see “Using Oil to Thermally Couple Sample Vessels to the Block,” chap-
ter 4), clean the wells whenever the oil has become discolored or contains
particulate matter. Use a swab to determine whether cleaning is needed.
Clean the block with 95% ethanol as described above. Oil buildup must
be prevented. Old oil harbors dirt, which interferes with vessel seating
and diminishes thermal coupling of sample vessels to the block.

A Caution: Do not pour any cleaning solution into the block’s wells

and then heat the block, in an attempt to clean it. Severe
damage to the block, the heated lid, and the chassis will
result.

Cleaning the Air Vents

Clean the air intake and exhaust vents with a soft-bristle brush, a damp
cloth, or a vacuum cleaner whenever dust is visible in them. The air in-
take vents are located on the bottom, lower front edge, and back of the
machine; the air exhaust vents are located on both sides (see figs. 2-1, 2-3,
and 2-4). If these vents become clogged with dust and debris, airflow to the
Alpha unit’s heat sink is hampered, causing performance problems re-
lated to overheating. The air intake vents are particularly likely to collect
dust since their holes are much smaller than those of the air exhaust vents.

v Tip:  To prevent problems with overheating, institute a regular pro-
gram of checking for dust buildup, particularly for robotics
installations.
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Cleaning Radioactive or Biohazardous Materials Out
of the Block

When cleaning machines that have been running radioactive or biohaz-
ardous reactions, consult your institution’s radiation safety officer or
biosafety officer regarding cleaning methods, monitoring, and dispos-
ing of contaminated materials.

Changing the Fuses

The circuits in the DNA Engine are protected by two fuses (6.3A fast-
acting, 5 x 20mm). When a fuse blows, the DNA Engine immediately
shuts down and cannot be turned back on. The machine records the event
as a power loss, so if a protocol is running when a fuse blows, the ma-
chine will resume the run when the fuse is replaced and power restored
(see “Resuming a Protocol after a Power Outage,” chapter 5).

A Warning: The DNA Engine incorporates neutral fusing, which means
that live power may still be available inside the unit even
when a fuse has blown or been removed. Never open the
DNA Engine base. You could receive a serious electrical
shock. Opening the base will also void your warranty .

1. Disconnect the power cord from the back of the instrument. Move
the power switch to the “0” (off) position.

N

Insert one corner of a small flat-head screwdriver just under the fuse
plug (fig. 10-1A), and gently pry the plug loose. Pull the plug straight
out as far as it will go, then push it downward to expose the fuses
(fig. 10-2B).

3. Remove both fuses and replace them with new ones (it is impossible to visu-
ally determine which fuse is blown). You may also test the fuses with an
ohmmeter to determine which is defective and replace just that one.

4. Gently press the fuse cover back in place, and reconnect the power cord.

Figure 10-1 A, How to pull out the fuse plug. B, Location of the fuses in the opened plug.

F |
v plLg Fuse

Fuse plug

Serewdriver
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Error Messages

Note: The DNA Engine/ Tetrad software is highly sensitive with re-
spect to block and heat-sink errors. When such errors messages oceur,
try restarting the protocol. If the message fails to reappear, proceed as

usual.
‘Error Message CauseandResult Action
A/C Power Failed, Displayed when a machine run-  No action is necessary. Protocol
Cycle XXX Step X, ning a protocol has been turned resumes running when power

Recovered at XX.X° off, either intentionally or due to a is restored. Results may or may
power outage, and then turmed on  not be affected, depending on
again. whether power failed in an ear-

ly or a late cycle, and whether
the power was restored before
the sample cooled excesswely

BlockOverheated, . .:_On machlnes Wlth software ver~

P e TR " Determine machmes software,j
Return for Service.

'_fﬁverszon number (see p.89).If
number is below 1.1M, ccmtacti;._-._ .

'-EEEfM] AESEARCH OT your local dis- -
"tnbutor'to request a software.
i a_versmn upgrade.-

Sensor ma]functlon a]lows base to Alpha unit and/or base needs
heat block over its maximum al-  servicing. Contact MJ RESEARCH
lowable temperature, triggering or your local distributor.

an automatic Alpha unit shut-

down.

':. : Left center or nght temperat-ure e ‘Alpha unit needs servu:mg :
' i ;'1:_;15 not Work- - soon. Contact:MJ R]EEARCI—I or
' _ymur local dlstnbutor

Block Sensor Fault, None of the temperature sensors ~ Alpha unit and/or base needs

Program Terminated  in Alpha unit are working proper- servicing. Contact MJ RESEARCH
ly, so Alpha unit has been shut or your local distributor.
down.



Error Message .

Troubleshooting W

CauseandResult . .Action .

Calc Control, Probe

Grad.ieﬁt Fault,
Service Alpha Soon
Gradient Program,

Heated Lid Faul,
Program Terminated

HS Overheated

L_ngram Srmin; ted_;i_"é.:. _

_--;Runtune error mdlcatmg gradlent : Use96V Alpha module.
.Invahd Alpha Type : is S R

- Runtime error indicatinga - Change to Calc control mode. -
- gradient step'is being progammed B L e
) :under ]?robe Control mode. .

D:splayed at end of run. Inchcates Alpha unit and/or base needs
gradient was not achieved within  servicing. Contact M] Research
20 secs. of block reaching target. or your distributor.

L1d sensor falled durmg preheat Heated lid or base needs servic-
so Alpha unit has been shut down. ing. Contact MJ ResearcH or
your local distributor.

4_Make sure mac:hme gets :

Machine is running a protocol Contact M] ResearcH or your
consisting of many cycles of only a local distributor to discuss
few seconds each. Alpha unit heat protocal.

sink does not have time to dissi-

pate heat generated by rapid cycl-

ing. Eventually its maximum al-

lowable temperature is exceeded,

and Alpha unit is shut down.

HS Overheating,
Check Air Flow

Program Terrnjnated." Program Terminated "

See causes for "HS Overheated, See actions for "HS Overheated,
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Error Message - . Causeand Result ‘. Action

HS Sensor Fault, Alt ~ Alpha unit heat sink sensor is not ~ Alpha unit needs servicing
Control Mode functioning properly, so machine  soon. Contact MJ REsEARCH or
has begun estimating heat sink your local distributor.
temperature based on other tem-
peature sensor readmgs

HS Sensor Fault Left :Same as prevmus _ P Sahieras.p.j:evious_i'_:' -
Tgnored . L ek
HS Sensor Fault Same as previous

Right Ignored

51nterna1 Fan Fault_ - Fan inside base i is s not Workmg, o F

: Alpha umt has been shut down-

Lid Sensor Fault, Heated hd is giving unexpected Alpha unit needs servmmg
Lid Was Disabled temperature readings, so base has  soon. Contact MJ ResearcH or
turned it off. Protocols can still be  your local distributor.
run, but reactions may fail be-
cause of condensation in vessels.

'3 Thermoelectr . umts in Al":ha"umt

No Memory - Delete unused protocols and

Available! filled. folders from memory. Reduce
size of stored programs by
using GoTo and the Inc and Ext

optlons (see chapter 6)

Probe Sensor Faul

temperat'ure control method to |
____calculated control e

11-4



Error Message

" Cause and Result

Troubleshooting Il

“Action

PS Overheated, :
Program Terminated

- Machineis not getting enough air,

or air being taken in is warmer
than 31° C. ' : :

Machine is running a protocol
consisting of many cycles of only
a few seconds each. Alpha unit
heat sink does not have time to
dissipate heat generated by rapid
cycling. Eventually its maximum
allowable temperature is exceed-

ed and Alpha unit is shut down

' ;d1str1butor

‘Make sure that machine is

getting enough air and that.

- temperature: of air being taken
T inis 317 C or cooler (see P '3-3).
. Correct any air supply =~ :

- problems and run ‘protocol :
- again. If error message per51sts
- base may 1 need serv:lcmg -Con-

Contact M] RESEARCH or your
local distributor to discuss
protocol.

;gChéck Axr ; low -

S Sensor Fault
Temp Ignored

Slow Lid Cycling,
Service Alpha Soon

Unit Failure/
Unit X Failure
{Tetrad)

Power supply sensor is not

working properly. Protocols can
still be run, but machine shouid
be serviced soon too repair sensor.

Alpha unit hd has not reached
target temperature within expect-
ed time. Unit will begin beeping
and will continue to beep until
target temperature is reached, pro-
tocol is manually progressed to its
next step (see p. 5-8), or protocol
run is halted.

The self-test has failed because of
a problem with the base or the
Alpha unit.

Base needs ser\ncmg Contact
M] ResearcH or your local
distributor.

Alpha unit lid needs servicing
soon. Contact M] RESEARCH or
your local distributor.

Contact MJ RESEARCH or your
local distributor.

11-5
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Problems Related to Protocols

Following is a general description of some common problems related to
the protocols and reaction components in sequencing and amplification
applications. For a more detailed discussion of protocols and reactions,
see Current Protocols in Molecular Biology (F. Ausubel et al., eds., John Wiley
& Sons), specifically chapters 7 (DNA sequencing), 14 {in-situ hybridiza-
tion and immunology), and 15 (polymerase chain reaction).

ErorMessage  CauseandResut ~ ‘Action

Reaction is working  "Primer-dimer"” material often If obtaining appropriate reac-
but broad low mole-  produces a broad band in the tion product/s, no need to
cular weight band is ~ <100bp region of gels. change anything.

seen in gels.

- '{:;Mmumze pnmer—dlmer

Reoptimize magnesium concen-
tration and annealing temper-
ature to maximize desired pro-
duct and minimize "primer-
dimers.”

,_Reactlon workmg : Program 5 ho" Etart 1nt0;“ 1e _

-unexpected extra
;:products or smear S,
-'seen o

Reactlon component concentratlon Check concentratons of compo-
too high or too low. nents. May need to reoptimize
mag,nesmm concentration.

:temperature

Protocol contains a wrong value.  Use List utlhty to check proto—
col's temperature control
method, temperatures, and
times.

’T‘emplate 0 £ sufficier - i Check_ Extrachon'and punﬁ_

Multiple templates or host DNA Check nuclem amd preparahons
in sequencing reactions. by gel electrophoresis.



Troubleshooting M

Problem B Cause . . : _Action :
No reaction products  Wrong protocol used. Re-run reaction using correct
obtained. protocol

o ‘Protocol contams a wrong value. '_3Use List utlhty to check proto- .
e P . col's temperatire control meth— i
“od, tempera’tures, and times

Reaction component omitted from Check reaction assembly proto—
mixture. col, ensuring that mixture con-
tains appropriate components

in correct concentrations.

ion temperature too

Annealing temperature too high ~ Check for appropriate anneal-

for primers. ing temperatures of primers,
using available computer pro-
grams or empirical testing.

Probe failed, causing machine to - Check screen for probe fallure

run protocol under calculated error message. Probe may need
control. servicing or replacing. Call M]
ResearcH or your local

distributor.

Reaction mix contains an inhibitor "Spike" a complete reaction mix
(e.g., heme from blood). with a control template and
primer set.
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Problems Relaied to Environmental Conditions,
Setup, and Maintenance

Problem- . . : Cause . . - Co Action

Frequent shutdowns  Machine is not receiving enough ~ Make sure air intake vents are
due to overheating. air. not obstructed by dust, debris,
Frequent "Slow Block or paper. Remove light collec-
Cydling," "HS tons of dust and debris with
Overheat," and "HS damp cloth. Vacuum out heavy
Overheating” error collections. Remove any papers
messages. placed under the machine. Posi-

tion machine at least 10cm from
vertical surfaces.

:E;Check temperature of air enter— :
— -'}mg air mta_ke vents, fo]lowmg

C Air ﬂowmg mto mtake vents 15

Dust and debris clog- qulure to regu_larly check for Remove light collections with

ging up air intake buildup. damp cloth. Vacuum out heavy
vents. collections.
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Meet the DNA Engine Tetrad® Thermal Cycler

Specifications

122

The DNA Engine Tetrad thermal cycler harnesses four DNA Engine® cy-
clers in a single compact machine. Four Alpha™ units of any type can be
loaded into the DNA Engine Tetrad base, one unit into each “quadrant”
of the base. The same factory-installed and custom protocols can be run
on the DN A Engine Tetrad as on the DNA Engine. Programs can be run
independently on any one Alpha unit or simultaneously on all of them.

The DNA Engine Tetrad’s control panel Figure 12-1 Layout of quadrants.
is nearly identical to that of the DNA En-
gine. Additional features include a Back of Tetrad

«Power» key and an array of lights indi- il T
cating the selection status of the blocks in 5 g
the base’s quadrants. There isan Aand a al 2A 1IN bl
B light for each quadrant since each Al- — )
pha unit can contain up to two blocks. The _g 18 A g_
arrangement of the status indicator lights OE 1A 4B |2
matches the arrangement of the quadrants ®

in the base when the DNA Engine Tetrad Front of Tetrad
is viewed from above (fig. 12-1).

The DNA Engine Tetrad’s power supply has been placed in a separate
housing that is attached by cables to the base, which keeps the base com-
pact and makes it easier to use in robotics installations. The power sup-
ply uses MOSFET transistors to efficiently convert AC input power into
the high-current, low-voltage DC power that the Tetrad requires (see ap-
pendix D for a short explanation of this technology).

Up to 15 DNA Engine Tetrads and DNA Engines can be networked together,
in any combination, but a DNA Engine or a computer must serve as the
controller unit for the network. Networked DNA Engine Tetrads operate
like networked DNA Engines, with a few minor exceptions (explained be-
low). The Moto Alpha remote-controlied heated lid may also be used with
networked DNA Engine Tetrads if the controller is a computer.

The DNA Engine Tetrad's specifications are identical to those of the DNA
Engine except for weight and size (see chapter 2).
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Layout

Front View
(Figure 12-2)

Dual-block Alpha unit

Power supply
air intake vent

. Tetrad™ base
Front air exhaust vents

Control panel

Control Panel
(Figure 12-3).

Instant
Block status  incubation
lights key LCD display Cancel key Power light

|
| st s |

|

o o W DNA Engine Tetrad @ @ @ @ @ M) Rstipc

8 8 ﬁ:) Pioceed @ @ @ Pali lg[—ZZISc r ©
" incazy ier Tharmal Cyeler

slimtng v {nding " @ Seleat ) @ @ @ @ @

CAUIOM:Sampde Elndks may ba very leg |
An[mlms:tmylmpmm e e hfisly | N i

! S | !
Block key Left and right  Proceed key Power key
selection keys
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Back View
{Figure 12-4; Alpha units removed}

Tetrad base

Power supply air
exhaust vents

Parallel IEEE-488
printer port port

Signal cable
—

~~

Power cable

Bottom View
{(Figure 12-5)

Air intake vents
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Unpacking and Instdlling the DNA Engine Tetrad

Packing Checklist

After unpacking the DNA Engine Tetrad, check to see that you have
received the following:

* DNA Engine Tetrad base

* Four Alpha units

* Power supply unit

» 220V power cord set {inside power supply box)
* Four spare fuses

* PTC-200 DNA Engine & PTC-225 DNA Engine Operations Manual (this
document)

If any of these components are missing or damaged, contact MJ RESEARCH
or the authorized distributor from whom you purchased the DNA En-
gine Tetrad to obtain a replacement. Please save the original packing
materials in case you need to return the Tetrad for service. See appendix
C for shipping instructions.

Installation

The DNA Engine Tetrad requires minimal assembly: installing the Alpha
units (see chapter 4) and connecting the signal and power cables to the
back panel of the base.

Connecting the Cables

The signal and power cables running from the DNA Engine Tetrad’s
power supply (fig. 12-4) must be connected to the base, and the power
supply must be plugged into an electrical outlet.

A Warning: Disconnect the power supply from the wall outlet before
connecting or disconnecting the signal or power cable.
The power supply is capable of generating high-current
DC power. High-current circuits should never be con-
nected or disconnected when electrical power is present;
electrical arcs may result, which can damage the power
supply and pose a hazard of electrical shock.
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12.6

The signal and power cables terminate in twist-lock plugs. To screw a
plug in, first make sure the power supply is not plugged into an outlet.
Press the plug into the socket, and twist it to the right. A snap will be felt
when the plug completely seats in the socket; a faint click is also audible
when the plug to the power cable fully seats.

The signal and power cables are joined at their power supply end by a
single connector that plugs into the power supply. This connector is
housed in a protective metal cage screwed onto the back of the power

supply.

Note: Do not open the protective hbusing; there are no user-service-
able parts within.

Power Supply Requirements

The DNA Engine Tetrad requires 10A@200-240VAC, 50/ 60 Hz. The unit
is not designed to operate on the ordinary 100V-120V household power
commonly supplied in North America and Japan. The DNA Engine Tet-
rad can use current in the specified range without adjustment, so there is
no voltage-setting switch.

Environmental Requirements

The requirements for safe operation of the DNA Engine Tetrad are the
same as those of the DNA Engine (see chapter 3).

Air Supply Requirements

The air supply requirements for the DNA Engine Tetrad are the same as
those of the DNA Engine (see chapter 3). .

Robotics Installation Requirements

Robotics installations of DNA Engine Tetrads require special attention to
airflow and air temperature. Typically in these installations, DNA En-
gine Tetrads and other thermal cyclers are crowded into a small area,
along with other heat-generating equipment. Overheating can quickly
occur when many of these machines are operating at once, unless pre-
ventive measures are taken.

Follow the procedures described in chapter 3 to ensure adequate airflow
and an air intake temperature of 31°C or cooler. Air intake temperature
must be verified by measurement. If none of the troubleshooting proce-
dures outlined in chapter 3 are sufficient to ensure cool-enough air,
install ductwork to the front and rear air exhaust vents, to remove
exhausted air. Attach ductwork using the screws to the right and left
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of the air exhaust vents on the front and back of the DNA Engine
Tetrad (fig. 12-2). These screws may be replaced with longer ones, as
long as they are M4 x 0.7 screws.

Operating the DNA Engine Tetrad

Turning the DNA Engine Tetrad On

First, make sure Alpha units are installed in all four quadrants. An in-
terlock switch prevents the DNA Engine Tetrad from operating if fewer
than four Alpha units are installed.

Turn the DNA Engine Tetrad on with the «Power» key located at the
lower right of the control panel.

Operating Alpha Units

Alpha unit installation, removal, and general operation are the same as
for the DNA Engine (see chapter 4).

Running Protocols on the DNA Engine Tetrad

Running Separate Protocols by Block

Choose a protocol (see chapter 5). A screen identifying the protocol (2-
STEP in the examples below), the Alpha unit type (96V), and the quad-
rant number of the block the protocol will run on (1) will be displayed:

Run: 2-STEP on 1

Block: 96V

If a dual-block Alpha unit is present in the identified quadrant, an Aor a
B will appear after the quadrant number (e.g., 1A).

Protocols are initially assigned to the first block available in the DNA
Engine Tetrad, in numerical order of quadrants. To run the protocol on a
different block, press «Block» until the quadrant number of the desired
block is displayed in the screen’s upper right-hand corner. The status
light of the selected block will flash. When a single-block Alpha unit is
selected, only the A light flashes. When a dual-block Alpha unit is se-
lected, either the A or the B light flashes, depending on the block chosen.
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When the desired block has beeri selected, press «Proceed» to run the protocol.

Note: To run different protocols concurrently, press «Block» to return to
the main screen, and select a new protocol and a new block as de-
scribed in this section. Any protocols already initiated will continue to
Tun.

Running the Same Protocol on All Blocks

If all the Alpha units installed in the DNA Engine Tetrad have the same
type of block (i.e., each has the same number of wells, or four Slide Cham-
bers Alpha unit are loaded) and no protocols are currently running on
any of them, the same protocol (including an instant incubation) may be
run on all of the blocks at once.

To do this, select a protocol (or press «Instant» to run an instant incuba-
tion), then press «Block» until Al appears in the upper right-hand corner
of the displayed screen:

Run: 2-STEP on ALL

Block: 96v

The status indicator lights for all of the sample blocks will be flashing green.
Press «Proceed» to run the protocol on all the blocks simultaneously.

Running an Instant Incubation

Instant incubations are run in the same way as for the DNA Engine (see
chapter 5). The incubation is initially assigned to the first available block in
numerical order of quadrants; press «Block» to assign it to a different block,
or to all of them (if the same type block is present in all four quadrants).

Cancelling Protocols

Press «Block» to select the block that is running the protocol to be cancelled,
then press «Cancel». A cancellation confirmation screen will be displayed:

Run: 2-STEP on 2B

STOP 2-5TEP on 2B?

Yes ~ _NO

-
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Select Yes, then press «Proceed». A screen announcing the cancellation
and citing the total time for the run will be displayed:

Run: 2-STEP on 2B
PROGRAM CANCELED

Total time: 1:1@

Programming the DNA Engine Tetrad

The DNA Engine Tetrad is programmed in the same way as the DNA
Engine (see chapter 6).

Networking the DNA Engine Tetrad

Any combination of DNA Engine Tetrads and DNA Engines can be net-
worked, as long as the 15-machine limit is not exceeded and a computer
or a DNA Engine is included to serve as the controller (the DNA Engine
Tetrad cannot serve as controller). See chapter 9 for information on net-
working machines.

Software Required for Networking

ADNA Engine must have software version 1.1] or later in order to control a
network that includes one or more DNA Engine Tetrads. To identify the
software version loaded into a DNA Engine, see “Determining the Software
Version Number,” chapter 8.

Operating Nefworked DNA Engine Tetrads

Networked DNA Engine Tetrads operate the same as networked DNA
Engines. Each block of a networked DNA Engine Tetrad is designated by
the machine’s IEEE-488 address, followed by the block’s quadrant num-
ber and an A or a B if a dual block is involved. For example, the designa-
tion for a single-block Alpha unit present in quadrant 1 of machine 17 is
17-1. The designation for block B in a dual-block Alpha unit present in
quadrant 2 of the same machine is 17-2B.

Using the Utilities for the DNA Engine Tetrad

The DNA Engine Tetrad has the same utilities as the DNA Engine (see
chapter 8).
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Troubleshooting the DNA Engine Tetrad

The Tetrad is subject to the same problems with operations, protocols,
and reaction results as the DNA Engine (see chapter 11).

Maintaining the DNA Engine Tetrad

Cleaning

Clean the DNA Engine Tetrad according to the instructions in chapter 10
for cleaning the DNA Engine.

Changing the Fuses

Each quadrant of the Tetrad is protected by a fuse mounted in a plug on
the back panel of the base (fig. 12-6). Blown fuses may be replaced by any
15A fast-acting fuse (0.25” x 1.25”3AB or 3ABC).

To replace a fuse, first unplug the power supply from the wall. Twist the
fuse cap a quarter turn to the left and pull out the fuse plug. Replace the
blown fuse. Press the plug back into its socket, and twist it a quarter turn
to the right to seat it. The plug is spring-loaded, so firm pressure may be
required.

A Warning: The DNA Engine incorporates neutral fusing, which

means that live power may still be available inside the
unit even when a fuse has blown or been removed. Never
open the DNA Engine Tetrad base; you could receive a
serious electrical shock. Opening the base will also void
your warranties.

Figure 12-6 Quadrant assignments for fuses.

12-10

Quadrant 4 Quadrant 1
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Quadrant 3 Quadrant 2
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About the Remote Alpha Dock System

The Remote Alpha Dock system is designed to add flexibility to the in-
stallation and operation of the MJ Research® DNA Engine” and DNA En-
gine Tetrad® cycler. The system allows Alpha™ units to be placed at a
distance from the PTC-200 or PTC-225 base, enabling more efficient use
of space and facilitating robotic operation. The basic system, the RAD-
0200, comprises a Dock Connector, which mounts in the base; and a Re-
mote Alpha Dock, into which the Alpha units are mounted. The RAD-
0201 contains, in addition, a fan power supply and three “daisy chain”
(series) cables, allowing the cooling fans for up to four Remote Docks to
run off a single AC outlet. Additionally, the fan power supply along with
the cables to run up to four Remote Alpha Dock fans from a single ther-
mal cycler base can be purchased separately, as RPS-0200.

Figure 13-1

132

The Remote Alpha Dock with Alpha unit mounted
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Packing checklist
*  One Dock Connector
* One Remote Alpha Dock
*  One multi-pin power cable
*  One multi-pin data cable
¢ One fan power supply (RAD-0201 only)
* One wall-plug power cord (RAD-0201 only)
* Three round-jack power cords (RAD-0201 only)

Requirements

Environment

The Remote Alpha Dock System allows for custom installations. The

following placement configurations are recommended by MJ Research.

* Remote Docks with mounted Alpha units may be configured in any
horizontal orientation or array as long as a minimum side clearance
of 10 cm is maintained between the Remote Dock and any wall, bulk-
head, or adjacent Remote Dock unit (this is identical to the PTC-200/
PTC-225 base requirement). Requirements for motorized lid opera-
tion or for loading or unloading plates may dictate additional clear-
ances.

* Remote Docks with mounted Alpha units may be stacked vertically
as long as a minimum bottom clearance is maintained that would be

Figure 13-2 Remote Alpha Dock and Dock Connector,
bottom view.

£
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Installation

no less than that resulting from the unit being placed on a solid hori-
zontal platform. A minimum top clearance is also required to allow
access to and operation of the Alpha unit lid.

Remote Docks can be flush-mounted (i.e., with the feet removed) to
facilitate robotic operation, as long as the airway beneath the unit is
equivalent to the airway the unit would have with the feet attached.
Usually a hole will need to be cut to allow air to flow to the cooling
fan. Figure 13-5 is a template for flush-mounting the Remote Dock.

Power Supply

The Alpha unit mounted in each Remote Dock is powered from the
PTC-200 or PTC-225 base.

The Remote Dock’s fan is powered externally, and a power supply is
provided that requires power from 90-250 VAC and 47 to 63 Hz, with
a grounded outlet.

Air Supply

Alpha units being operated in the remote configuration have no op-
erating constraints that do not also apply to normal operations in the
PTC-200 or PTC-225.

Figure 13-3  Atiachment of power and data cables

Dock connector

Remote dock

=

13-4
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Turn the Dock Connector upside down, so that the green circuit board
is visible. Check that the ground lead remains attached at both ends
(fig. 13-1). Note the two female multi-pin sockets, one labeled
“DATA,” and the other “POWER.”

Connect the multi-pin power cable’s male end to the female socket
labeled “POWER” and slide the latch to lock the pins in place.

Both of the data cable’s multi-pin connectors are male: one is labeled
“CONNECTOR DATA” and the other “DOCK DATA.” Attach the
“"CONNECTOR DATA” end to the female connector labeled “DATA”
on the circuit board and slide the latch to lock the pins in place.
Press both cables firmly into the two strain relief holes on the Dock
Connector’s front side (fig. 13-2).

Turn the Remote Dock upside down. You will see a male multi-pin
connector labeled “Power Port” and a female multi-pin connector la-
beled “Data Port” (fig. 13-3).

Connect the multi-pin power cable’s female end to the connector la-
beled “Power Port” and slide the latch to lock the pins in place.
Attach the data cable's “DOCK DATA” end to the connector labeled
“Data Port” and slide the latch to Iock the pins in place.

Turn both units back over.

The Dock Connector mounts in the base in the same manner as a
regular Alpha unit (see pp. 44 - 4-6).

Attach the wall-plug power cord to the fan power supply.

Figure 13-4

Fan power supply connected in series
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Operation

136

» Attach the fan power supply’s round jack to either of the round con-
nectors on the back of the Remote Dock (fig. 13-4).

* The fan power supply produces sufficient current such that up to
three additional fans can be “daisy chained” to the initial Remote
Dock via the round-jack power cords supplied. Attach one end of the
cord to the initial unit's free round connector. Attach the other end to
either of the round connectors on the back of the next Remote Dock
in the series, and so on (fig. 13-4).

*  When the RAD system has been completely set up, connect the fan
power supply’s wall plug to a power source.

The remote system is transparent to the base unit; i.e., the Dock Connec-
tor allows the base to control the Alpha unit in the Remote Dock as if it
were in the standard configuration.

IMPORTANT: Turn the base unit’s power off when changing the type of
sample block you are using. Turning the power off resets the base, allow-
ing it to recognize the new block. If not reset, the base unit assumes that
the previous type of block is installed, resulting in error messages and
procedural faults.
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Figure 13-5 Flush-mounting template
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Appendix A

How a Peltier Heat Pump Works

The functional heart of every DNA Engine is a high-performance Peltier-effect heat pump (also
known as a “thermoelectric module”). This solid-state device is manufactured to withstand the

thermal stresses associated with rapidly cycling temperatures.

A thermoelectric module consists of numerous pairs
of crystalline semiconductor blocks precisely sand-
wiched between two layers of ceramic substrate (fig.
A-1). The blocks are of two varieties: “N-type,” which
has a surplus of electrons in its crystalline structure,
and “P-type,” which has a deficit of electrons. The two
types are positioned in alternating pairs within the in-
nermost layer of the sandwich.

The two types of blocks are wired together in alternat-
ing pairs. When electrical current is passed through the
blocks, electrons in the N-type blocks and the “holes,”
or empty electron spaces, in the P-type blocks are ex-
cited at one conductor-semiconductor interface, which
absorbs a small amount of heat. The electrons and holes

Figure A-1 A thermoeleciric module.
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flow through the crystalline blocks and return to a low-energy state at the other conductor-semi-
conductor interface, with the release of the previously absorbed heat. A thermal gradient of up to

70°C can be generated across the blocks in this manner.

The direction of heat pumping is reversed by reversing the polarity of current flow through the
thermoelectric module, and the amount of heat pumped is changed by changing the amount of
current passed. Both direction and amount of current flow are dictated by a microprocessor in the
Alpha™ unit, allowing precise control of thermal cycling in the Alpha unit block.
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Appendix B

How a Switching Power Supply
Works

Almost all solid-state electronic devices, including the DNA Engine®cycler’s thermoelectric mod-
ule, require direct current (DC) for operation. However, electric utilities supply low-Hertz alter-
nating current (AC), which varies in voltage and frequency from nation to nation. The DNA En-
gine uses switching transistors, combined with high-frequency, resonant transformers, to convert
the incoming AC to DC.

The power supply first chops the AC power into small bursts of energy (over 100,000 per second)
with the aid of high-current switching transistors called MOSFETs (metal-oxide semiconductor
field-effect transistors). The energy bursts are channeled into a high-frequency transformer. By
changing the duration of the bursts that charge the transformer’s magnetic core (pulse-width
modulation), a specific voltage output can be maintained even when the incoming voltage varies
(between 100 and 240 volts in the case of the DNA Engine). Because the incoming power is being
chopped so rapidly, the incoming frequency is unimportant; it can even be DC. Spikes and surges
in the incoming power no longer pose a problem since they are chopped nearly to oblivion. The
addition of resonance to the transformer design gives it extraordinary efficiency. These design
innovations has made the DNA Engine’s power supply small in size, universal in input, and resis-
tant to noise.
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Appendix C

Shipping Instructions for US Residents

Users residing in the United States should follow these instructions for shipping a machine to M]
ResearcH for factory repair or an upgrade. Users outside of the United States should send ma-
chines to their distributor, in accordance with shipping instructions obtained from the distributor.

1.

Call MJ] ReseARCH to obtain a return materials authorization (RMA ) number. Machines returned
without an RMA will be refused by the Receiving Department,

Thoroughly clean the machine, removing excess oil and radioactive and other biohazardous
substances. To protect the health of our employees, M] ResearcH will not repair or upgrade
any machine that is excessively oily or that emits ionizing radiation upon arrival at our fac-
tory. PLEASE ELIMINATE ALL BIOHAZARDS!

Pack the machine in its original packaging. If this has been misplaced or discarded, call M]
ReseArcH to request shipment of packaging materials. You can also request a loaner machine,
which will be provided if available (a rental fee may apply). You can use the loaner’s packag-
ing to return the machine needing repair.

Remove the Alpha unit from the DNA Engine® or DNA Engine Tetrad® base before shipping.
All warranties are voided if a machine is shipped with an Alpha unit installed. If the Alpha™
unit also needs to be shipped, pack it in its original packaging materials.

Write the RMA number on the outside of the box.

Ship the machine (freight prepaid) to the following address. We recommend you purchase
insurance from your shipper.

Ship to:  Repair Department
M]J Research, Inc.

136 Coolidge Ave.
Watertown, MA 02172
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Appendix D

Warranties

The DNA Engine [PTC-200) and DNA Engine Tetrad {PTC-225) thermal cyclers are warranted
against defects in materials and workmanship. For specific Warranty information, contact your
local BioRad office. IF any defects should occur during the warranty period, Bio-Rad will replace
the defective parts without charge. However, the following defects are specifically excluded:

1. Defects caused by improper operation or by improper packaging of refurned goods.
2. Repair or modifications done by anyone other than Bio-Rad Laboratories.

3. Use with tubes, plates, or sealing materials not specified by Bio-Rad Laboratories for use
with the DNA Engine or DNA Engine Tetrad thermal cyclers.

4. Deliberate or accidental misuse.
5. Damage caused by disaster.
6. Damage due to use of improper solvent or sample.

The warranty does not apply to fuses.

For inquiry or request for repair service, contact Bio-Rad Laboratories after confirming the model
and serial number of your insirument.

For Technical Service call your locel distributor or in the U.S. call 1-888-652-9253, or visit our
website af www.mir.com.

Tech Support: {888) 652-9253 » Sales [BBB) 735-8437 » tech@mir.com * www.mjr.com D-1
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Appendix E

Factory-Installed Protocols

Note: A programmed time of 0:00:00 means “hold at this temperature forever.”

: Tén‘ip.-_c_o'niral"':" _:ﬁjn_ i ER
ICEBUKET Block 1 4° , 0:00:00
2 END

‘Name

CBlock o000

37° . 1:00:00
4° | 0:00:00

o 1 HR SRR ok
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Index

A

Accessories. See Moto Alpha unit
Air supply requirements
ensuring adequate air supply 3-3
Ensuring air is cool enough 3-4
troubleshooting problems with 3-4
Alpha units
closing 4-6
installing, 44
maximum rate of heating and cooling 6-2
models 2-4
opening 4-5
removing 4-5

Baud rate, setting 5-§
Beep option. See Pragrams: options, types of
Bleach, using in block 10-2

C

Chill-out liquid wax 4-7
Cleaning
air vents 10-2
and biohazardous materials 10-3
and radioactive materials 10-3, 4-16
chassis and block 4-16
removing oil from block 10-2
solutions to use 4-16
Condensation in tubes following holds 4-8
Control panel 2-2
keys 4-3
lights 4-3
using 4-3

D

DNA Engine
running protocols

separately by block 12-7
sirnultaneosly on all blocks 12-8
DNA Engine Driver Software 9-4
DNA Engine Tetrad
air supply requirements 12-6
Alpha units, operating 12-7
cancelling protocol runs 12-8
cleaning 12-10
connecting power cables 12-5
environmental requirements 12-6
fuses, changing 12-10
general information 12-2
installing 12-5-12-6
instant incubations, running 12-8
layout
back view 12-4
bottom view 12-4
control panel 12-3
front view 12-3
networking 12-9
packing checklist 12-5
power supply requirements 12-6
programming 12-9
robotics installations 12-6
specifications 12-2
troubleshooting 12-10
turning machine on 12-7
utilities for 12-9
Documentation conventions
graphic vi
terminology vi
typographic vi

Electromagnetic interference v
Environmental requirements 3-2-3-3

Error messages 11-2

Explanation of symbols iv

Extend option. See Programs: options, types of
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F O
FCC warning v Qil, use of in block. See Smuple vessels
Tuses Operation
changing 10-3 turning machine on 4-2
H P
Hot Bonnet Packing checldist 3-2
adjusting lid pressure 4-8-4-9 Passwards. See Ulilities: files: assigning password to
temperature control methods §-9 folder
Peltier effect A-1
Ports 4-3
| TEEE-488 2-3
Increment option. See Programs: options, fbypes of parallel (printer) 2-3
Instant incubation 5-10 R5-232 23
Power cord
location of jack 2-3
L plugging in 3-2
Power supply requirements 3-3
Layout . acceptable power cords 3-3
back view 2-3 Probe

bottom view 2-3
control panel 2-2
front view 2-2

adding representative sample
calculating amount of oil to add 4-12
choosing type of oil 4-12
how to add oil 4-12

M connecting to block 4-13
customizing probe vessel 4-11
Menus detecting faulty 4-13
Edit Menu 7-3 function of 4-I1
Enter Men, the 6-6 layout 4-11
Files Menu §-2 loading into block 4-13
Main Menu 4-2 thermistor 4-11
Options Menu 6-11 probe
Setup Menu 8-7 adding representative sample 4-12
Microseal silicone oil as representative sample 4-17
"A" film 4-8 Programming
'M" sealing mat 4-8 Choosing a temperature control method 6-6
P pads 4-14 deleting an uncompleted program 6-16
Moto Alpha unit 2-4 entering steps
beep opticn 6-14
end step 6-11
N extend option 6-13
Networking GoTo step 6-10
general information 9-2 Increment option 6-12
with computer as controller 9-4 ramp step 6-8
setting up an IEEE-488 network 9-5 temperature step 6-7
setting up an R5-232 network 9-5 general process 6-5
with DNA Engine as tontroller 9-2-9-4 Initiating a program 6-5
assigning address numbers 9-2 modffyl_ng block- and probe-control programs 6-5
connecting machines 9-2 mod}fymg programs designed for other ma-
running protocols 9-3 chines 6-5
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Naming a program 6-6
revising during 6-14
setting a lengthy hold time 6-7
Programs
designing 6-2-6-5
choosing temperature control method. See
Temperature control methods
translating protecol into programinto pro-
grams 6-2
using Go'To steps to shorten programs 6-3
editing 7-2, 7-3-7-4
adding an option 7-4
cancelling editing changes 7-5
changing individual values in a step 7-3
changing temperature control method 7-3
deleting step 7-4
inserting new step 7-4
saving edited program 7-4-7-5
finding in machine 5-2, 7-2, §-2
options
optons, types of 6-2, 6-12
program steps, types of 6-2
renaming. See Litilities: file
Protocols
and power failure 5-9
factory-installed 5-2, E-1
manually stepping through 5-8
pausing while running 5-8
printing logs for runs 5-7-5-8
sample log 5-7
TUnming,
choosing block to run protocol on 5-3
choosing protocol to run 5-2
reading completion screen 5-6
reading runtime screen 5-5-5-6
setting up temperature control method 5-3
three steps of 5-2
stopping while running 5-9
protocols
adjusting for sample vessel type 4-6

Remote Alpha Dock System
air supply requirements 13-4
environmental requirements 13-3
installation 13-5
operation 13-6
packing checklist 13-3
power supply requirements 13-4
Robotics installation requirements 3-5

Index H

S

Safety
general instructions 1-3
guideline for safe use v
warnings iv
Sample vessel
selection chart 4-14
Sample vessels
ensuring good thermal contact 4-10
loading into block 4-9
ensuring good thermal contact 4-9
sealing
Reason for 4-7
with Hot Bonnet and Caps/Film 4-8
with oil or wax 4-7
selection 4-6
0.2-ml tubes 4-6
0.5-ml tubes 4-6
microplates 4-6
Use of oil to improve thermal contact with black
4-10
Self-test 4-2
Setting machine up. Seealso Alpha units, installing
Shipping instructions C-1
Specifications 2-5
DNA Engine Tetrad 2-5
Switching power supply B-1

T

Temperature control methods
block control 6-3, 6-4
calculated control 6-3, 6-4
choice of calculated control over probe control
4-11
probe conirol 6-4
Thermoelectric unit A-1

U
Utilities
file
assigning password to folder §-3-8-4
copying program 8-¢4
creating folder 8-3
deleting a program 8-3
Deleting folder 84
moving a program 8-5
renaming programs 8§-5
List 8-6
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viewing a program in LCD window 8-6

list

printing a program §-7

setup 5-7

choosing a printer port 8-§

choosing a remote port §-7

choosing a temperature control method for the
Hot 8-9

determining software version number §-9



Declaration of Conformity

Bio-Rad Laboratories, Inc., 1000 Alfred Nobel Drive, Hercules, California,
94547, U.S.A., declares that the product

PTC-200, The BNA Engine® Thermal Cycler

to which this declaration relates, is in conformity to the following standards or
normative docurnents.

IECB1010-1
ENB1326: CLASS A

following the provisions of the B9/336/EEC & T3/23/EEC Directive.

Test Data to verify this conformity are available for inspection at our European
Representative Office at Literbuen 10B, 2740 Skovlunde, Denmark.

13 September, 2004
date of issue

Brad Crutchfield
Vice President
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Diractive.
Brad Cruichfield
Vice President

89/336/EEC & 73/23/EEC

Declaration of Conformity

Test Data to verify this conformity are available for inspection at our European
Representative Office at Literbuen 10B, 2740 Skovilunde, Denmark.
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PTC-225, The DNA Engine Tetrad® Thermal Cycler

normative documents,
IEC61010-1
ENG1326: CLASS A
following the provisions of the
13 September, 2004

date of issue
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